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CHAPTER 1

Deploy AnyConnect

* Before You Begin Deployment, on page 1

* AnyConnect Deployment Overview, on page 1

* Preparing the Endpoint for AnyConnect, on page 4

» Using Network Visibility Module on Linux, on page 7

* Predeploying AnyConnect, on page 8

* Web Deploying AnyConnect, on page 22

» Updating AnyConnect Software and Profiles, on page 29

Before You Begin Deployment

If you are deploying the Umbrella Roaming Security module, any existing installation of the Umbrella Roaming
Security will be detected and removed automatically to prevent conflicts. If the existing installation of the
Umbrella Roaming Security client is associated with an Umbrella Roaming Security service subscription, it
will automatically be migrated to the Umbrella Roaming Security module unless an OrgInfo.json file is
co-located with the AnyConnect installer, configured for web deployment or predeployed in the Umbrella
Roaming Security module's directory. You may wish to manually uninstall the Umbrella Roaming Security
client prior to deploying the Umbrella Roaming Security module.

You must additionally complete the following prerequisites if using the Umbrella Roaming Security module:

» Obtain Umbrella Roaming Account. The Umbrella dashboard http://dashboard.umbrella.com is the
login page where you obtain necessary information for the operation of the Umbrella Roaming
Securitymodule. You also use this site to manage reporting for the roaming client activity.

» Download the Orglnfo File from the Dashboard. To prepare for deploying the Umbrella Roaming
Security module, obtain the Orglnfo.json file from the Umbrella dashboard. Click on Roaming Computer
in the Identities menu structure and then click the + sign in the upper-left corner of the page. Scroll down
to Umbrella Roaming Securitymodule and click Module Profile.

The Orglnfo.json file contains specific information about your Umbrella service subscription that lets
the Umbrella Roaming Security module know where to report and which policies to enforce.

AnyConnect Deployment Overview

Deploying AnyConnect refers to installing, configuring, and upgrading AnyConnect and its related files.
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The AnyConnect Secure Mobility Client can be deployed to remote users by the following methods:

* Predeploy—New installations and upgrades are done either by the end user, or by using an enterprise
software management system (SMS). This deployment option offers no cloud management.

» Web Deploy—The AnyConnect package is loaded on the headend, which is either a Secure Firewall
ASA, Firepower Threat Defense, or an ISE server. When the user connects to a firewall or to ISE,
AnyConnect is deployed to the client. This deployment option offers no cloud management.

* For new installations, the user connects to a headend to download AnyConnect. The client is either
installed manually or automatically (web-launch).

* Updates are done by AnyConnect running on a system where AnyConnect is already installed, or
by directing the user to the Secure Firewall ASA clientless portal.

* Cloud Update—After the Umbrella Roaming Security module is deployed, you can update any
AnyConnect modules using one of the above methods, as well as Cloud Update. With Cloud Update,
the software upgrades are obtained automatically from the Umbrella cloud infrastructure, and the update
track is dependent upon that and not any action of the administrator. By default, automatic updates from
Cloud Update are disabled.

)

Note Consider the following regarding Cloud Update:

* Only the software modules that are currently installed are updated.

* Customizations, localizations, and any other deployment types are not
supported.

* The updates occur only when logged in to a desktop and will not happen if
a VPN is established.

» With updates disabled, the latest software features and updates will not be
available.

» Disabling Cloud Update has no effect on other update mechanisms or settings
(such as web deploy, deferred updates, and so on).

* Cloud Update ignores having newer, unreleased versions of AnyConnect
(such as interim releases and patched versions).

When you deploy AnyConnect, you can include optional modules that enable extra features, and client profiles
that configure the VPN and optional features.

Refer to the AnyConnect release notes for system, management, and endpoint requirements for Secure Firewall
ASA, IOS, Microsoft Windows, Linux, and macOS.
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Note

Some third-party applications and operating systems may restrict the ISE posture agent and other processes
from necessary file access and privilege elevation. Make sure the AnyConnect installation directory (C:\Program
Files (x86)\Cisco for Windows or /opt/cisco for macOS) is trusted and/or in the allowed/exclusion/trusted
lists for endpoint antivirus, antimalware, antispyware, data loss prevention, privilege manager, or group policy
objects.

Additionally, third-party security applications (AV/AS/AM/DLP) could result in failure with a Compliance
Module upgrade, because the interaction leads to missing libraries on the endpoint. To avoid these issues,
upgrade the Compliance Module version and set these to exclude (in your third-party security application),
before upgrading the Compliance Module:

-anyconnect-win-4.3.xxxx.xxxx-isecompliance-webdeploy-k0.pkg
—anyconnect-win-4.3.xxxx.xxxx-1secompliance-webdeploy-k9.exe
—anyconnect-win-4.3.xxxx.xxxx-isecompliance-webdeploy-k9.msi
-opswat.msi

Decide How to Install AnyConnect

AnyConnect can be web deployed by ISE 2.0 (or later) and Secure Firewall ASA headends or predeployed.
To install AnyConnect initially requires administrative privileges.

Web Deploy

To upgrade AnyConnect or install additional modules using web deploy (from Secure
FirewallASA/ISE/Firepower Threat Defense), you do not need administrative privileges.

* Web Deploying from a Secure Firewall ASA or Firepower Threat Defense—User connects to the

AnyConnect clientless portal on the headend device, and selects to download AnyConnect. The Secure
Firewall ASA downloads the AnyConnect Downloader. The AnyConnect Downloader downloads the
client, installs the client, and starts a VPN connection.

» Web Deploying from ISE—User connects to the Network Access Device (NAD), such as a Secure

Firewall ASA, wireless controller, or switch. The NAD authorizes the user, and redirects the user to the
ISE portal. The AnyConnect Downloader is installed on the client to manage the package extraction and
installation, but does not start a VPN connection.

Predeploy

To upgrade AnyConnect or install additional modules using predeploy (out-of-band deployment, either
manually or using SCCM and so on), you need administrative privileges.

+ Using an Enterprise software management system (SMS).

» Manually distributing the AnyConnect file archive, with instructions for the user about how to install.
File archive formats are zip for Windows, DMG for macOS, and gzip for Linux.

For system requirements and licensing dependencies, refer to the AnyConnect Secure Mobility Client Features,
License, and OS Guide.
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\)

Note Ifyou are using VPN Posture to perform root privilege activities on a macOS or Linux platform, we recommend

that you predeploy VPN Posture.

Determine The Resources You Need to Install AnyConnect
Several types of files make up the AnyConnect deployment:
* AnyConnect , which is included in the AnyConnect package.
* Modules that support extra features, which are included in the AnyConnect package.
* Client profiles that configure AnyConnect and the extra features, which you create.
» Language files, images, scripts, and help files, if you wish to customize or localize your deployment.

* ISE posture and the compliance module (OPSWAT).

Preparing the Endpoint for AnyConnect

Using Mobile Broadband Cards with AnyConnect

Some 3G cards require configuration steps before using AnyConnect. For example, the VZAccess Manager
has three settings:

» modem manually connects

» modem auto connect except when roaming

* LAN adapter auto connect
If you choose L AN adapter auto connect, set the preference to NDIS mode. NDIS is an always on connection
where you can stay connected even when the VZAccess Manager is closed. The VZAccess Manager shows
an autoconnect LAN adapter as the device connection preference when it is ready for AnyConnect installation.

When the AnyConnect interface is detected, the 3G manager drops the interface and allows the AnyConnect
connection.

When you move to a higher priority connection—wired networks are the highest priority, followed by WiFi,
and then mobile broadband—AnyConnect makes the new connection before breaking the old one.

Add the ASA to the List of Internet Explorer Trusted Sites on Windows

Step 1
Step 2
Step 3

An Active Directory administrator can use a group policy to add the ASA to the list of trusted sites in Internet
Explorer. This procedure is different from the way a local user adds trusted sites in Internet Explorer.

On the Windows Domain server, log in as a member of the Domain Administrators group.
Open the Active Directory Users and Computers MMC snap-in.
Right-click the Domain or Organizational Unit where you want to create the Group Policy Object and click Properties.
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Step 4
Step 5
Step 6

Step 7
Step 8
Step 9
Step 10
Step 11

Step 12
Step 13
Step 14

Block Proxy Changes in Internet Explorer .

Select the Group Policy tab and click New.
Type a name for the new Group Policy Object and press Enter.

To prevent this new policy from being applied to some users or groups, click Properties. Select the Security tab. Add
the user or group that you want to prevent from having this policy, and then clear the Read and the Apply Group
Policy check boxes in the Allow column. Click OK.

Click Edit and choose User Configuration > Windows Settings > Internet Explorer Maintenance > Security.
Right-click Security Zonesand Content Ratings in the right pane, and then click Properties.

Select Import the current security zonesand privacy settings. If prompted, click Continue.

Click Modify Settings, select Trusted Sites, and click Sites.

Type the URL for the Security Appliance that you want to add to the list of trusted sites and click Add. The format can
contain a hostname (https://vpn.mycompany.com) or IP address (https://192.168.1.100). It can be an exact match
(https://vpn.mycompany.com) or a wildcard (https://*.mycompany.com).

Click Close and click OK continually until all dialog boxes close.
Allow sufficient time for the policy to propagate throughout the domain or forest.
Click OK in the Internet Options window.

Block Proxy Changes in Internet Explorer

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Under certain conditions, AnyConnect hides (locks down) the Internet Explorer Tools > Internet Options >
Connections tab. When exposed, this tab lets the user set proxy information. Hiding this tab prevents the user
from intentionally or unintentionally circumventing the tunnel. The tab lockdown setting is reversed upon
disconnect. Tab lockdown is overridden by any administrator-defined policies applied to that tab. The lockdown
is applied when:

* The Secure Firewall ASA configuration specifies Connections tab lockdown
* The Secure Firewall ASA configuration specifies a private-side proxy

» A Windows group policy previously locked down the Connections tab (overriding the no lockdown
Secure Firewall ASA group policy setting)

For Windows 10 version 1703 (or later), in addition to hiding the Connections Tab in Internet Explorer,
AnyConnect hides (locks down) the system proxy tab in the Settings app to prevent the user from intentionally
or unintentionally circumventing the tunnel. This lockdown is reversed upon disconnect.

In ASDM go to Configuration > Remote Access VPN > Network (Client) Access > Group Palicies.
Select a group policy and click Edit or Add a new group policy.

In the navigation pane, go to Advanced > Browser Proxy. The Proxy Server Policy pane displays.

Click Proxy L ockdown to display more proxy settings.

Uncheck Inherit and select either:

* Yes to enable proxy lockdown and hide the Internet Explorer Connections tab during the AnyConnect session.

* No to disable proxy lockdown and expose the Internet Explorer Connections tab during the AnyConnect session.

Click OK to save the Proxy Server Policy changes.
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Step 7 Click Apply to save the Group Policy changes.

Configure How AnyConnect Treats Windows RDP Sessions

You can configure AnyConnect to allow VPN connections from Windows RDP sessions. By default, users
connected to a computer by RDP are not able to start a VPN connection with the AnyConnect Secure Mobility
Client. The following table shows the logon and logout options for a VPN connection from an RDP session.
These preferences are configured in the VPN client profile:

Windows L ogon Enforcement—Availablein SBL mode

» Single Local Logon (Default)}—(Local: 1, Remote: no limit) Allows only one local user to be logged on
during the entire VPN connection. Also, a local user can establish a VPN connection while one or more
remote users are logged on to the client PC. This setting has no effect on remote user logons from the
enterprise network over the VPN connection.

\}

Note Ifthe VPN connection is configured for all-or-nothing tunneling, then the remote
logon is disconnected because of the resulting modifications of the client PC
routing table for the VPN connection. If the VPN connection is configured for
split-tunneling, the remote logon might or might not be disconnected, depending
on the routing configuration for the VPN connection.

* Single Logon—(Local + Remote: 1) Allows only one user to be logged on during the entire VPN
connection. If more than one user is logged on, either locally or remotely, when the VPN connection is
being established, the connection is not allowed. If a second user logs on, either locally or remotely,
during the VPN connection, the VPN connection terminates. No additional logons are allowed during
the VPN connection, so a remote logon over the VPN connection is not possible.

N

Note Multiple simultaneous logons are not supported.

* Single Logon No Remote—(Local: 1, Remote: 0) Allows only one local user to be logged on during the
entire VPN connection. No remote users are allowed. If more than one local user or any remote user is
logged on when the VPN connection is being established, the connection is not allowed. If a second local
user or any remote user logs on during the VPN connection, the VPN connection terminates.

Windows VPN Establishment—Not Availablein SBL Mode

* Local Users Only (Default)—Prevents a remotely logged-on user from establishing a VPN connection.
This is the same functionality as in prior versions of AnyConnect.

» Allow Remote Users—Allows remote users to establish a VPN connection. However, if the configured
VPN connection routing causes the remote user to become disconnected, the VPN connection terminates
to allow the remote user to regain access to the client PC. Remote users must wait 90 seconds after VPN
establishment if they want to disconnect their remote login session without causing the VPN connection
to be terminated.
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Configure How AnyConnect Treats Linux SSH Sessions

You can configure AnyConnect to allow VPN connections from Linux SSH sessions. By default, users
connected to a computer by SSH are not able to start a VPN connection with the AnyConnect Secure Mobility
Client. The following table shows the logon and logout options for a VPN connection from an SSH session.
These options are configured in the VPN client profile.

Linux Login Enforcement— Single Local Logon (Default): Allows only one local user to be logged on
during the entire VPN connection. Also, a local user can establish a VPN connection while one or more remote
users are logged on to the client PC. This setting has no effect on remote user logons from the enterprise
network over the VPN connection.

N

Note If the VPN connection is configured for all-or-nothing tunneling, then the remote logon is disconnected
because of the resulting modifications of the client PC routing table for the VPN connection. If the VPN
connection is configured for split-tunneling, the remote logon might or might not be disconnected, depending
on the routing configuration for the VPN connection.

Single L ogon—Allows only one user to be logged on during the entire VPN connection. If more than one
user is logged on (either locally or remotely) when the VPN connection is being established, the connection
is not allowed. If a second user logs on (either locally or remotely) during the VPN connection, the VPN
connection terminates. No additional logons are allowed during the VPN connection, so a remote logon over
the VPN connection is not possible.

Linux VPN Establishment—

* Local Users Only (Default)—Prevents a user, who is logged in remotely, from establishing a VPN
connection.

» Allow Remote Users—Allows remote users to establish a VPN connection.

DES-Only SSL Encryption on Windows

By default, Windows does not support DES SSL encryption. If you configure DES-only on the Secure Firewall
ASA, the AnyConnect connection fails. Because configuring these operating systems for DES is difficult, we
do not recommend that you configure the Secure Firewall ASA for DES-only SSL encryption.

Using Network Visibility Module on Linux

Before using Network Visibility Module on Linux, you must set up a kernel driver framework (KDF). You
can choose to prebuild the AnyConnect Kernel Module or build the driver on target. If you choose to build
on target, no action is required; the build is handled automatically during deployment or during reboot.

Prerequisites to Build the AnyConnect Kernel Module

Prepare the target device:

» Make sure that the GNU Make Utility is installed.

* Install the kernel header package:
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 For RHEL, install the package kernel-devel-$(uname -r), such as
kernel-devel-2.6.32-642.13.1.¢16.x86_64.

* For Ubuntu, install the package linux-header s-$(uname-r), such as linux-headers-4.2.0-27-generic.

* For Linux, install the required libelf devel packages.

» Make sure that the GCC compiler is installed. The major.minor version of the installed GCC compiler
should match the GCC version with which the kernel was built. You can verify this in the /proc/version
file.

Package NVM with Prebuilt AnyConnect Linux Kernel Module

Before you begin
Complete the prerequisites in Prerequisites to Build the AnyConnect Kernel Module, on page 7.

The AnyConnect Network Visibility Module can be packaged with a pre-built AnyConnect Linux Kernel
Module so that you do not need to build it on every target device, especially when the target devices have the
same OS kernel version. If you decide to not use the pre-built option, you can use on target, which happens
automatically during deployment or reboot without administrator input. Alternatively, if your deployment
doesn't have the kernel prerequisites on all endpoints, you could use the pre-built option.

)

Note Web deployment is not supported with the pre-built AnyConnect Linux Kernel Module.

Step 1 Extract the AnyConnect predeploy package: anyconnect-linux64-<version>-predeploy-k9.tar.gz.
Step 2 Navigate to the nvm directory.
Step 3 Invoke the script $sudo ./build_and_package ac_ko.sh.

After running the script, anyconnect-linux64-<version>-ac_kdf_ko-k9.tar.gz gets created, which includes
the AnyConnect Linux Kernel Module build. On Secure Boot enabled systems, sign the module with a private
key allowed by Secure Boot. This file can only be used for predeploy.

What to do next

When the target device's OS kernel is upgraded, you must re-deploy the AnyConnect Network Visibility
Module with the updated Linux Kernel Module.

Predeploying AnyConnect

AnyConnect can be predeployed by using an SMS, manually by distributing files for end users to install, or
making your AnyConnect file archive available for users to connect to.
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When you create a file archive to install AnyConnect, the directory structure of the archive must match the
directory structure of the files installed on the client, as described in Locations to Predeploy the AnyConnect
Profiles, on page 11.

Before you begin

* If you manually deploy the VPN profile, you must also upload the profile to the headends. When the
client system connects, AnyConnect verifies that the profile on the client matches the profile on the
headend. If you have disabled profile updates, and the profile on the headend is different from the client,
then the manually deployed profile will not work.

* If you manually deploy the AnyConnect ISE Posture profile, you must also upload that file to ISE.

* If you are using a cloned VM, refer to Guidelines for Cloning VMs With AnyConnect (Windows Only),
on page 13.

Step 1 Download the AnyConnect Predeployment Package.

The AnyConnect files for predeployment are available on cisco.com.

0s AnyConnect Predeploy Package Name

Windows anyconnect-win-version-predeploy-k9.zip

macOS anyconnect-macos-version-predeploy-k9.dmg

Linux (64-bit) (for script installer)
anyconnect-linux64-version-predeploy-k9.tar.gz

(for RPM installer)
anyconnect-linux64-version-predeploy-rpm-k9.tar.gz

(for DEB installer)
anyconnect-linux64-version-predeploy-deb-k9.tar.gz

The Umbrella Roaming Security module is not available in the Linux operating system.

Step 2 Create client profiles: some modules and features require a client profile.
The following modules require AnyConnect profiles to be created:

» AnyConnect VPN

* Network Access Manager
* ISE Posture

* AMP

» Network Visibility Module

* Umbrella Roaming Secure Module

The following modules do not require AnyConnect profiles to be created:

» Start Before Login
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* Diagnostic and Reporting Tool
* VPN Posture

* Customer Experience Feedback

You can create client profiles in ASDM, and copy those files to your PC. Or, you can use the standalone profile editor
on a Windows PC.

Step 3 Optionally, Customize and Localize AnyConnect and Installer, on page 39.

Step 4 Prepare the files for distribution. The directory structure of the files is described in Locations to Predeploy the AnyConnect
Profiles.

Step 5 After you have created all the files for AnyConnect installation, you can distribute them in an archive file, or copy the
files to the client. Make sure that the same AnyConnect files are also on the headends you plan to connect to: Secure
Firewall ASA, ISE, and so on.

AnyConnect Module Executables for Predeploy and Web Deploy

The following table shows the filenames on the endpoint computer when you predeploy or web deploy the
Umbrella Roaming Security Module, Network Access Manager, AMP Enabler, ISE Posture, and Network
Visibility Module clients to a Windows computer.

Table 1: Module Filenames for Web Deployment or Predeployment

Module Web-Deploy Installer (Downloaded) Predeploy Installer

Network Access anyconnect-win-version-nam-webdeploy-k9.msi anyconnect-win-version-nam-predeploy-k9.msi
Manager

ISE Posture anyconnect-win-version-iseposture-webdeploy-k9.msi | anyconnect-win-version-iseposture-predeploy-k9.msi
AMP anyconnect-win-version-amp-webdeploy-k9.msi anyconnect-win-version-amp-predeploy-k9.exe
Network Visibility | anyconnect-win-version-nvm-webdeploy-k9.exe anyconnect-win-version-nvm-predeploy-k9.msi
Module

Umbrella Roaming | anyconnect-win-version-umbrella-webdeploy-k9.exe | anyconnect-win-version-umbrella-predeploy-k9.msi
Security Module

ThousandEyes n/a cisco-secure-client-win-vergon-thousandeyes-predeploy-k9.msi
Endpoint Agent
Module

\)

Note If you have a Windows server OS, you may experience installation errors when attempting to install the
Network Access Manager. The WLAN service is not installed by default on the server operating system, so
you must install it and reboot the PC. The WLANAutoconfig service is a requirement for the Network Access
Manager to function on any Windows operating system.
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Locations to Predeploy the AnyConnect Profiles
If you are copying the files to the client system, the following tables show where you must place the files.

Table 2: AnyConnect Core Files

File Description
anyfilename.xml AnyConnect profile. This file specifies the features and attribute values configured for a particular user
type.

AnyConnectProfile.xsd | Defines the XML schema format. AnyConnect uses this file to validate the profile.

Table 3: Profile Locations for all Operating Systems

Module Location

Windows

AnyConnect VPN Profile %ProgramData%\Cisco\Cisco AnyConnect Secure Mobility
Client\Profile

Network Access Manager %ProgramData%\Cisco\ Cisco AnyConnect Secure Mobility

Client\Network Access Manager\newConfigFiles

Customer Experience Feedback %ProgramData%\Cisco\ Cisco AnyConnect Secure Mobility
Client\CustomerExperienceFeedback

ISE Posture %ProgramData%\Cisco\Cisco AnyConnect Secure Mobility
Client\ISE Posture

AMP %ProgramData%\Cisco\Cisco AnyConnect Secure Mobility
Client\AMP Enabler

Network Visibility Module %ProgramData%\Cisco\Cisco AnyConnect Secure Mobility
ClienttNVM

Umbrella Roaming Security Module %ProgramData%\Cisco\Cisco AnyConnect Secure Mobility
Client\Umbrella

Note In order to enable the Umbrella Roaming Security
module, you must copy the Orglnfo.json file from
the Umbrella dashboard and place it into this target
directory without any renaming. You can
alternatively co-locate the OrgInfo.json file with the
Umbrella Roaming Security module installer,
placing the file in \Profiles\umbrella before
installation.

macOS

ISE Posture /opt/cisco/anyconnect/iseposture/
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Module Location

AMP Enabler /opt/cisco/anyconnect/ AMPEnabler/

Network Visibility Module /opt/cisco/anyconnect/NVM/

Umbrella Roaming Security Module /opt/cisco/anyconnect/umbrella

Note In order to enable the Umbrella Roaming Security

module, you must copy the Orglnfo.json file from
the Umbrella dashboard and place it into this target
directory without any renaming. You can
alternatively co-locate the OrglInfo.json file with the
Umbrella Roaming Security module installer,
placing the file in \Profiles\umbrella before
installation.

AnyConnect VPN Profile /opt/cisco/anyconnect/profile

Linux

NVM /opt/cisco/anyconnect/NVM

AnyConnect VPN Profile /opt/cisco/anyconnect/profile

Other AnyConnect File Locations

Customization and Localization - Windows
* L1ON
* %ALLUSERSPROFILE%\Cisco\Cisco AnyConnect Secure Mobility Client\l10n

* Resour ces
* %PROGRAMFILES%\Cisco\Cisco AnyConnect Secure Mobility Client\res

Customization and Localization - mac0S and Linux
« L10ON

* /opt/cisco/anyconnect/110n

* Resources

* /opt/cisco/anyconnect/resources

macO0S Binaries, Libraries, and Ul Resources

« Ul Resources
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* /Applications/Cisco/Cisco Secure Mobility Client.app/Contents/Resources/

* Binaries

* /opt/cisco/anyconnect/bin

e Libraries

* /opt/cisco/anyconnect/lib

Help
* Windows

* %ALLUSERSPROFILE%\Cisco\Cisco AnyConnect Secure Mobility Client\Help

* macOS & Linux

* /opt/cisco/anyconnect/help

OPSWAT Libraries
Used by both ISE Posture and HostScan
» Windows

* %PROGRAMFILES%\Cisco\Cisco AnyConnect Secure Mobility Client\OPSWAT

* macOS

/opt/cisco/anyconnect/lib/opswat

Guidelines for Cloning VMs With AnyConnect (Windows Only)

AnyConnect endpoints are uniquely identified by a Universal Device Identifier (UDID), which all modules
of AnyConnect use. When a Windows VM is cloned, the UDID remains the same for all the clones from a
source. To avoid any potential issues with cloned VMs, follow this action before using AnyConnect:

1. Navigate to % ProgramFiles(x86)% \Cisco\Cisco AnyConnect Secure Mobility Client\DART and run
dartcli.exe with administrator privileges as:

dartcli.exe -nu
or
dartcli.exe -newudid
2. Print the UDID prior to and after this command to ensure that the UDID has changed with this command:
dartcli.exe -u
or

dartcli.exe -udid
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Predeploying AnyConnect Modules as Standalone Applications

The Network Access Manager and Umbrella Roaming Security modules can run as standalone applications.
The AnyConnect is installed, but the VPN and AnyConnect Ul are not used.

Deploying StandAlone Modules with an SMS on Windows

Step 1 Disable VPN functionality by configuring your software management system (SMS) to set the MSI property
PRE DEPLOY DISABLE VPN=l. For example:

msiexec /package anyconnect-win-version-predeploy-k9.msi /norestart /passive PRE DEPLOY DISABLE VPN=1
/lvx* <log file name>

The MSI copies the VPNDisable ServiceProfile.xml file embedded in the MSI to the directory specified for profiles for
VPN functionality.

Step 2 Install the module. For example, the following CLI command installs Umbrella:

msiexec /package anyconnect-win-version-umbrella-predeploy-k9.msi /norestart /passive /lvx* c:\test.log
Step 3 (Optional) Install DART.

misexec /package annyconnect-win-version-dart-predeploy-k9.msi /norestart /passive /lvx* c:\test.log

Step 4 Save a copy of the obfuscated client profile to the proper Windows folder.
Step 5 Restart the Cisco AnyConnect service.

Deploying AnyConnect Modules as Standalone Applications

Requirements

The VPNDisable ServiceProfile.xml file must also be the only AnyConnect profile in the VPN client profile
directory.

User Installation of StandAlone Modules

You can break out the individual installers and distribute them manually.

If you decide to make the zip image available to your users, and then ask to install it, be sure to instruct them
to install only the standalone modules.

\}

Note Ifa previous installation of Network Access Manager did not exist on the computer, the user must reboot the
computer to complete the Network Access Manager installation. Also, if the installation is an upgrade that
required upgrading some of the system files, the user must reboot.

Step 1 Instruct users to check the AnyConnect Network Access Manager or Secure Umbrella Module.
Step 2 Instruct users to uncheck Cisco AnyConnect VPN Module.
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Doing so disables the VPN functionality of the core client, and the Install Utility installs the Network Access Manager
or Umbrella Roaming Security Module as standalone applications with no VPN functionality.

Step 3 (Optional) Check the L ock Down Component Services check box. The lockdown component service prevents users
from switching off or stopping the Windows service.

Step 4 Instruct users to run the installers for the optional modules, which can use the AnyConnect GUI without the VPN service.
When the user clicks the Install Selected button, the following happens:

a) When the user clicks OK, the Install Utility invokes the AnyConnect installer with a setting of
PRE DEPLOY DISABLE VPN=l.
b) The Install Utility removes any existing VPN profiles and then installs VPNDisable ServiceProfile.xml.
¢) The Install Utility invokes the Network Access Manager or Umbrella Roaming Security installer.
d) The Network Access Manager or Umbrella Roaming Security Module is enabled without VPN service on the computer.

Predeploying to Windows

Distributing AnyConnect Using the zip File

The zip package file contains the Install Utility, a selector menu program to launch the individual component
installers, and the MSIs for the core and optional AnyConnect modules. When you make the zip package file
available to users, they run the setup program (setup.exe). The program displays the Install Utility menu, from
which users choose which AnyConnect modules to install. You probably do not want your users to chose
which modules to load. So if you decide to distribute using a zip file, edit the zip to remove the modules you
do not want to use, and edit the HTA file.

One way to distribute an ISO is by using virtual CD mount software, such as SlySoft or PowerIS.

Predeployment zip Modifications

» Update the zip file with any profiles that you created when you bundled the files, and to remove any
installers for modules that you do not want to distribute.

« Edit the HTA file to personalize the installation menu, and to remove links to any module installers that
you do not want to distribute.

Contents of the AnyConnect zip File

File Purpose
GULico AnyConnect icon image.
Setup.exe Launches the Install Utility.

anyconnect-win-version-dart-predeploy-k9.msi MSI installer file for the DART Module.

anyconnect-win-ver sion-gina-predeploy-k9.msi MSI installer file for the SBL Module.

anyconnect-win-version-iseposture-predeploy-k9.msi | MSI installer for the ISE Posture Module.

anyconnect-win-version-amp-predeploy-k9.exe MSI installer file for the AMP Enabler.
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File Purpose

anyconnect-win-version-nvm-predeploy-k9.msi MSI installer file for the Network Visibility Module.

anyconnect-win-version-umbrella-predeploy-k9.msi | MSI installer file for the Umbrella Roaming Security Module.

anyconnect-win-ver sion-nam-predeploy-k9.msi MSI installer file for the Network Access Manager Module.

anyconnect-win-version-posture-predeploy-k9.msi | MSI installer file for the Posture Module.

anyconnect-win-version-core-vpn-predeploy-k9.msi | MSI installer file for the AnyConnect VPN Module.

autorun.inf Information file for setup.exe.

eula.html Acceptable Use Policy.

setup.hta Install Utility HTML Application (HTA), which you can customize for your
site.

Distributing AnyConnect Using an SMS

After extracting the installers (*.msi) for the modules you want to deploy from the zip image, you can distribute
them manually.

Requirements

* When installing AnyConnect onto Windows, you must disable either the AlwaysInstallElevated or the
Windows User Account Control (UAC) group policy setting. If you do not, the AnyConnect installers
may not be able to access some directories required for installation.

* Microsoft Internet Explorer (MSIE) users should add the headend to the list of trusted sites or install
Java. Adding to the list of trusted sites enables the ActiveX control to install with minimal interaction
from the user.

Profile Deployment Process

* If you are using the MSI installer, the MSI picks any profile that has been placed in the Profiles folder
and places it in the appropriate folder during installation. The proper folder paths are available in the
predeployment MSI file available on CCO.

* If you are predeploying the profile manually after the installation, copy the profile manually or use an
SMS, such as Altiris, to deploy the profile to the appropriate folder.

* Make sure you put the same client profile on the headend that you predeploy to the client. This profile
must also be tied to the group policy being used on the Secure Firewall ASA. If the client profile does
not match the one on the headend or if it is not tied to the group policy, you can get inconsistent behavior,
including denied access.

* The table below provides recommendations for log file names. By following the recommendations, you
will have predictable locations, making it easier to find desired logs within the DART collection. Likewise,
some example commands provided may provide a function that is not desired by you. For example, the
customer experience feedback command disables the feedback, which is enabled by default.
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Windows Predeployment MSI Examples

Module Installed

Command and Log File

AnyConnect core client No VPN
capability.

(Use when installing standalone
modules. )

msiexec /package anyconnect-win-version-core-vpn-predeploy-k9.msi /norestart /passive
PRE_DEPLOY_ DISABLE VPN=I /lvx*

anyconnect-win-version-core-vpn-predeploy-k9-install-datetimestamp.log

AnyConnect core client with VPN
capability.

(Use for all cases except when
installing standalone modules.)

msiexec /package anyconnect-win-version-core-vpn-predeploy-k9.msi /norestart /passive
/lvx*

anyconnect-win-version-core-vpn-predeploy-k9-install-datetimestamp.log

Customer Experience Feedback

msiexec /package anyconnect-win-version-core-vpn-predeploy-k9.msi /norestart /passive
DISABLE CUSTOMER EXPERIENCE FEEDBACK=I /lvx*

anyconnect-win-version-core-vpn-predeploy-k9-install-datetimestamp.log

Diagnostic and Reporting Tool
(DART)

msiexec /package anyconnect-win-version-dart-predeploy-k9.msi /norestart /passive /lvx*

anyconnect-win-ver sion-dart-predeploy-k9-install-datetimestamp.log

SBL

msiexec /package anyconnect-win-version-gina-predeploy-k9.msi /norestart /passive /lvx*

anyconnect-win-version-gina-predeploy-k9-install-datetimestamp.log

Network Access Manager

msiexec /package anyconnect-win-version-nam-predeploy-k9.msi /norestart /passive /lvx*

anyconnect-win-version-nam-predeploy-k9-install-datetimestamp.log

VPN Posture msiexec /package anyconnect-win-version-posture-predeploy-k9.msi /norestart/passive /lvx*
anyconnect-win-version-posture-predeploy-k9-install-datetimestamp.log

ISE Posture msiexec /package anyconnect-win-version-iseposture-predeploy-k9.msi /norestart /passive
/vx*
anyconnect-win-version-iseposture-predeploy-k9-install-datetimestamp.log

AMP Enabler msiexec /package anyconnect-win-version-amp-predeploy-k9.msi /norestart /passive /lvx*

Network Visibility Module

msiexec /package anyconnect-win-version-nvm-predeploy-k9.msi /norestart /passive /lvx*

anyconnect-win-ver sion-nvm-predeploy-k9-install-datetimestamp.log

Umbrella Roaming Security

msiexec /package anyconnect-win-version-umbrella-predeploy-k9.msi / norestart /passive
/vx*

anyconnect-version-umbrella-predeploy-k9-install-datetimestamp.log

AnyConnect Sample Windows Transform

Cisco provides example Windows transforms, along with documents that describe how to use the transforms.
A transform that starts with an underscore character () is a general Windows transform which allows you to
apply only certain transforms to certain module installers. Transforms that start with an alphabetic character
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are VPN transforms. Each transform has a document that explains how to use it. The transform download is
sampleTransforms-X.X.X.zip.

Windows Predeployment Security Options

Cisco recommends that end users are given limited rights on the device that hosts the AnyConnect Secure
Mobility Client. If an end user warrants additional rights, installers can provide a lockdown capability that
prevents users and local administrators from switching off or stopping those Windows services established
as locked down on the endpoint. With the lockdown service option enabled, you can also uninstall all
AnyConnect Modules if you have administrator privileges.

Windows Lockdown Property

Each MST installer supports a common property (LOCKDOWN) which, when set to a non-zero value, prevents
the Windows service(s) associated with that installer from being controlled by users or local administrators
on the endpoint device. We recommend that you use the sample transform
(anyconnect-vpn-transforms-X.X.xxxxx.zip) provided at the time of install to set this property and apply the
transform to each MSI installer that you want to have locked down. The lockdown option is also a check box
within the ISO Install Utility.

Hide AnyConnect from Add/Remove Programs List

You can hide the installed AnyConnect modules from users that view the Windows Add/Remove Programs
list. You cannot start or stop AnyConnect services. If you launch any installer using
ARPSYSTEMCOMPONENT=1, that module will not appear in the Windows Add/Remove Programs list.

We recommend that you use the sample transform (anyconnect-vpn-transforms-X.X.xxxxx.zip) that we
provide to set this property. Apply the transform to each MSI installer for each module that you want to hide.

AnyConnect Module Installation and Removal Order on Windows

Step 1

Step 2

The module installers verify that they are the same version as the core client before starting to install. If the
versions do not match, the module does not install, and the installer notifies the user of the mismatch. If you
use the Install Utility, the modules in the package are built and packaged together, and the versions always
match.

Install the AnyConnect modules in the following order:

a)

b)

<)

Install the AnyConnect core client module, which installs the GUI and VPN capability (both SSL and IPsec).

In Windows and macOS, a restricted user account (ciscoacvpnuser) is created to enforce the principle of least privilege
only when the management tunnel feature is detected as enabled. This account gets removed during AnyConnect
uninstallation or during an installation upgrade.

Install the AnyConnect Diagnostic and Reporting Tool (DART) module, which provides useful diagnostic information
about the AnyConnect installation.

Install the Umbrella Roaming Security, Network Visibility Module, AMP Enabler, SBL, Network Access Manager,
Posture modules, or ISE compliance modules in any order.

Uninstall the AnyConnect modules in the following order:

a) Uninstall Umbrella Roaming Security, Network Visibility Module, AMP Enabler, Network Access Manager, Posture,

ISE Compliance module, or SBL, in any order.

b) Uninstall the AnyConnect core client module.
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¢) Uninstall DART last.

DART information is valuable should the uninstall processes fail.

)

Note By design, some XML files remain after uninstalling AnyConnect.

Predeploying to mac0S

Install and Uninstall AnyConnect on mac0S

AnyConnect for macOS is distributed in a DMG file, which includes all the AnyConnect modules. When
users open the DMG file, and then run the AnyConnect.pkg file, an installation dialog starts, which guides
the user through installation. On the Installation Type screen, the user is able to select which packages (modules)
to install.

AnyConnect 4.9.04xxx is the minimum required version on macOS 11. For details on the AndyConnect
changes pertaining to macOS 11, refer to the Appendix: AnyConnect Changes Related to macOS 11 (And
Later) , on page 307.

To remove any of the AnyConnect modules from your distribution, run the AnyConnect uninstaller in Finder
and navigate to Applications > Cisco and double click Uninstall. Or run the VPN vpn_uninstall.sh script in
/opt/cisco/anyconnect/bin and choose which CLI uninstall script to run.

Getting Write Permissions to Place Profiles for macOS Predeployment

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6
Step 7

The following procedure explains how to customize a module, create a profile, and add that profile to the
DMG package. You must establish write permissions for the installer image before copying any files to the
embedded profiles folder. It also sets the AnyConnect user interface to start automatically on boot-up, which
enables AnyConnect to provide the necessary user and group information for the module.

Download the AnyConnect DMG package (such as cisco-secure-client-macos-<version>-nvm-standalone.dmg for the
Network Visibility Module) from Cisco.com.

During the installation process, approve the system extensions popup that appears.

When the installation is complete, the standalone application is installed on the endpoint, and the supporting files are
placed under the /opt/cisco/secureclient directory of the appropriate module. For example, for Network Visibility Module,
the files are placed in /opt/cisco/secureclient/nvm.

Open the file to access the installer. Note that the downloaded image is a read-only file.

Make the installer image writable by either running the Disk Ultility or using the Terminal application, as follows: hdiutil
convert <source dmg> -format UDRW -o <output dmg>

Install the stand-alone Profile Editor on a computer running a Windows operating system. You must choose the AnyConnect
modules you want as part of a custom installation or perform a complete installation. They are not installed by default.

Start the profile editor and create a profile with the required configuration.

Using Network Visibility Module as an example, the steps below explain how to appropriately save the profile. Following
these steps, the profile editor creates an additional obfuscated version of the profile (such as NVM_ ServiceProfile.wso
for Network Visibility Module) and saves it to the same location as you saved the file (such as NVM_ ServiceProfile.xml).
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a) Copy the specified .wso file from the Windows device to the macOS installer package in the appropriate folder path,
such as AnyConnect x.x.x/Profiles/NVM. Or, use the Terminal application, as shown below for Network Visibility
Module instance:cp <path to the wso> \Volumes\"AnyConnect <VERSION>"\Profiles\nvm\

b) Inthe macOS installer, go to the AnyConnect x.x.x/Profiles directory and open the ACTransforms.xml file in TextEdit
for editing. Set the <DisableVPN> element to trueto ensure that VPN functionality is not
installed:<ACTransforms><DisableVPN>true</DisableVPN></ACTransforms>

¢) The AnyConnect DMG package is now ready to distribute to your users.

Restrict Applications on mac0S

Gatekeeper restricts which applications are allowed to run on the system. You can choose to permit applications
downloaded from:

* Mac App Store
* Mac App Store and identified developers
» Anywhere

The default setting is Mac App Store and identified developers (signed applications).

The current version of AnyConnect is signed using an Apple-issued certificate and is notarized by Apple. If
Gatekeeper is configured for Mac App Store (only), then you must either select the App Store and identified
developer s setting or control-click to bypass the selected setting to install and run AnyConnect from a
predeployed installation. For more information see: Safely open apps on your Mac

Predeploying to Linux

Installing Modules for Linux

You can break out the individual installers for Linux and distribute them manually. Each installer in the
predeploy package can run individually. Use a compressed file utility to view and extract the files in the tar.gz
file.

Step 1 Install the AnyConnect core VPN module, which installs the GUI and VPN capability (both SSL and IPsec).

Step 2 Install the DART module, which provides diagnostic information about the AnyConnect core VPN and other installed
modules.

Step 3 Install the posture module or ISE compliance module.
Step 4 Install the Network Visibility Module.

Using RPM or DEB Installer for Upgrade

When using an RPM/DEB installer to upgrade from the version installed by the script, the following limitations
exist:

 Automatic client update from headend is not supported. You must do updates out-of-band with a system
package manager.
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* The only AnyConnect modules supported with RPM and DEB installers are VPN and DART.

* You must uninstall current existing AnyConnect (including all modules) before switching to use RPM
or DEB installer.

* You cannot use a script installer to update an existing RPM or DEB installation.

Uninstalling Modules for Linux

The order that the user uninstalls AnyConnect is important.

DART information is valuable if the uninstall processes fails.

Step 1 Uninstall the Network Visibility Module.

Step 2 Uninstall the posture module or ISE compliance module.
Step 3 Uninstall the AnyConnect core VPN module.

Step 4 Uninstall DART.

Manually Installing/Uninstalling NVM on a Linux Device

Step 1 Extract the AnyConnect predeploy package.

Step 2 Navigate to the nvm directory.
Step 3 Invoke the script $sudo ./nvm_install.sh.

You can uninstall Network Visibility Module using /opt/cisco/anyconnect/bin/nvm_uninstall.sh.

Certificate Store for Server Certificate Verification

By default, AnyConnect uses the PEM File certificate store, including system CA certificate location
(/etc/ssl/certs) to verify server certificates. NSS certificate store could also be used for AnyConnect to verify
server certificates.

To Activate NSS Certificate Store

If you have never launched a Firefox browser installed on a Linux device, you must first create a Firefox user
profile, which includes a certificate store. AnyConnect attempts to use it for server certification verification.
If You Do Not Use the NSS Certificate Store

You must configure the local policy to exclude the Firefox NSS certificate store and must keep the PEM File
certificate store enabled.

Multiple Module Requirement

If you deploy the core client plus one or more optional modules, you must apply the lockdown property to
each of the installers.
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This action is available for the VPN installer, Network Access Manager, Network Visibility Module, and
Umbrella Roaming Security Module.

\)

Note Ifyou choose to activate lockdown to the VPN installer, you will consequently be locking down AMP as well.

Manually Installing DART on a Linux Device
1. Store anyconnect-dart-linux-(ver)-k9.tar.gz locally.

2. From a terminal, extract the tar.gz file using the tar -zxvf <path to tar.gz file including the file name
command.

3. From a terminal, navigate to the extracted folder and run dart_install.sh using the sudo ./dart_install.sh
command.

4. Accept the license agreement and wait for the installation to finish.

\}

Note  You can only uninstall DART using /opt/cisco/anyconnect/dart/dart_uninstall.sh.

Web Deploying AnyConnect

Web deployment refers to the AnyConnect Downloader on the client system getting AnyConnect software
from a headend, or to using the portal on the headend to install or update AnyConnect. As an alternative to
our traditional web launch which relied too heavily on browser support (and Java and ActiveX requirements),
we improved the flow of auto web deploy, which is presented at initial download and upon launch from a
clientless page. Automatic provisioning (Weblaunch) works on Windows operating systems with Internet
Explorer browsers only.

Web Deployment with the Secure Firewall ASA
The Clientless Portal on the Secure Firewall ASA web deploys AnyConnect.

Users open a browser and connect to the Secure Firewall ASA clientless portal. On the portal, the users click
the Start AnyConnect Client button. They can then download the AnyConnect package manually.

You are not required to configure the AnyConnect web-deploy package on the Secure Firewall ASA if you
are using a different method for software updates or if you don't need profile editor integration with ASDM.

Secure Firewall ASA Web-Deployment Restrictions

* Loading multiple AnyConnect packages for the same operating system to the Secure Firewall ASA is
not supported.

» The OPSWAT definitions are not included in the VPN Posture module when web deploying. You must
either manually deploy the HostScan module or load it on the ASA in order to deliver the OPSWAT
definitions to the client.

* If your Secure Firewall ASA has only the default internal flash memory size, you could have problems
storing and loading multiple AnyConnect packages on the ASA. Even if you have enough space on flash
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to hold the package files, the Secure Firewall ASA could run out of cache memory when it unzips and
loads the client images. For more information about the Secure Firewall ASA memory requirements
when deploying AnyConnect, and possibly upgrading the ASA memory, see the latest release notes for
your VPN Appliance.

» Users can connect to the Secure Firewall ASA using the IP address or DNS, but the link-local secure
gateway address is not supported.

* You must add the URL of the security appliance supporting web launch to the list of trusted sites in
Internet Explorer. This can be done with a group policy, as described in Add the ASA to the List of
Internet Explorer Trusted Sites on Windows.

* For Windows users, we recommend that you install Microsoft NET framework 4.6.2 (and later) before
installation or initial use. At startup, the Umbrella service checks if NET framework 4.0 (or newer) is
installed. If it is not detected, the Umbrella module is not activated, and a message is displayed. To go
and then install the NET Framework, you must reboot to activate the Umbrella module.

Web Deployment with ISE

Policies on ISE determine when the AnyConnect will be deployed. The user opens a browser and connects
to a resource controlled by ISE and is redirected to the AnyConnect portal. That ISE Portal helps the user
download and install AnyConnect. The Portal downloads the Network Setup Assistant, and that tool helps
the user install AnyConnect.

| SE Deployment Restrictions

* If both ISE and Secure Firewall ASA are web deploying AnyConnect, the configurations must match
on both headends.

* The ISE server can only be discovered by the AnyConnect ISE Posture agent if that agent is configured
in the ISE Client Provisioning Policy. The ISE administrator configures either the NAC Agent or the
AnyConnect ISE Posture module under Agent Configuration > Policy > Client Provisioning.

Configuring Web Deployment on the ASA

Download the AnyConnect Package

Download the latest AnyConnect Secure Mobility Client package from the Cisco Software Download webpage.

0s AnyConnect Web-Deploy Package Names
Windows anyconnect-win-version-webdeploy-k9.pkg
macOS anyconnect-macos-version-webdeploy-k9.pkg
Linux (64-bit) anyconnect-linux64-version-webdeploy-k9.pkg

\)

Note  You should not have different versions for the same operating system on the Secure Firewall ASA.
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Load the AnyConnect Package on the Secure Firewall ASA

Step 1 Navigate to Configuration > Remote Access> VPN > Network (Client) Access> AnyConnect Client Software. The
AnyConnect panel displays the AnyConnect images currently loaded on the Secure Firewall ASA. The order in which
the images appear is the order the Secure Firewall ASA downloads them to remote computers.

Step 2 To add the AnyConnect image, click Add and choose one of the following:
* Click Browse Flash to select the AnyConnect image you have already uploaded to the Secure Firewall ASA.

* Click Upload to browse to the AnyConnect image you have stored locally on your computer.

Step 3 Click OK or Upload.
Step 4 Click Apply.

Enable Additional AnyConnect Modules

To enable additional features, specify the new module names in the group-policy or Local Users configuration.
Be aware that enabling additional modules impacts download time. When you enable features, AnyConnect
must download those modules to the VPN endpoints.

)

Note If you choose Start Before Login, you must also enable this feature in the AnyConnect VPN profile.

Step 1 In ASDM go to Configuration > Remote Access VPN > Network (Client) Access > Group Poalicies.
Step 2 Select a group policy and click Edit or Add a new group policy.

Step 3 In the navigation pane, select VPN Policy > AnyConnect Client. At Client Modulesto Download, click Add and
choose each module you want to add to this group policy. The modules that are available are the ones you added or
uploaded to the Secure Firewall ASA.

Step 4 Click Apply and save your changes to the group policy.

Create a Client Profile in ASDM

You must add the AnyConnect web-deployment package to the Secure Firewall ASA before you can create
a client profile on the Secure Firewall ASA.

Step 1 Navigate to Configuration > Remote Access VPN > Network (Client) Access> AnyConnect Client Profile.
Step 2 Select the client profile you want to associate with a group and click Change Group Policy.

Step 3 In the Change Policy for Profile policy name window, choose a group policy from the Available Group Policies field
and click the right arrow to move it to the Policies field.

Step 4 Click OK.
Step 5 In the AnyConnect profile page, click Apply.
Step 6 Click Save.
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Step 7 When you have finished with the configuration, click OK.

Configuring Web Deployment on ISE

ISE can configure and deploy the AnyConnect core VPN module, ISE Posture module, and OPSWAT
(compliance module) to support posture for ISE. ISE can also deploy all the AnyConnect modules and resources
that can be used when connecting to the Secure Firewall ASA. When a user browses to a resource controlled
by ISE:

* If ISE is behind a Secure Firewall ASA, the user connects the ASA, downloads AnyConnect, and makes
a VPN connection. If AnyConnect ISE Posture was not installed by the Secure Firewall ASA, then the
user is redirected to the AnyConnect portal to install the ISE Posture.

* If ISE is not behind a Secure Firewall ASA, users connect to the AnyConnect portal, which guides them
to install the AnyConnect resources defined in the AnyConnect configuration on ISE. A common
configuration is to redirect the browser to AnyConnect provisioning portal if the ISE Posture status is
unknown.

* When the user is directed to the AnyConnect provisioning portal in ISE:

« If the browser is Internet Explorer, ISE downloads AnyConnect Downloader, and the Downloader
loads the AnyConnect.

* For all other browsers, ISE opens the client provisioning redirection portal, which displays a link
to download the Network Setup Assistant (NSA) tool. The user runs the NSA, which finds the ISE
server, and downloads the AnyConnect downloader.

When the NSA is done running in Windows, it deletes itself. When it is done running on macOS,
it must be manually deleted.

The ISE documentation describes how to:
* Create AnyConnect configuration profiles in ISE
» Add AnyConnect resources to ISE from a local device
* Add AnyConnect provisioning resources from a remote site

* Deploy the AnyConnect and resources

\}

Note Because AnyConnect ISE posture module does not support web proxy based redirection in discovery, Cisco

recommends that you use non-redirection based discovery. You can find further information in the Client

Provisioning Without URL Redirection for Different Networks section of the Cisco Identity Services Engine

Administrator Guide.

ISE can configure and deploy the following AnyConnect resources:

» AnyConnect core VPN and other modules, including the ISE Posture module

* Profiles: Network Visibility Module, AMP, VPN, Network Access Manager, Customer Feedback and
ISE Posture
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* Files for customization
* UI Resources

* Binaries, connection scripts and help files

* Localization files

» AnyConnect gettext translations for message localizations

* Windows Installer Transforms

Prepare AnyConnect Files for ISE Upload

» Download the AnyConnect packages for your operating systems, and other AnyConnect resources that
you want to deploy to your local PC.

N

Note  With Secure Firewall ASA, installation happens with the VPN downloader. With
the download, the ISE posture profile is pushed via Secure Firewall ASA, and
the discovery host needed for later provisioning the profile is available before
the ISE posture module contacts ISE. Whereas with ISE, the ISE posture module
will get the profile only after ISE is discovered, which could result in errors.
Therefore, Secure Firewall ASA is recommended to push the ISE posture module
when connected to a VPN.

* Create profiles for the modules you plan to deploy. At a minimum, create the AnyConnect ISE Posture
profile (ISEPostureCFG.xml).

\}

Note An ISE posture profile with a Call Home List is mandatory for predeploying the
ISE posture module, if non-redirection based discovery is used.

» Combine customization and localization resources into a ZIP archive, which is called a bundle in ISE.
A bundle can contain:

* AnyConnect Ul resources
* VPN Connection Scripts
* Help file(s)
* Installer Transforms
The AnyConnect localization bundle can contain:
* AnyConnect gettext translations, in binary format

« Installer transforms

Creating ISE bundles is described in Prepare AnyConnect Customizations and Localizations for ISE Deployment
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Configure ISE to Deploy AnyConnect

You must upload the AnyConnect package to ISE before you upload and create additional AnyConnect
resources.

)

Note When configuring the AnyConnect configuration object in ISE, unchecking the VPN module under AnyConnect
module selection does not disable the VPN on the deployed/provisioned client.

1. InISE, select Policy > Policy Elements> results> . Expand Client Provisioning to show Resour ces,
and select Resour ces.

2. Select Add > Agent resour cesfrom local disk, and upload the AnyConnect package file. Repeat adding
agent resources from local disk for any other AnyConnect resources that you plan to deploy.

3. Select Add > AnyConnect Configuration > . This AnyConnect configuration configures modules,
profiles, customization/language packages, and the OPSWAT package, as described in the following
table.

The AnyConnect ISE Posture profile can be created and edited in ISE, on the Secure Firewall ASA, or
in the Windows AnyConnect Profile Editor. The following table describes the name of each AnyConnect
resource, and the name of the resource type in ISE.

Table 4: AnyConnect Resources in ISE

Prompt ISE Resource Type and Description
AnyConnect Package AnyConnectDesktopWindows
AnyConnectDesktopOSX

AnyConnectWebAgentWindows
AnyConnectWebAgentOSX

Compliance Module AnyConnectComplianceModuleWindows

AnyConnectComplianceModuleOSX

AnyConnect Profiles AnyConnectProfile
ISE displays a checkbox for each profile provided by the uploaded
AnyConnect package.

Customization Bundle AnyConnectCustomizationBundle

Localization Bundle AnyConnectLocalizationBundle

4. Create a Role or OS-based client provisioning policy. AnyConnect and the ISE legacy NAC/MAC agent
can be selected for Client provisioning posture agents. Each CP policy can only provision one agent, either
the AnyConnect agent or the legacy NAC/MAC agent. When configuring the AnyConnect agent, select
one AnyConnect configuration created in step 2.
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Configuring Web Deployment on Secure Firewall Threat Defense

A Firepower Threat Defense device is a Next Generation Firewall (NGFW) that provides secure gateway
capabilities similar to the Secure Firewall ASA. Firepower Threat Defense devices support Remote Access
VPN (RA VPN) using the AnyConnect Secure Mobility Client only, no other clients, or clientless VPN access
is supported. Tunnel establishment and connectivity are done with IPsec IKEv2 or SSL. IKEv1 is not supported
when connecting to a Secure Firewall Threat Defense device.

Windows, macOS, and Linux AnyConnect is configured on the Firepower Threat Defense headend and
deployed upon connectivity, giving remote users the benefits of an SSL or IKEv2 IPsec VPN client without
the need for client software installation and configuration. In the case of a previously installed client, when
the user authenticates, the Firepower Threat Defense headend examines the revision of the client, and upgrades
the client as necessary.

Without a previously installed client, remote users enter the I[P address of an interface configured to download
and install the AnyConnect. The Firepower Threat Defense headend downloads and installs the client that
matches the operating system of the remote computer, and establishes a secure connection.

The AnyConnect apps for Apple iOS and Android devices are installed from the platform app store. They
require a minimum configuration to establish connectivity to the Firepower Threat Defense headend. As with
other headend devices and environments, alternative deployment methods, as described in this chapter, can
also be used to distribute the AnyConnect software.

Currently, only the AnyConnect core VPN and the AnyConnect VPN Profile can be configured on the
Firepower Threat Defense and distributed to endpoints. A Remote Access VPN Policy wizard in the Secure
Firewall Management Center quickly and easily sets up these basic VPN capabilities.

Guidelines and Limitations for AnyConnect and Firepower Threat Defense

* The only supported VPN client is the AnyConnect Secure Mobility Client. No other clients or native
VPN are supported. Clientless VPN is not supported as its own entity; it is only used to deploy the
AnyConnect.

* Using AnyConnect with Firepower Threat Defense requires version 4.0 or later of AnyConnect, and
version 6.2.1 or later of the Secure Firewall Management Center.

* There is no inherent support for the AnyConnect Profile Editor in the Secure Firewall Management
Center; you must configure the VPN profiles independently. The VPN Profile and AnyConnect VPN
package are added as File Objects in the Secure Firewall Management Center, which become part of the
RA VPN configuration.

* Secure Mobility, Network Access Management, and all the other AnyConnect modules and their profiles
beyond the core VPN capabilities are not currently supported.

* VPN Load balancing is not supported.
* Browser Proxy is not supported.

* All posture variants (HostScan, Endpoint Posture Assessment, and ISE) and Dynamic Access Policies
based on the client posture are not supported.

* The Firepower Threat Defense device does not configure or deploy the files necessary to customize or
localize AnyConnect.

* Features requiring Custom Attributes on the AnyConnect are not supported on Firepower Threat Defense
such as: Deferred Upgrade on desktop clients and Per-App VPN on mobile clients.
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* Authentication cannot be done on the Firepower Threat Defense headend locally; therefore, configured
users are not available for remote connections, and the Firepower Threat Defense cannot act as a Certificate
Authority. Also, the following authentication features are not supported:

* Secondary or double authentication

* Single Sign-on using SAML 2.0

* TACACS, Kerberos (KCD Authentication) and RSA SDI
* LDAP Authorization (LDAP Attribute Map)

* RADIUS CoA

For details on configuring and deploying AnyConnect on a Firepower Threat Defense, see the Firepower
Threat Defense Remote Access VPN chapter in the appropriate release of the Firepower Management Center
Configuration Guide, Release 6.2.1 or later.

Updating AnyConnect Software and Profiles

AnyConnect can be updated in several ways. Upgrades to Cisco Secure Client from AnyConnect 4.x use the
same process as upgrades from older versions of Secure Client 5 to the most recent versions of Secure Client
5.

* AnyConnect—When AnyConnect connects to the Secure Firewall ASA, the AnyConnect Downloader
checks to see if any new software or profiles have been loaded on the Secure Firewall ASA. It downloads
those updates to the client, and the VPN tunnel is established.

* Cloud Update—The Umbrella Roaming Security Module can provide automatic updates for all installed
AnyConnect modules from the Umbrella Cloud infrastructure. With Cloud Update, the software upgrades
are obtained automatically from the Umbrella Cloud infrastructure, and the update track is dependent
upon that and not any action of the administrator. By default, automatic updates from Cloud Update are
disabled.

» ASA or FTD Portal—You instruct your users to connect to the Secure Firewall ASA Clientless Portal
to get updates. FTD downloads the core VPN module only.

* ISE—When a user connects to ISE, ISE uses its AnyConnect configuration to decide if there are updated
components or new posture requirements. Upon authorization, the Network Access Device (NAD)
redirects the users to the ISE portal, and the AnyConnect downloader is installed on the client to manage
the package extraction and installation. You must upload the deploy package to the Secure Firewall ASA
headend and make sure that the versions of AnyConnect match the Secure Firewall ASA and ISE
deployment package versions.

Receiving a message that "automatic software updates are required but cannot be performed while the
VPN tunnel is established" indicates that the configured ISE policy requires updates. When the
AnyConnect version on the local device is older than what's configured on ISE, you have the following
options, because client updates are not allowed while the VPN is active:

* Deploy AnyConnect update out of band

* Configure the same version of AnyConnect on the Secure Firewall ASA and ISE
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You can allow the end user to delay updates, and you can also prevent clients from updating even if you do
load updates to the headend.

Upgrade Example Flows

Prerequisites

The following examples assume that:

* You have created a Dynamic Authorization Control List (DACL) in ISE that uses the posture status of
the client to determine when to redirect the client to the AnyConnect Client Provisioning portal on ISE,
and that DACL has been pushed to the Secure Firewall ASA.

« ISE is behind the Secure Firewall ASA.

AnyConnect isInstalled on the Client
1. User starts AnyConnect, provides credentials, and clicks Connect.

2. Secure Firewall ASA opens SSL connection with client, passes authentication credentials to ISE, and ISE
verifies the credentials.

3. AnyConnect launches the AnyConnect Downloader, which performs any upgrades, and initiates a VPN
tunnel.

If ISE Posture was not installed by the Secure Firewall ASA, then
1. A user browses to any site and is redirected to AnyConnect provisioning portal on ISE by the DACL.

2. With the browser, the user downloads and executes Network Setup Assistant (NSA), which downloads
and starts the AnyConnect Downloader.

3. The AnyConnect Downloader performs any AnyConnect upgrades configured on ISE, which now includes
the AnyConnect ISE Posture module.

4. The ISE Posture agent on the client starts posture.

AnyConnect isNot I nstalled

1. The user browses to a site, which starts a connection to the Secure Firewall ASA Portal.
2. The user provides authentication credentials, which are passed to ISE, and verified.

3. AnyConnect Downloader is launched by ActiveX control on Internet Explorer and by Java applet on other
browsers.

4. AnyConnect Downloader performs upgrades configured on Secure Firewall ASA and then initiates VPN
tunnel. Downloader finishes.

If ISE Posture was not installed by the Secure Firewall ASA, then

1. User browses to a site again and is redirected to AnyConnect client provisioning portal on ISE.

2. On Internet Explorer, an ActiveX control launches Downloader. On other browsers, the user downloads
and executes Network Setup Assistant, which downloads and launches the Downloader.

3. The AnyConnect Downloader performs any upgrades configured on ISE through the existing VPN tunnel,
which includes adding the AnyConnect ISE Posture module.

4. ISE Posture agent starts posture assessment.
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Disabling AnyConnect Auto Update

It is possible to disable or limit AnyConnect automatic updates by configuring and distributing client profiles.
* In the VPN Client Profile:

« Auto Update disables automatic updates. You can include this profile with the AnyConnect
web-deployment installation or add to an existing client installation. You can also allow the user to
toggle this setting.

* In the VPN Local Policy Profile:

» Bypass Downloader prevents any updated content on the Secure Firewall ASA from being
downloaded to the client.

* Update Policy offers granular control over software and profiles updates when connecting to different
headends.

Prompting Users to Download AnyConnect During WebLaunch

Step 1
Step 2
Step 3

Step 4

You can configure the Secure Firewall ASA to prompt remote users to start web deployment, and configure
a time period within which they can choose to download AnyConnect or go to the clientless portal page.

Prompting users to download AnyConnect is configured on a group policy or user account. The following
steps show how to enable this feature on a group policy.

In ASDM go to Configuration > Remote Access VPN > Network (Client) Access > Group Policies.

Select a group policy and click Edit or Add a new group policy.

In the navigation pane, choose Advanced > AnyConnect Client > Login Settings. Uncheck the Inherit check box,
if necessary, and select a Post Login setting.

If you choose to prompt users, specify a timeout period and select a default action to take when that period expires in the
Default Post Login Selection area.

Click OK and be sure to apply your changes to the group policy, then click Save.

Allowing Users to Defer Upgrade

You can force users to accept the AnyConnect update by disabling AutoUpdate, as described in Disabling
AnyConnect Auto Update. AutoUpdate is on by default.

You can also allow users to defer client update until later by setting Deferred Update. If Deferred Update is
configured, then when a client update is available, AnyConnect opens a dialog asking the user if they would
like to update, or to defer. Deferred Upgrade is supported by all Windows, Linux and macOS.

Configure Deferred Update on Secure Firewall ASA

On the Secure Firewall ASA, Deferred Update is enabled by adding custom attributes and then referencing
and configuring those attributes in the group policies. You must create and configure all custom attributes to
use Deferred Upgrade.
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The procedure to add custom attributes to your Secure Firewall ASA configuration is dependent on the
ASA/ASDM release you are running. See the Cisco ASA Series VPN CLI or ASDM Configuration Guide
that corresponds to your ASA/ASDM deployed release for custom attribute configuration procedures.

The following attributes and values configure Deferred Update in ASDM:

Custom Attribute *

Valid
Values

Default
Value

Notes

true false

false

True enables deferred update. If deferred update is disabled (false), the settings below
are ignored.

XXX

0.0.0

Minimum version of AnyConnect that must be installed for updates to be deferrable.

The minimum version check applies to all modules enabled on the headend. If any
enabled module (including VPN) is not installed or does not meet the minimum
version, then the connection is not eligible for deferred update.

If this attribute is not specified, then a deferral prompt is displayed (or auto-dismissed)
regardless of the version installed on the endpoint.

Defed Dt

0-300
(seconds)

150
seconds

Number of seconds that the deferred upgrade prompt is displayed before being
dismissed automatically. This attribute only applies when a deferred update prompt
is to be displayed (the minimum version attribute is evaluated first).

If this attribute is missing, then the auto-dismiss feature is disabled, and a dialog is
displayed (if required) until the user responds.

Setting this attribute to zero allows automatic deferral or upgrade to be forced based
on:

* The installed version and the value of DeferredUpdateMinimum Version.

* The value of DeferredUpdateDismissResponse.

defer
update

update

Action to take when DeferredUpdateDismissTimeout occurs.

Configure Deferred Update in ISE

* The custom attribute values are case-sensitive.

Step 1 Follow this navigation:

a) Choose Policy > Results.
b) Expand Client Provisioning.

¢) Select Resources, and click Add > Agent Resour ces from Local Disk.
d) Upload the AnyConnect pkg file, and choose Submit.

Step 2 Upload any other AnyConnect resources you have created.

Step 3 On Resources, add an AnyConnect Configuration using the AnyConnect package that you uploaded. The AnyConnect
configuration has fields to configure Deferred Update.
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Set the Update Policy

Update Policy Overview

AnyConnect software and profile updates occur when they are available and allowed by the client upon
connecting to a headend. Configuring the headend for AnyConnect updates makes them available. The Update
Policy settings in the VPN Local Policy file determine if they are allowed.

Update policy is sometimes referred to as software locks. When multiple headends are configured, the update
policy is also referred to as the multiple domain policy.

By default, the Update Policy settings allow software and profile updates from any headend. Set the Update
Policy parameters to restrict this as follows:

* Allow, or authorize, specific headends to update all AnyConnect software and profiles by specifying
them in the Server Name list.

The headend server name can be an FQDN or an I[P Address. They can also be wild cards, for example:
* example.com.

See Authorized Server Update Policy Behavior below for a full description of how the update occurs.

* For all other unspecified, or unauthorized headends:

* Allow or disallow software updates of the VPN core module and other optional modules using the
Allow Software Updates From Any Server option.

* Allow or disallow VPN Profile updates using the Allow VPN Profile Updates From Any Server
option.

« Allow or disallow other service module profile updates using the Allow Service Profile Updates
From Any Server option.

* Allow or disallow ISE Posture Profile updates using the Allow | SE Posture Profile Updates From
Any Server option.

* Allow or disallow Compliance Module updates using the Allow Compliance M odule Updates
From Any Server option.

See Unauthorized Server Update Policy Behavior below for a full description of how the update
occurs.

Authorized Server Update Policy Behavior

When connecting to an authorized headend identified in the Server Name list, the other Update Policy
parameters do not apply and the following occurs:

* The version of the AnyConnect package on the headend is compared to the version on the client to
determine if the software should be updated.

« If the version of the AnyConnect package is older than the version on the client, no software updates
occur.

« If the version of the AnyConnect package is the same as the version on the client, only software
modules that are configured for download on the headend and not present on the client are
downloaded and installed.
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« If the version of the AnyConnect package is newer than the version on the client, software modules
configured for download on the headend, as well as software modules already installed on the client,
are downloaded and installed.

» The VPN profile, ISE Posture profile, and each service profile on the headend is compared to that profile
on the client to determine if it should be updated:

* [f the profile on the headend is the same as the profile on the client, it is not updated.

* If the profile on the headend is different than the profile on the client, it is downloaded.

Unauthorized Server Update Policy Behavior

When connecting to an unauthorized headend, the Allow ... Updates From Any Server options are used to
determine how AnyConnect is updated as follows:

« Allow Software Updates From Any Server:

« [f this option is checked, software updates are allowed for this unauthorized Secure Firewall ASA.
Updates are based on version comparisons as described above for authorized headends.

« If this option is not checked, software updates do not occur. In addition, VPN connection attempts
will terminate if updates, based on version comparisons, should have occurred.

* Allow VPN Profile Updates From Any Server:

« If this option is checked, the VPN profile is updated if the VPN profile on the headend is different
than the one on the client.

« If this option is not checked, the VPN profile is not updated. In addition, VPN connection attempts
will terminate if the VPN profile update, based on differentiation, should have occurred.

* Allow Service Profile Updates From Any Server:

« If this option is checked, each service profile is updated if the profile on the headend is different
than the one on the client.

« If this option is not checked, the service profiles are not updated.

« Allow | SE Posture Profile Updates From Any Server:

« If this option is checked, the ISE Posture profile is updated when the ISE Posture profile on the
headend is different than the one on the client.

« If this option is not checked, the ISE Posture profile is not updated. ISE Posture profile is required
for the ISE Posture agent to work.

« Allow Compliance M odule Updates From Any Server:

* If this option is checked, the Compliance Module is updated when the Compliance Module on the
headend is different than the one on the client.

« If this option is not checked, the Compliance Module is not updated. The Compliance Module is
required for the ISE Posture agent to work.
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Update Policy Guidelines

* Enable remote users to connect to a headend using its IP address by listing that server’s IP address in the
authorized Server Namelist. If the user attempts to connect using the IP address but the headend is listed
as an FQDN, the attempt is treated as connecting to an unauthorized domain.

* Software updates include downloading customizations, localizations, scripts and transforms. When
software updates are disallowed, these items will not be downloaded. Do not rely on scripts for policy
enforcement if some clients will not be allowing script updates.

* Downloading a VPN profile with Always-On enabled deletes all other VPN profiles on the client. Consider
this when deciding whether to allow or disallow VPN profiles updates from unauthorized, or non-corporate,
headends.

* [f no VPN profile is downloaded to the client due to your installation and update policy, the following
features are unavailable:

Service Disable Untrusted Network Policy
Certificate Store Override Trusted DNS Domains
Show Pre-connect Message Trusted DNS Servers

Local LAN Access Always-On

Start Before Login Captive Portal Remediation
Local proxy connections Scripting

PPP Exclusion Retain VPN on Logoff
Automatic VPN Policy Device Lock Required
Trusted Network Policy Automatic Server Selection

* In Windows, the downloader creates a separate text log (UpdateHistory.log) that records the download
history. This log includes the time of the updates, the Secure Firewall ASA that updated the client, the
modules updated, and what version was installed before and after the upgrade. This log file is stored
here:

$ALLUSERESPROFILE%\Cisco\Cisco AnyConnect Secure Mobility Client\Logs
directory.

* You must restart the AnyConnect service to pick up any changes in the Local Policy file.

Update Policy Example

This example shows the client update behavior when the AnyConnect version on the client differs from various
Secure Firewall ASA headends.

Given the following Update Policy in the VPN Local Policy XML file:

<?xml version="1.0" encoding="UTF-8"7?>

<AnyConnectLocalPolicy acversion="2.4.140"

xmlns=http://schemas.xmlsoap.org/encoding/
xmlns:xsi=http://www.w3.0rg/2001/XMLSchema-instance
xsi:schemalLocation="http://schemas.xmlsoap.org/encoding/ AnyConnectLocalPolicy.xsd">
<FipsMode>false</FipsMode>
<BypassDownloader>false</BypassDownloader><RestrictWebLaunch>false</RestrictWebLaunch>
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<StrictCertificateTrust>false</StrictCertificateTrust>
<RestrictPreferenceCaching>false</RestrictPreferenceCaching>
<RestrictTunnelProtocols>false</RestrictTunnelProtocols>

<UpdatePolicy>
<AllowSoftwareUpdatesFromAnyServer>false</AllowSoftwareUpdatesFromAnyServer>
<AllowComplianceModuleUpdatesFromAnyServer>true</AllowComplianceModuleUpdatesFromAnyServer>
<AllowManagementVPNProfileUpdatesFromAnyServer>true</AllowManagementVPNProfileUpdatesFromAnyServer>
<AllowISEProfileUpdatesFromAnyServer>true</AllowISEProfileUpdatesFromAnyServer>
<AllowServiceProfileUpdatesFromAnyServer>false</AllowServiceProfileUpdatesFromAnyServer>
<AllowScriptUpdatesFromAnyServer>true</AllowScriptUpdatesFromAnyServer>
<AllowHelpUpdatesFromAnyServer>true</AllowHelpUpdatesFromAnyServer>
<AllowResourceUpdatesFromAnyServer>true</AllowResourceUpdatesFromAnyServer>
<AllowLocalizationUpdatesFromAnyServer>true</AllowLocalizationUpdatesFromAnyServer>
<AuthorizedServerList>

<ServerName>seattle.example.com</ServerName>

<ServerName>newyork.example.com</ServerName>

</AuthorizedServerList>

</UpdatePolicy>

</AnyConnectLocalPolicy>

With the following Secure Firewall ASA headend configuration:

ASA Headend AnyConnect Package Loaded Modules to Download
seattle.example.com Version 4.7.01076 VPN, Network Access Manager
newyork.example.com Version 4.7.03052 VPN, Network Access Manager
raleigh.example.com Version 4.7.04056 VPN, Posture

The following update sequence is possible when the client is currently running AnyConnect VPN core and
Network Access Manager modules:

* The client connects to seattle.example.com, an authorized server configured with the same version of
AnyConnect. If the VPN and Network Access Manager profiles are available for download and different
than the ones on the client, they will also be downloaded.

* The client then connects to newyork.example.com, an authorized Secure Firewall ASA configured with
anewer version of AnyConnect. The VPN and Network Access Manager modules are upgraded. Profiles
that are available for download and different than the ones on the client are also downloaded.

* The client then connects to raleigh.example.com, an unauthorized Secure Firewall ASA. Even though a
software update is necessary and a software update is available, the update is not allowed due to the
policy determining version upgrades are not allowed. The connection terminates.

Locations of User Preferences Files on the Local Computer

AnyConnect stores some profile settings on the user computer in a user preferences file and a global preferences
file. AnyConnect uses the local file to configure user-controllable settings in the Preferences tab of the client
GUI and to display information about the last connection, such as the user, the group, and the host.

AnyConnect uses the global file for actions that occur before logon, for example, Start Before Login and
AutoConnect On Start.

The following table shows the filenames and installed paths for preferences files that are placed under VPN
sub directory for AnyConnect:
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Operating System Type File and Path
Windows User C:\Users\username\AppData\Local\Cisco\ Cisco AnyConnect VPN
Client\preferences.xml
Global C:\ProgramData\Cisco\Cisco AnyConnect VPN Client\ preferences global.xml
macOS User /Users/username/.anyconnect
Global /opt/cisco/anyconnect/.anyconnect _global
Linux User /home/username/.anyconnect
Global /opt/cisco/anyconnect/.anyconnect _global

Port Used by AnyConnect

The following tables list the ports used by the AnyConnect Secure Mobility Client for each protocol.

Protocol AnyConnect Port

TLS (SSL) TCP 443

SSL Redirection TCP 80 (optional)

DTLS UDP 443 (optional, but highly recommended)
[Psec/IKEv2 UDP 500, UDP 4500
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Customize and Localize AnyConnect and Installer

* Modify AnyConnect Installation Behavior, on page 39

* Enable DSCP Preservation, on page 47

* Set Public DHCP Server Route, on page 47

* Customize the AnyConnect GUI Text and Messages, on page 48

* Create Custom Icons and Logos for the AnyConnect GUI, on page 54

* Create and Upload the AnyConnect Help File, on page 60

» Write and Deploy Scripts, on page 61

» Write and Deploy Custom Applications with the AnyConnect API, on page 64

* Use the AnyConnect CLI Commands, on page 65

* Prepare AnyConnect Customizations and Localizations for ISE Deployment, on page 68

Modify AnyConnect Installation Behavior

Disable Customer Experience Feedback

The Customer Experience Feedback module is enabled by default. This module provides Cisco with anonymous
information about what features and modules customers have enabled and are using. This information gives
us insight into the user experience so that Cisco can continue to improve quality, reliability, performance, and
user experience.

To manually disable the Customer Experience Feedback module, create a CustomerExperience Feedback.xml
file using the standalone profile editor. You must stop the AnyConnect service, name the file
CustomerExperience_Feedback.xml, and put it in the C:\ProgramData\Cisco\Cisco AnyConnect Secure
Mobility Client\CustomerExperienceFeedback) directory. When the file is created with the disable flag set,
you can manually deploy this to AnyConnect. To check the results, open the AnyConnect About menu and
verify that the Customer Experience Feedback module is not listed in the Installed Module section.

You can disable the Customer Experience Feedback module using:

* A Customer Feedback Experience module client profile—Uncheck Enable Customer Experience Feedback
Service, and distribute the profile.

* An MST file—Extract anyconnect-win-disable-customer-experience-feedback.mst from
anyconnect-vpn-transforms-X. X.xxxxx.zip.
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Modify Installation Behavior, Windows

Use the following Windows installer properties to modify AnyConnect installation behavior. In the ISO image,
the installer program setup.hta is HTML and can be edited.

\}

Note AnyConnect does not support Windows Installer ADVERTISE mode.

» Command-Line Parameters—One or more properties are passed as parameters on the command-line
installer, msiexec. This method is for predeployment; it is not supported by web deployment.

* Installer Transform—You can modify the installer property table with a transform. Several tools are
available to create transforms; one common tool is Microsoft Orca. The Orca tool is part of the Microsoft
Windows Installer Software Development Kit (SDK), which is included in the Microsoft Windows SDK.
To get the Windows SDK, browse to http://msdn.microsoft.com, and search for the SDK for your version
of Windows.

Transforms can be used for predeploy only. (Only Cisco signed transforms will work for web deploy
when the downloader invokes the installer.) You can apply your own transforms through the out-of-band
methods, but the details are outside the scope of this guide.

Limitations

The AnyConnect uninstall prompt is not customizable.

Windows Installer Properties That Customize Client Installations

The following Windows installer properties customize AnyConnect installations. Bear in mind that there are
many other Windows installer properties supported by Microsoft that you can use.

* Resetting the System MTU—When the VPN installer property (RESET ADAPTER MTU) is set to 1,
the installer resets all Windows network adapter MTU settings to their default value. The system must
be rebooted for the changes to take effect.

* Setting Windows Lockdown—Cisco recommends that end users be given limited rights to the AnyConnect
Secure Mobility Client on their device. If an end user warrants additional rights, installers can provide
a lockdown capability that prevents users and local administrators from switching off or stopping the
AnyConnect services. You can also stop the services from the command prompt with the service password.

The MSI installers for VPN, Network Access Manager, Network Visibility Module, and Umbrella
Roaming Security Module support a common property (LOCKDOWN). When LOCKDOWN is set to
anon-zero value, Windows service(s) associated with that installer cannot be controlled by users or local
administrators on the endpoint device. We recommend using the sample transform that we provide to
set this property, and apply the transform to each MSI installer that you want to have locked down. You
can download the sample transforms from the AnyConnect Secure Mobility Client software download

page.
If you deploy the core client plus one or more optional modules, you must apply the LOCKDOWN

property to each of the installers. This operation is one way only and cannot be removed unless you
re-install the product.
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\}

Note The AMP Enabler installer is coupled with the VPN installer.

* Turning on ActiveX Control—Previous versions of the AnyConnect predeploy VPN package installed
the VPN WebLaunch ActiveX control by default. Installation of the VPN ActiveX control is now turned
off by default for the most secure configuration.

When predeploying AnyConnect client and optional modules, if you require the VPN ActiveX control
to be installed with AnyConnect, you must use the NOINSTALLACTIVEX=0 option with msiexec or
a transform.

* Hiding AnyConnect from the Add/Remove Program List—You can hide the installed AnyConnect
modules from a user's Add/Remove Programs list in the Windows Control Panel. Passing
ARPSYSTEMCOMPONENT=1 to the installer prevents that module from appearing in the list of installed
programs.

We recommend that you use the sample transform we provide to set this property, applying the transform
to each MSI installer for each module that you want to hide. You can download the sample transforms
from the AnyConnect software download page.

Windows Installer Properties for AnyConnect Modules

The following table provides examples of MSI install command-line calls and the locations to deploy profiles.

Module
Installed

Command and Log File

AnyConnect
without
VPN
capability

(Use only
when
installing
standalone
modules)

msiexec /package anyconnect-win-version-predeploy-k9.msi /norestart /passive PRE_ DEPLOY_DISABLE VPN=1
/vx*

anyconnect-win-ver sion-predeploy-k9-install-datetimestamp.log

AnyConnect
with VPN
capability
(use for all
cases
except
when
installing
standalone
modules)

msiexec /package anyconnect-win-version-predeploy-k9.msi /norestart /passive /lvx*

anyconnect-win-version-predeploy-k9-install-datetimestamp.log

Customer
Experience
Feedback

msiexec /package anyconnect-win-version-predeploy-k9.msi /norestart /passive
DISABLE CUSTOMER EXPERIENCE FEEDBACK=I /lvx*

anyconnect-win-version-predeploy-k9-install-datetimestamp.log
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Module Command and Log File

Installed

Diagnostic | msiexec /package anyconnect-win-version-dart-predeploy-k9.msi /norestart /passive /lvx*

and . . . .

Reporting anyconnect-win-version-dart-predeploy-k9-install-datetimestamp.log

Tool

(DART)

SBL msiexec /package anyconnect-win-version-gina-predeploy-k9.msi /norestart /passive /lvx*
anyconnect-win-version-gina-predeploy-k9-install-datetimestamp.log

Network | msiexec /package anyconnect-win-version-nam-predeploy-k9.msi /norestart /passive /lvx*

Access . . . .

Manager anyconnect-win-version-nam-predeploy-k9-install-datetimestamp.log

VPN msiexec /package anyconnect-win-version-posture-predeploy-k9.msi /norestart/passive /lvx*

Posture anyconnect-win-ver sion-posture-predeploy-k9-install-datetimestamp.log

ISE Posture | msiexec /package anyconnect-win-version-iseposture-predeploy-k9.msi /norestart/passive /lvx*
anyconnect-win-ver sion-iseposture-predeploy-k9-install-datetimestamp.log

AMP msiexec /package anyconnect-win-version-amp-predeploy-k9.msi /norestart/ passive /lvx*
anyconnect-win-version-amp-predeploy-k9-install-datetimestamp.log

Network | msiexec /package anyconnect-win-version-nvm-predeploy-k9.msi /norestart/ passive /lvx*

Visibility . . . .
anyconnect-win-version-nvm-predeploy-k9-install-datetimestamp.log

Module

Umbrella | msiexec /package anyconnect-win-version-umbrella-predeploy-k9.msi/norestart/ passive /lvx*

Roaming . . . .

Security anyconnect-win-version-predeploy-k9-install-datetimestamp.log

Module

Import a Customized Installer Transform to the Secure Firewall Adaptive Security Appliance

Step 1

Importing a Cisco provided Windows transform to the Secure Firewall ASA allows you to use it for web
deployment.

In ASDM go to Configuration > Remote Access VPN > Network (Client) Access> AnyConnect

Customization/L ocalization > Customized I nstaller Transforms.

Step 2

Click Import.

The Import AnyConnect Customization Objects windows displays:
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Remote Access ¥PN

o
-

Localize the AnyConnect Installer Screens .

= Configuration = Remote Access ¥PN = Metwork (Client) Access =

=B} Metwork {Client) Access
)} AmviConneck Connection Profiles
)} IPsec Connection Profiles

-8 Group Palicies
Dynamic Access Policies
B

=8

= Resources
Binary
GUI Text and Messages

Localized Installer Transforms
(- Byp Address Assignment
- T, Advanced

I8 Clientless 550 VPN Access
AddfLocal Users
; fy Secure Deskkop Manager
[ Certificate Management
----- Language Localization
-8 | gad Balancing
iﬁ DHCP Server
DMS

"J--- Advanced

|
| Eﬁ) Device Setup
! % Firewall

o AnyConnect Customization/Localization

(Cuskomized Installer Transforms

AnyConnect Customization/Localization = Customized Installer Transforms

Import or Export ArsConneck-customization objects to the security appliance, These

objecksyill be served by the ASA on request From the AnyConnect client,
o SN

3tFor Cbject Mame

/

& Import AnyConnect Customization Objects

T 8 ]
Mame: EOur_corpDrate_|cnn| |

Platform: I win w |

Select & file

(%) Local computer

Path:

() Flash file system

() Remate server

I Import Mow l [ Cancel ] [ Help ]
- ,
=
|
docs 15 ) 5{4/09 10:10:34 AM EDT

file applies. You can apply transforms globally or per module with the following syntax:

Step 3
a) _name.mst: applied to all installers
b) <moduleid> name.mst: applied to a single module installer
¢) namemst: applied to the VPN installer only

Step 4

Localize the AnyConnect Installer Screens

247122

Enter the name of the file to import. The name of the transform file determines to which module the installer transform

Select a platform and specify the file to import. Click mport Now. The file now appears in the table of installer transforms.

You can translate the messages displayed by the AnyConnect installer. The Secure Firewall ASA uses a
transform to translate the messages displayed by the installer. The transform alters the installation but leaves
the original security-signed MSI intact. These transforms only translate the installer screens and do not translate

the client GUI screens.
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\)

Note Every release of AnyConnect includes a localized transform that administrators can upload to the Secure
Firewall ASA whenever they upload AnyConnect packages with new software. If you are using our localization
transform, make sure to update them with the latest release from cisco.com whenever you upload a new
AnyConnect package.

We currently offer transforms for 30 languages. These transforms are available in the following .zip file on
the AnyConnect software download page at cisco.com:

anyconnect-win-<VERSION>-webdeploy-k9-lang.zip
In this file, <VERSION> is the version of AnyConnect release.

The archive contains the transforms (.mst files) for the available translations. If you need to provide a language
to remote users that is not one of the 30 languages we provide, you can create your own transform and import
it to the Secure Firewall ASA as a new language. With Orca, the database editor from Microsoft, you can
modify existing installations and new files. Orca is part of the Microsoft Windows Installer Software
Development Kit (SDK) which is included in the Microsoft Windows SDK.

Import a Localized Installer Transform to the Secure Firewall ASA

The following procedure shows how to import a transform to the Secure Firewall ASA using ASDM.

Step 1 In ASDM go to Configuration > Remote Access VPN > Network (Client) Access> AnyConnect
Customization/L ocalization > Localized Installer Transforms.

Step 2 Click Import. The Import MST Language Localization window opens:
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Remote Access ¥PN BB Configuration = Remate Access VRN = Metwork (Client) Access = AnyConnect CustamizationfLocalization = O
TP'Tl%troductinn Localized Installer Transforms

3 Tebwork (Client) Access

AnyConnect Conneckion Profiles

IPsec Connection Profiles

= ﬁz Group Policies

Zonfigure language kranslation kables that the security appliance uses bo translake AnyviZonnect messages
implemested through M3T (Microsoft Transform file Format,

Dynamic Access Policies Language Translation Table
=T} AnyConnect Customization Localization

-1, Resources
Binary
- Gl Text and Messages
Customized Installer Tra
: ized Installer Tra
L"+J p Address Assignment
L"+J Advanced
[#-[ Clientless 551 YPM Access

nsforms

r+j g AdAfLocal Users Select a file Language Language Code
+ i Secure Deskiop Manager s . Slovenian ol
[ Certificate Management, @ Acal computer
Language Localization Path: |
2.8 Load Balancing ]
DHCP Server {7 Flash File: system Spanish (Argenting) es-ar
e DNS . |5panish (Bolivia) es-bo
[T Advanced Pt | |Spanish (Chile) es-c|
| () Remots server Spanish (Calombia) Es5-C0
Eﬁ Device Setup ; |Spanish (Costa Rica) es-cr
= | [ Spanish (Daominican Republic)  |es-do
% Firewall I l [ Spanish (Ecuador) es-a0
P Import MNow Car|spanish (El Salvadaor) Bs-s
I “ Remate Access YRM |
EEMIDE SLEREE | Spanish (Guatemala) es-gk
! gﬁ Site-to-Site YPH | Spanish (Handuras) es-hn
o | Spanish (Mexica) E5-nx
| E:g) Dievice Management | Spanish (Micaragua) es-ni
] ™ | il E Spanish (Panama) e5-pa
= Spanish (Paraguay) Es-py
B ' = Spanish (Peru es-pe
docs 15 B " - Spe) - -
Spanish (Puerto Rica) es-pr
Spanish (Uruguay) Es-1y
Step 3 Click the Language drop-down list to choose a language (and the industry-recognized abbreviation) for this transform.

If you enter the abbreviation manually, be sure to use an abbreviation recognized by browsers and operating systems.

Step 4 Click Import Now.
A message displays saying you successfully imported the table.

Step 5 Click Apply to save your changes.

In this procedure we specified the language as Spanish (es). The following illustration shows the new transform
for Spanish in the list of Languages for AnyConnect.
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Configuration = Remote Access ¥PN = Metwork (Client) Access =
AnyConnect Customization/Localization > Localized Installer Transforms

Configure language translation tables that the security appliance uses to kranslate
AnyConnect messages implemented through MST (Microsoft Transform File Format).

@ Import | [Z Export | [ Delete

Language Language Translation Table

247117

Modify Installation Behavior, mac0S

The AnyConnect installer cannot be localized. The strings used by the installer come from the macOS installer
application, not the AnyConnect installer.

)

Note  You cannot manipulate the optional module selection that is seen by the user in the installer UL. Changing the

default optional module selection in the installer Ul requires editing of the installer, which would then invalidate
the signature.

Customize Installer Behavior on mac0S with ACTransforms.xml

No standard way to customize .pkg behavior is provided for macOS, so we created ACTransforms.xml. When
this XML file is positioned with the installer, the installer reads this file before running the installation. You

must place the file in a specific location relative to the installer. The installer searches in this order to see if
a modification is found:

1. Ina “Profile” directory in the same directory as the .pkg installer file.
2. In a“Profile” directory in the root of a mounted disk image volume.
3. Ina “Profile” directory in the root of a mounted disk image volume.

The XML file has this format:

<ACTransforms>

<PropertyNamel>Value</PropertyNamel>

<PropertyName2>Value</PropertyName2>

</ACTransforms>

For example, the macOS ACTransforms.xml property is DisableVPN to create a “stand-alone” deployment
of Network Visibility Module. ACTransforms.xml is in the Profiles directory in the DMG file.

Disable the Customer Experience Feedback Module

The Customer Experience Feedback module is enabled by default. To switch this feature off on macOS:
Step 1 Convert the dmg package from read-only to read-write using Disk Utility or hdiutil. For example:

hdiutil convert anyconnect-macosx-i386-ver-k9.dmg -format UDRW -o anyconnect-macosx-1386-ver-k9-rw.dmg

Step 2 Edit ACTransforms.xml, and set or add the following value, if it is not already set.
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<DisableCustomerExperienceFeedback>false</DisableCustomerExperienceFeedback>

Modify Installation Behavior, Linux

Customizing Installer Behavior on Linux with ACTransform.xml

No standard way to customize .pkg behavior is provided for Linux, so we created ACTransforms.xml. When
this XML file is positioned with the installer, the installer reads this file before running the installation. You
must place the file in a specific location relative to the installer. The installer searches in this order to see if
a modification is found:

* In a “Profile” directory in the same directory as the .pkg installer file
* In a “Profile” directory in the root of a mounted disk image volume

* In a “Profile” directory in the same directory as the .dmg file
The XML file, ACTransforms.xml, in the Profiles directory in the predeployment package has this format:

<ACTransforms>
<PropertyNamel>Value</PropertyNamel>
<PropertyName2>Value</PropertyName2>
</ACTransforms>

Enable DSCP Preservation

You can set a custom attribute to control Differentiated Services Code Point (DSCP) on Windows or macOS
platforms for DTLS connection only. DSCP preservation allows devices to prioritize latency sensitive traffic;
the router takes into account whether this is set and marks prioritized traffic to improve outbound connection
quality.

The custom attribute type is DSCPPreservationAllowed, and the valid values are True or False.

)

Note By default AnyConnect performs DSCP preservation (True). To disable it, set the custom attribute value to
false on the headend and reinitiate the connection.

This feature is configured in ASDM at Configuration > Remote Access VPN > Network (Client) Access
> Group Policies> Add/Edit > Advanced > AnyConnect Client > Custom Attributes. Refer to the Enable
DSCP Preservation section in the appropriate release of the Cisco ASA Series VPN ASDM Configuration
Guide for the configuration process.

Set Public DHCP Server Route

To allow local DHCP traffic to flow in the clear when Tunnel All Network is configured, AnyConnect adds
a specific route to the local DHCP server when the client connects. To prevent data leakage on this route,
AnyConnect also applies an implicit filter on the LAN adapter of the host device, blocking all traffic for that
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route except DHCP traffic. If you are connecting to the external interface and using a local DHCP server once
a connection is established, a specific route to that server is created, pointing to the NIC and not the virtual
adapter. If other services are running on the same server (such as WINS or DNS)), this route breaks these
services after the VPN session is established.

On Windows, by setting a group policy custom attribute, you can control the creation of the public DHCP
server route. The no-dhcp-server-route custom attribute must be present and set to true to avoid creating the
public DHCP server route upon tunnel establishment.

This feature is configured in ASDM at Configuration > Remote Access VPN > Network (Client) Access
> Group Policies> Add/Edit > Advanced > AnyConnect Client > Custom Attributes. Refer to the
appropriate release of the Cisco ASA Series VPN ASDM Configuration Guide for the configuration process.

Customize the AnyConnect GUI Text and Messages

The Secure Firewall ASA uses translation tables to translate user messages displayed by AnyConnect. The
translation tables are text files with strings of translated message text. You can edit existing messages or add
additional languages using ASDM or using transforms (for Windows).

The following Windows sample transforms for localization are available on www.cisco.com:

» Language localization transform files for predeploy package for Windows platforms

* Language localization transform files for web-deploy package for Windows platforms

The AnyConnect package file for Windows contains a default English language template for AnyConnect
messages. The Cisco Secure Firewall ASA automatically imports this file when you load the AnyConnect
package on the ASA. This template contains the latest changes to message strings in the AnyConnect software.
You can use it to create new translation tables for other languages, or you can import one of the following
translation tables available on www.cisco.com (see Import Translation Tables to the Secure Firewall ASA,
on page 51):

* Chinese (Simplified)
* Chinese (Traditional)
* Czech

* Dutch

* French

* French (Canadian)

* German

» Hungarian

* [talian

* Japanese

* Korean

* Polish

* Portuguese (Brazil)
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* Russian

* Spanish (Latin American)

The following sections contain procedures for translating GUI text and messages if the desired languages are
not available or if you wish to further customize imported translation tables:

* Add or Edit the AnyConnect Text and Messages. You can make changes to the message file by adding
or editing the file to change message text for one or more message IDs in one of the following ways:

* Typing your changes into the text in the open dialog.

* Copying the text in the open dialog to a text editor, making your changes, and pasting the text back
into the dialog.

* Import Translation Tables to the Secure Firewall ASA, on page 51. You can export the message file by
clicking Save to File, editing the file, and importing it back into the ASDM.

After you update the translation table on the Secure Firewall ASA, the updated messages are not applied until
the client is restarted and makes another successful connection.

\}

Note Ifyou are not deploying the client from the Secure Firewall ASA and are using a corporate software deployment
system such as Altiris Agent, you can manually convert the AnyConnect translation table (anyconnect.po) to
a .mo file using a catalog utility such as Gettext and install the .mo file to the proper folder on the client
computer. See Create Message Catalogs for Enterprise Deployment for more information.

Guidelines and Limitations
AnyConnect is not fully compliant with all internationalization requirements, exceptions include:

* Date/Time formats do not always follow locale requirements.
* Right to left languages are not supported.
* Some strings are truncated in the UI due to hardcoded field lengths.

» A few hardcoded English strings remain such as:

* Status messages, when updating.
* Untrusted server messages.

* Deferred update messages.

Add or Edit the AnyConnect Text and Messages

You can make changes to the English messages displayed on the AnyConnect GUI by adding or editing the
English translation table and changing message text for one or more message IDs. After you open the message
file, you can edit it by:

* Typing your changes into the text in the open dialog.
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» Copying the text in the open dialog to a text editor, making your changes, and pasting the text back into
the dialog.

» Exporting the message file by clicking Save to File, editing the file, and importing it into the ASDM.

Step 1 In ASDM go to Configuration > Remote Access VPN > Network (Client) Access> AnyConnect
Customization/L ocalization > GUI Text and M essages.

Step 2 Click Add. The Add Language Localization Entry window displays.

Remote Access YPM o & o= Configuration = Remote Access WPN = Mebwork (Client) Access =
5D Introduction AnConnect Customization/Localization = GUI Text and Messages

|-} Nej:wnrk (Client) Access Configure language translation tables that the security
: AnyConnect Connection Profiles appliance uses to kranslate titles and messages associated with
il IPsec Connection Profiles the &ryConnect ¥PM Client user interface,
-8} Group Policies _
- Dynamic Access Palicies it | ﬁ 2] o Impnrt_ @ I
C—'r-- AnyConnect Cuskomization/Localization "/|' i

Resources | Language
Binary
GUI Text and M 5

Customized Installer Transfor
Localized Installer TransFarms

& Add Language Localization Entry

[+ Zyp Address Assignment -
:'-- Advanced Translation Domain: | iy onnect |
-8 Clientless S50 WPM Access & -
gy AAAfLocal Users Language: ( |
B Secure Deskbop Manager Language Language Code
r_,... Certificate Man..age!'nent Chinese (PRC) SHion =,
----- Languaqge Localization EhiseE T haaare) pra 7
-2 | nad Balancing
Chinese (Taiwan) zh-tva
Croatian hr
Czech s =
Danish da
Dukch (Belgium) nl-be
Dukch (3kandard) nl
English {Australia) ! en-au
English {Belize) en-bz
English {Canada) en-ca
English {Caribbean) en-029
English {Ireland) er-ie o
Frnlich { Tarmaicah en-im 7
Lo [ o4 ] [ Cancel ] [ Save to File,, ] [_ Help ] g
evice ... don '“a‘“

Step 3 Click the Language drop-list and specify the language as English (en). The translation table for English displays in the
list of languages in the pane.

Step 4 Click Edit to begin editing the messages.

The Edit Language Localization Entry window displays. The text between the quotes of msgid is the default English text
displayed by the client and must not be changed. The msgstr string contains text that the client uses to replace the default
text in msgid. Insert your own text between the quotes of the msgstr.

In the example below, we insert “Call your network administrator at 800-553-2447.”
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Remote Access YPN i Configuration > Remote Access ¥PN > Metwork {Client

S Tntroduction Access = AnyConnect Customization/Localization > GUI =

twark (Client) Access Configure language translation tables that the security

ryConneck Connection Profiles appliance uses ko translake titles and messages associated with
-l IPsec Connection Profiles the AnyConnect YPM Client user interface,
5% Group Palicies '
Mo Dynamic Access Policies “& Add | Delete & Impart G Export |
=T, AryConnect Customization/Localization nl
; | Language |
[
Custu?mlzed Installer T Feriplts
Localized Installer Transforms

Translation Domain; |

Language: =

i#: B44atrbeceandftal 961 AaBd6aTdeada ~

|msaid "The ¥PM client is unable to establish a connection,
(e =l oL nebwork administrator at &0

\#: 344andiecean3fbal96158a8d697de549
!msgid

|"The ¥PM client agent encountered a secure gateway protocal Failure, Close "
|"all sensitive networked applications.”

|msgskr ™

|#: B44atdbeceas3foal 9615450697 dc9d3

|msgid ™"

|"The ¥PM client agent 5501 engine encountered an error, Close all sensitive "
|"retwarked applications,”

" | m
[ |m=sgstr
o] |
) |#: B44andbeceasiffal 9618a3d697dc9do
E:g) Devi !msgid
|"The ¥PM client agent S5L encryption encountered an error, Close all "
|"sensitive networked applications."
_ |msgskr " e
Config... o
[ Ok ] [ Cancel l [ Save to File, ] l Help %
=t
o

Step 5 Click OK and then Apply to save your changes.

Import Translation Tables to the Secure Firewall ASA

Step 1 Download the desired translation table from www.cisco.com.

Step 2 In ASDM go to Configuration > Remote Access VPN > Network (Client) Access> AnyConnect
Customization/L ocalization > GUI Text and M essages.

Step 3 Click Import. The Import Language Localization Entry window displays.
Step 4 Choose the appropriate Language from the drop-down list.
Step 5 Specify where the translation table will be imported from.
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Step 6

Click Import Now. This translation table will be deployed to AnyConnect clients with this preferred language. Localization
will be applied after AnyConnect restarts and connects.

Create Message Catalogs for Enterprise Deployment

Step 1

Step 2
Step 3
Step 4

Step 5

If you are not deploying the client with the Secure Firewall ASA, and are using an enterprise software
deployment system such as Altiris Agent, you can manually convert the AnyConnect translation table to a
message catalog using a utility such as Gettext. After converting the table from a .po file to a .mo file, you
then place the file in the proper folder on the client computer.

)

Note GetText and PoeEdit are third-party software applications. The recommended method for AnyConnect GUI
customization is to take the default .mo file from the Secure Firewall ASA and edit it as necessary for any
deployments to the client. Using the default .mo avoids potential conversion issues resulting from third-party
applications such as GetText and PoeEdit.

Gettext is a utility from The GNU Project and runs in the command window. See the GNU website at gnu.org
for more information. You can also use a GUI-based utility that uses Gettext, such as Poedit. This software
is available at poedit.net. This procedure creates a message catalog using Gettext:

AnyConnect M essage Template Directories

AnyConnect message templates are located in the folders listed below for each operating system:

\)

Note The \110n directory is part of each directory path listed below. The directory name is spelled: lower case |
(“el”), one, zero, lower case n.

* For Windows— <Driveletter>:\ProgramData\Cisco\Cisco AnyConnect Secure
Mobility Client\110n\<LANGUAGE-CODE>\LC MESSAGES

* FormacOS and Linux— /opt/cisco/anyconnect/110n/<LANGUAGE-CODE>/LC_MESSAGES

Download the Gettext utilities from http://www.gnu.org/software/gettext/ and install Gettext on a computer that you use
for administration (not a remote user computer).

Retrieve a copy of the AnyConnect message template AnyConnect.po on a computer with AnyConnect installed.
Edit the AnyConnect.po file (use notepad.exe or any plain text editor) to change strings as desired.

Run the Gettext message file compiler to create the .mo file from the .po file:

msgfmt -o AnyConnect.mo AnyConnect.po

Place a copy of the .mo file in the correct message template directory on the user’s computer.
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Merge New Messages into a Customized Translation Table on the Secure
Firewall ASA

Step 1

Step 2

Step 3

New user messages are added to some releases of AnyConnect. To enable translation of these new messages,
new message strings are added to the translation template that is packaged with the latest client image. If you
have created translation tables based on the template included with the previous client, the new messages are
not automatically displayed to remote users. You must merge the latest template with your translation table
to ensure your translation table has these new messages.

There are free third-party tools to perform the merge. Gettext utilities from The GNU Project is available for
Windows and runs in the command window. See the GNU website at gnu.org for more information. You can
also use a GUI-based utility that uses Gettext, such as Poedit. This software is available at poedit.net. Both
methods are covered in the procedure below.

\)

Note This procedure assumes that you have already loaded the latest AnyConnect image package to the Secure
Firewall ASA. The template is not available for export until you do.

Export the latest AnyConnect Translation Template from Remote Access VPN > L anguage L ocalization > Templates.
Export the template with the filename as AnyConnect . pot. This filename ensures that the msgmerge.exe program
recognizes the file as a message catalog template.

Merge the AnyConnect Template and Translation Table.

If you are using the Gettext utilities for Windows, open a command prompt window and run the following command.
The command merges the AnyConnect translation table (.po) and the template (.pot), creating the new
AnyConnect merged.po file:

msgmerge -o AnyConnect merged.po AnyConnect.po AnyConnect.pot
The following example shows the results of the command:

C:\Program Files\GnuWin32\bin> msgmerge -o AnyConnect merged.po AnyConnect.po AnyConnect.pot

If you are using Poedit, first open the AnyConnect.po file; go to File > Open > <AnyConnect.po>. Then merge it with
the template; go to Catalog > Update from POT file <AnyConnect.pot>. Poedit displays an Update Summary window
with both new and obsolete strings. Save the file, which you will import in the next step.

Import the merged translation table to Remote Access VPN > Language L ocalization. Click mport, specify a language,
and select AnyConnect as the Translation Domain. Specify the file to import as AnyConnect merged. po.

Select the Default Language for Windows on the Client

When the remote user connects to the Secure Firewall ASA and downloads the client, AnyConnect detects
the preferred language of the computer and applies the appropriate translation table by detecting the specified
system locale.

To view or change the specified system locale on Windows:
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Step 1 Navigate to the Control Panel > Region and L anguagesdialog box. If you are viewing your Control Panel by Category,
choose Clock, Language, and Region > Change display language.

Step 2 Specify the language/locale setting, and specify that these setting should be used as the default for all user accounts.

\}

Note If a location is not specified, AnyConnect defaults to just the language. For example, if the “fr-ca” directory
is not found, AnyConnect checks for the “fr”” directory. You do not need to change the display language,
location, or keyboard to see the translations.

Create Custom Icons and Logos for the AnyConnect GUI

The tables in this section list the AnyConnect files that you can replace for each operating system. The images
in the tables are used by the AnyConnect core VPN and Network Access Manager module.

Restrictions

* The filenames of your custom components must match the filenames used by the AnyConnect GUI,
which are different for each operating system and are case sensitive for macOS and Linux. For example,
if you want to replace the corporate logo for Windows clients, you must import your corporate logo as
company_logo.png. If you import it as a different filename, the AnyConnect installer does not change
the component. However, if you deploy your own executable to customize the GUI, the executable can
call resource files using any filename.

* If you import an image as a resource file (such as company logo.bmp), the image that you import
customizes AnyConnect until you reimport another image using the same filename. For example, if you
replace company_logo.bmp with a custom image and then delete the image, the client continues to display
your image until you import a new image (or the original Cisco logo image) using the same filename.

Replace AnyConnect GUI Components

You can customize AnyConnect by importing your own custom files to the security appliance, which deploys
the new files with the client.

Step 1 In ASDM go to Configuration > Remote Access VPN > Network (Client) Access> AnyConnect
Customization/L ocalization > Resour ces.

Step 2 Click Import. The Import AnyConnect Customization Objects window displays.
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Remote Access ¥YPM o o Configuration = Remote Access WPN = Metwork (Client) Access = AnyConnect O
Introduckion 7 Customization/Localization = Resources
Mebwork (Client) Access Impart or Export AreConneck-cuskornization resources ko the security appliance, These

objects will be served by the ASA on request From the AnyConnect client,

(For &nyConnect 3.0 and newer releases, graphic file used For custamization musk be .png
file and no larger than 6233 in size. For eatlier releases of AnyConnect, agraphic File musk
be .brgFile. )
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AnyConnect Clisnt Profile
AnyConnect Clignt Settings
i}- Dynamic Access Palicies
53 Group Policies

&= IPsec(IKEv1) Connection Profiles
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< |

PlakFarm: |win “ |
&D Device Setup

Select a file

gﬂ Firewal (%) Local computer
Remate Access YPN Path: |C:'|,cnmpany_lngn.png | l Erowse Local Files. ..
Site-to-Site YPM () Flash file system

E:;L Device Management: | | Biro

() Remate server

I Import Mow H Cancel ][ Help ]

246081

Step 3 Enter the name of the file to import.
Step 4 Select a platform and specify the file to import. Click Import Now. The file now appears in the list of objects.

AnyConnect Icons and Logos for Windows

All files for Windows are located in:

$PROGRAMFILES$\Cisco\Cisco AnyConnect Secure Mobility Client\res\

N

Note %PROGRAMFILESY% refers to the environment variable by the same name. In most Windows installations,
thisis C: \Program Files.
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Filename and Description in Windows Installation Image Size (Pixels, L x H)
and Type

about.png 24 x 24

The About button in the upper-right corner of the Advanced dialog. PNG

The size is not adjustable.

®

about_hover.png 24 x 24

The About button in the upper-right corner of the Advanced dialog. PNG

The size is not adjustable.

®

app_logo.png 128 x 128

128 x 128 is the maximum size. If your custom file is not that size, it is resized |PNG
to 128 x 128 in the application. If it is not in the same ratio, it is stretched.

k4

attention.ico 16 x 16

System tray icon alerting the user to a condition requiring attention or interaction. | [CO
For example, a dialog about the user credentials.

The size is not adjustable.

il

company_logo.png 97 x 58 (maximum)

The company logo displayed in the top-left corner of the tray flyout and Advanced | PNG
dialog.

97 x 58 is the maximum size. If your custom file is not that size, it is resized to
97 x 58 in the application. If it is not in the same ratio, it is stretched.

]
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Filename and Description in Windows Installation Image Size (Pixels, L x H)
and Type
company_logo_alt.png 97 Xx58

The company logo displayed in the bottom-right corner of the About dialog. PNG

97 x 58 is the maximum size. If your custom file is not that size, it is resized to
97 x 58 in the application. If it is not in the same ratio, it is stretched.

I}

cues_bg.jpg 1260 x 1024

The background image for the tray flyout, Advanced window, and About dialog. | JPEG

Because images are not stretched, using a replacement image that is too small
results in black space.

error.ico 16 x 16

System tray icon alerting the user that something is critically wrong with one or | ICO
more components.

The size is not adjustable.

El
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Filename and Description in Windows Installation Image Size (Pixels, L x H)
and Type

neutral.ico 16x 16

System tray icon indicating that client components are operating correctly. ICO

The size is not adjustable.

&

transition 1.ico 16x 16

System tray icon that displays along with transition 2.ico and transition 3.ico |ICO
indicating that one or more client components are in transition between states
(for example, when the VPN is connecting or when Network Access Manager is
connecting). The three icon files display in succession, appearing to be a single
icon bouncing from left to right.

The size is not adjustable.
[

transition_2.ico 16x 16

System tray icon that displays along with transition 1.ico and transition 3.ico |ICO
indicating that one or more client components are in transition between states
(for example, when the VPN is connecting or when Network Access Manager is
connecting). The three icon files display in succession, appearing to be a single
icon bouncing from left to right.

The size is not adjustable.

B

transition_3.ico 16x 16

System tray icon that displays along with transition _1.ico and transition 2.ico |ICO
indicating that one or more client components are in transition between states
(for example, when the VPN is connecting or when the Network Access Manager
is connecting). The three icon files display in succession, appearing to be a single
icon bouncing from left to right.

The size is not adjustable.

[=]
vpn_connected.ico 16x 16
System tray icon indicating that the VPN is connected. ICO

The size is not adjustable.

o
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AnyConnect Icons and Logos for Linux

All files for Linux are located in:
/opt/cisco/anyconnect/resources/

The following table lists the files that you can replace and the client GUI area that is affected.

Filename and Description in Linux Installation Image Size
(Pixels, Lx H)
and Type

company-logo.png 142 x 92

Corporate logo that appears on each tab of the user interface. PNG

Use PNG images no bigger than 62x33 pixels.

atfrar]ee

cisco

cvc-about.png l6x 16

Icon that appears on the About tab. PNG

®

cve-connect.png 16x 16

Icon that appears next to the Connect button, and on the Connection tab. PNG

LA

cve-disconnect.png l6x 16

Icon that appears next to the Disconnect button. PNG

%

cve-info.png 16x 16

Icon that appears on the Statistics tab. PNG

Iud

systray connected.png 16x 16

Tray icon that displays when the client is connected. PNG

[&]

systray notconnected.png l6x 16

Tray icon that displays when the client is not connected. PNG

[=]
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Filename and Description in Linux Installation Image Size
(Pixels, Lx H)
and Type

systray disconnecting.png 16x 16

Tray icon that displays when the client is disconnecting. PNG

systray quarantined.png 16x16

Tray icon that displays when the client is quarantined. PNG

(=]

systray reconnecting.png 16x 16

Tray icon that displays when the client is reconnecting. PNG

[=]

vpnui48.png 48 x 48

Main program icon. PNG

AnyConnect Icons and Logos for mac0S

AnyConnect icons and logos for macOS GUI resource customization on macOS are currently not supported.

Create and Upload the AnyConnect Help File

Step 1
Step 2

Step 3
Step 4

Step 5

To provide AnyConnect users with help, create a help file with instructions about your site and load it on the
Secure Firewall ASA. When users connect with AnyConnect, the help file is downloaded, and the help icon
displays on the AnyConnect user interface. When the user clicks the help icon, the browser opens the help
file. PDF and HTML files are supported.

Create an HTML file named help AnyConnect.html.

In ASDM go to Configuration > Remote Access VPN > Network (Client) Access > AnyConnect
Customization/L ocalization > Binary.

Import the help_AnyConnect.xxx file. The supported formats are: PDF, HTML, HTM, and MHT.

On your device, bring up AnyConnect and connect to your Secure Firewall ASA. The help file will be downloaded to
the client device.
You should see that the help icon is added to the UI automatically.

Click the help icon to open the help file in the browser.
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If the help icon does not appear, check the help directory to see if the AnyConnect downloader was able to retrieve the
help file.

The “help_” part of the filename is removed by the downloader, so you should see AnyConnect.html in one of the
following directories, depending on the operating system:

* Windows—C : \ProgramData\Cisco\Cisco AnyConnect Secure Mobility Client\Help

* macOS—/opt/cisco/anyconnect/help

Write and Deploy Scripts

AnyConnect lets you download and run scripts when the following events occur:

* Upon the establishment of a new client VPN session with the security appliance. We refer to a script
triggered by this event as an OnConnect script because it requires this filename prefix.

* Upon the tear-down of a client VPN session with the security appliance. We refer to a script triggered

by this event as an OnDisconnect script because it requires this filename prefix.

The establishment of a new client VPN session initiated by Trusted Network Detection triggers the OnConnect
script (assuming the requirements are satisfied to run the script), but the reconnection of a persistent VPN
session after a network disruption does not trigger the OnConnect script.

Some examples that show how you might want to use this feature include:
* Refreshing the group policy upon VPN connection.
* Mapping a network drive upon VPN connection, and un-mapping it after disconnection.

* Logging on to a service upon VPN connection, and logging off after disconnection.

AnyConnect supports script launching during WebLaunch and stand-alone launches.

These instructions assume you know how to write scripts and run them from the command line of the targeted
endpoint to test them.

)

Note The AnyConnect software download site provides some example scripts; if you examine them, remember
that they are only examples. They may not satisfy the local computer requirements for running them and are
unlikely to be usable without customizing them for your network and user needs. Cisco does not support
example scripts or customer-written scripts.

Scripting Requirements and Limitations
Be aware of the following requirements and limitations for scripts:

» Number of Scripts Supported—AnyConnect runs only one OnConnect and one OnDisconnect script;
however, these scripts may launch other scripts.

* File Formats—AnyConnect identifies the OnConnect and onDisconnect script by the filename. It looks
for a file whose name begins with OnConnect or OnDisconnect regardless of file extension. The first
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script encountered with the matching prefix is executed. It recognizes an interpreted script (such as VBS,
Perl, or Bash) or an executable.

* Script Language—The client does not require the script to be written in a specific language but does
require an application that can run the script to be installed on the client computer. Thus, for the client
to launch the script, the script must be capable of running from the command line.

* Restrictions on Scripts by the Windows Security Environment—On Microsoft Windows, AnyConnect
can only launch scripts after the user logs onto Windows and establishes a VPN session. Thus, the
restrictions imposed by the user’s security environment apply to these scripts; scripts can only execute
functions that the user has rights to invoke. AnyConnect hides the cmd window during the execution of
a script on Windows, so executing a script to display a message in a .bat file for testing purposes does
not work.

* Enabling the Script—By default, the client does not launch scripts. Use the AnyConnect profile
EnableScripting parameter to enable scripts. The client does not require the presence of scripts if you do
s0.

* Client GUI Termination—Client GUI termination does not necessarily terminate the VPN session; the
OnDisconnect script runs after session termination.

* Running Scripts on 64-bit Windows—The AnyConnect is a 32-bit application. When running on a 64-bit
Windows version, it uses the 32-bit version of cmd.exe.

Because the 32-bit cmd.exe lacks some commands that the 64-bit cmd.exe supports, some scripts could
stop executing when attempting to run an unsupported command, or run partially and stop. For example,
the msg command, supported by the 64-bit cmd.exe, may not be understood by the 32-bit version of
Windows 7 (found in %WINDIR%\SysWOW64).

Therefore, when you create a script, use commands supported by the 32-bit cmd.exe.

Write, Test, and Deploy Scripts

Write and test your scripts on the targeted operating system. If a script cannot run properly from the command
line on the native operating system, then AnyConnect cannot run it properly.

Step 1 Write and test your scripts.
Step 2 Choose how to deploy the scripts:

» Use ASDM to import the script as a binary file to the Secure Firewall ASA.
Go to Network (Client) Access > AnyConnect Customization/L ocalization > Script.

If you use ASDM version 6.3 or later, the Secure Firewall ASA adds the prefix scripts_ and the prefix OnConnect
or OnDisconnect to your filename to identify the file as a script. When the client connects, the security appliance
downloads the script to the proper target directory on the remote computer, removes the scripts_ prefix and leaves
the OnConnect or OnDisconnect prefix. For example, if you import the script myscript.bat, the script appears on the
security appliance as scripts_ OnConnect_myscript.bat. On the remote computer, the script appears as
OnConnect_myscript.bat.

If you use an ASDM version earlier than 6.3, you must import the scripts with the following prefixes:

* scripts OnConnect

* scripts_OnDisconnect
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To ensure the scripts run reliably, configure all Secure Firewall ASAs to deploy the same scripts. If you modify
or replace a script, use the same name as the previous version and assign the replacement script to all of the
Secure Firewall ASAs that the users might connect to. When the user connects, the new script overwrites the
one with the same name.

+ Use an enterprise software deployment system to deploy scripts manually to the VPN endpoints.
If you use this method, use the script filename prefixes below:
* OnConnect
* OnDisconnect

Install the scripts in the following directory:

Table 5: Required Script Locations

0s Directory
Microsoft Windows %ALLUSERSPROFILE%\Cisco\Cisco AnyConnect Secure Mobility Client\Scri
Linux /opt/cisco/anyconnect

(On Linux, assign execute
permissions to the file for User,
Group and Other.)

macOS /opt/cisco/anyconnect/script

Configure the AnyConnect Profile for Scripting

Step 1
Step 2
Step 3
Step 4

Step 5

Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.
Check Enable Scripting. The client launches scripts on connecting or disconnecting the VPN connection.
Check User Controllableto let users enable or disable the running of On Connect and OnDisconnect scripts.

Check Terminate Script On Next Event to enable the client to terminate a running script process if a transition to another
scriptable event occurs. For example, the client terminates a running On Connect script if the VPN session ends and
terminates a running OnDisconnect script if AnyConnect starts a new VPN session. On Microsoft Windows, the client
also terminates any scripts that the On Connect or OnDisconnect script launched, and all their script descendents. On
macOS and Linux, the client terminates only the On Connect or OnDisconnect script; it does not terminate child scripts.

Check Enable Post SBL On Connect Script (enabled by default) to let the client launch the On Connect script (if present)
if SBL establishes the VPN session.

\)

Note Be sure to add the client profile to the Secure Firewall ASA group policy to download it to the VPN endpoint.
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Troubleshoot Scripts

If a script fails to run, try resolving the problem as follows:

Step 1 Make sure that the script has an onConnect or onDisconnect prefix name. Write, Test, and Deploy Scripts shows the
required scripts directory for each operating system.

Step 2 Try running the script from the command line. The client cannot run the script if it cannot run from the command line.
If the script fails to run on the command line, make sure the application that runs the script is installed, and try rewriting
the script on that operating system.

Step 3 Verify that there is only one OnConnect script and only one OnDisconnect script in the scripts directory on the VPN
endpoint. If the client downloads an OnConnect script from the Secure Firewall ASA, then downloads a second OnConnect
script with a different filename suffix for another Secure Firewall ASA, then the client might not run the script you
intended to run. If the script path contains more than one OnConnect or OnDisconnect script, and you are using the Secure
Firewall ASA to deploy scripts, then remove the contents of the scripts directory and re-establish a VPN session. If the
script path contains more than one OnConnect or OnDisconnect script, and you are using the manual deployment method,
then remove the unwanted scripts and re-establish a VPN session.

Step 4 If the operating system is Linux, make sure that the script file permissions are set to execute.

Step 5 Make sure that the client profile has scripting enabled.

Write and Deploy Custom Applications with the AnyConnect
API

For Windows, Linux, and macOS computers, you can develop your own executable User Interface (UI) with
the AnyConnect API. Deploy your UI by replacing the AnyConnect binary files.

The following table lists the filenames of the client executable files for the different operating systems.

Client 0S Client GUI File Client CLI File
Windows vpnui.exe vpncli.exe
Linux vpnui vpn

macOS Not supported by the Secure vpn

Firewall ASA deployment.
However, you can deploy an
executable for the macOS that
replaces the client GUI using other
means, such as Altiris Agent.

Your executable can call any resource files that you import to the Secure Firewall ASA, such as logo images.
When you deploy your own executable, you can use any filenames for your resource files.

Restrictions

* You cannot deploy updated AnyConnect software from the Secure Firewall ASA. If you place an updated
version of the AnyConnect package on the Secure Firewall ASA, the AnyConnect downloads the update,
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which replaces your custom Ul You must manage distribution of your custom client and related
AnyConnect software. Even though ASDM allows you to upload binaries to replace AnyConnect, this
deployment function is not supported when using custom applications.

* If you deploy the Network Access Manager, use the AnyConnect Secure Mobility Client GUI.

» Start Before Login is not supported.

Use the AnyConnect CLI Commands

The AnyConnect Secure Mobility Client provides a command line interface (CLI) for users who prefer to
enter client commands instead of using the graphical user interface. The following sections describe how to
launch the CLI command prompt and the commands available through the CLI:

* Launch the Client CLI Prompt, on page 65
* Use the Client CLI Commands, on page 65

* Prevent a Windows Popup Message When Secure Firewall ASA Terminates a Session, on page 67

\}

Note In Windows and macOS, the same downloader is used for profile updates in both VPN UI or CLI connections.
In Linux, the downloader for the VPN UI can display warnings and popups, such as the Untrusted Certificate
warning we often see when connecting or when downloading a profile or other component. However, a second
Linux downloader for the VPN CLI is not capable of displaying such popups and warnings, and you receive

a connection failure message as expected behavior.

Launch the Client CLI Prompt

To launch the CLI command prompt:

* (Windows) Locate the file vpncli.exe in the Windows folder C:/Program Files/Cisco/Cisco AnyConnect
Secure Mobility Client. Double click vpncli.exe.

* (Linux and macOS) Locate the file vpn in the folder /opt/cisco/anyconnect/bin/. Execute the file vpn.

Use the Client CLI Commands

If you run the CLI in interactive mode, it provides its own prompt. You can also use the command line.

« connect | P address or alias—Client establishes a connection to a specific Secure Firewall ASA
+ disconnect—Client closes a previously established connection

* stats—Displays statistics about an established connection

* quit—Exits the CLI interactive mode

« exit—EXxits the CLI interactive mode
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The following examples show the user establishing and terminating a connection from the command
line:

Windows

connect 209.165.200.224

Establishes a connection to a security appliance with the address 209.165.200.224. After contacting the
requested host, AnyConnect displays the group to which the user belongs and asks for the user's username
and password. If you have specified that an optional banner be displayed, the user must respond to the banner.
The default response is n, which terminates the connection attempt. For example:

VPN > connect 209.165.200.224

>>contacting host (209.165.200.224) for login information...
>>Please enter your username and password.

Group: testgroup

Username: testuser

Password: ****kkxx

>>notice: Please respond to banner.

VPN>
STOP! Please read. Scheduled system maintenance will occur tonight from 1:00-2:00 AM for
one hour.

The system will not be available during that time.

accept? [y/n] y

>> notice: Authentication succeeded. Checking for updates...
>> state: Connecting

>> notice: Establishing connection to 209.165.200.224.

>> State: Connected

>> notice: VPN session established.

VPN>

stats

Displays statistics for the current connection; for example:

VPN > stats
[Tunnel information]

Time Connected: 01:17:33
Client Address: 192.168.23.45
Server Address: 209.165.200.224

[Tunnel Details]

Tunneling Mode: All traffic
Protocol: DTLS

Protocol Cipher: RSA AES 256 SHAL
Protocol Compression: None

[Data Transfer]

Bytes (sent/received): 1950410/23861719
Packets (sent/received): 18346/28851
Bypassed (outbound/inbound): 0/0
Discarded (outbound/inbound): 0/0
[Secure Routes]

Network Subnet

0.0.0.0 0.0.0.0

VPN>

disconnect
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Closes a previously established connection; for example:

VPN > disconnect

>> state: Disconnecting

>> state: Disconnected

>> notice: VPN session ended.
VPN>

quit or exit

Either command exits the CLI interactive mode; for example:

quit

goodbye

>>state: Disconnected

Linux or macOS

/opt/cisco/anyconnect/bin/vpn connect 1.2.3.4

Establishes a connection to the Secure Firewall ASA with the address 1.2.3.4

/opt/cisco/anyconnect/bin/vpn connect some asa alias

Establishes a connection to the Secure Firewall ASA by reading the profile and looking up the alias
some_asa_aliasin order to find its address

/opt/cisco/anyconnect/bin/vpn stats
Displays statistics about the vpn connection
/opt/cisco/anyconnect/bin/vpn disconnect

Disconnect the vpn session if it exists.

Prevent a Windows Popup Message When Secure Firewall ASA Terminates

a Session

If you terminate the AnyConnect session by issuing a session reset from the Secure Firewall ASA, the following
Windows popup message displays to the end user:

The secure gateway has terminated the vpn connection. The following message was received
for the gateway: Administrator Reset

You may not want this message to appear (for example, when the VPN tunnel is initiated using the CLI
command). You can prevent the message from appearing by restarting the client CLI after the client connects.
The following example shows the CLI output when you do this:

C:/Program Files (x86)\Cisco\Cisco AnyConnect Secure Mobility Client>vpncli
Cisco AnyConnect Secure Mobility Client (version 4.x).
Copyright (c) 2016 Cisco Systems, Inc.

All Rights Reserved.

>> state: Connected

>> state: Connected

>> notice: Connected to asa.cisco.com.

>> notice: Connected to asa.cisco.com.

>> registered with local VPN subsystem.

>> state: Connected

>> notice: Connected to asa.cisco.com.

>> state: Disconnecting

>> notice: Disconnect in progress, please wait...

>> state: Disconnected

>> notice: On a trusted network.

>> error: The secure gateway has terminated the VPN connection.
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The following message was received from the secure gateway: Administrator Reset
VPN>

Alternatively, in the Windows registry, you can create a 32-bit double value with the name
SuppressModalDialogs on the endpoint device in the following locations. The client checks for the name but
ignores its value:

* 64-bit Windows:

HKEY LOCAL MACHINE/SOFTWARE\Wow6432Node\Cisco\ Cisco AnyConnect Secure Mobility
Client

* 32-bit Windows:
HKEY LOCAL MACHINE\SOFTWARE\Cisco\Cisco AnyConnect Secure Mobility Client

Prepare AnyConnect Customizations and Localizations for ISE
Deployment

Prepare AnyConnect Localization Bundle

Step 1

Step 2

The AnyConnect Localization Bundle is a zip file containing translation table files and installer transform
files used to localize AnyConnect. This zip file is part of an ISE AnyConnect resource that is used to deploy
AnyConnect from your ISE to your users. The contents of this zip file are defined by the languages you support
in your AnyConnect deployment as described in this procedure.

Before you begin

The ISE requires compiled, binary translation tables in its AnyConnect localization bundle. In gettext there
are two file formats: a text .po format used for editing and a compiled, binary .mo format used at runtime.
Compiling is done with the gettext tool msgfmt. Download the Gettext utilities from
http://www.gnu.org/software/gettext/ and install Gettext on a local computer you use for administration (not
a remote user computer).

Obtain and prepare the translation table files used by your AnyConnect deployment.

a)

b)

c)

From the AnyConnect Secure Mobility Client Software Download page on www.cisco.com, download and open the
AnyConnect-translations- (date) .zip file.

This zip file contains *.po files for all language translations provided by Cisco.

(Optional) Locate any other translation table files (*.po files) that you have customized or created for your own
environment.
Run the gettext message file compiler to create a *.mo file from each *.po file you are using:

msgfmt -o AnyConnect.mo AnyConnect.po

Assemble the translation table files used by your AnyConnect deployment.

a) Create a directory named 110n in a working area on your local computer.

b) Create a directory under 110n for each language you want to include whose name is the language code.

For example fr-ch for French (Canadian).

. Cisco AnyConnect Secure Mobility Client Administrator Guide, Release 4.10



| Customize and Localize AnyConnect and Installer

Step 3

Step 4

Step 5

Prepare AnyConnect Localization Bundle .

¢) Puteach compiled translation table file that you want to include into the appropriately named directory.

Do NOT put any *.po files in the compiled translation table. Only *.mo files should go into this file.

Your directory structure will be similar to the following which includes translation tables for French (Canadian), Hebrew,
and Japanese:

110n\fr-ch\AnyConnect.mo
\he\AnyConnect.mo
\Jja\AnyConnect.mo
(Windows only) Obtain and prepare the language localization transform files used by your AnyConnect deployment.
a) From the AnyConnect Secure Mobility Client Software Download page on www.cisco.com, download and open the
zip file containing the language localization transform files, which apply translations to the installer screens.
The zip file is named anyconnect-win- (version)-webdeploy-k9-lang.zip.

Note The version of the language localization files must match the version of AnyConnect used in your
environment. When upgrading to a new version of AnyConnect, you must also upgrade the language
localization files used in the localization bundle to the same version.

The zip file is named secureclient-win- (version)-webdeploy-k9-lang.zip.

Note The version of the language localization files must match the version of AnyConnect used in your
environment. When upgrading to a new version of AnyConnect, you must also upgrade the language
localization files used in the localization bundle to the same version.

b) Locate any language localization transform files that you have customized or created for your own environment.

(Windows only) Assemble the language localization files used by your AnyConnect deployment.
a) Create a directory named mst in the same working area on your local computer.
b) Create a directory under mst for each language you want to include whose name is the language code.

For example fr—-ch for French (Canadian).

c) Put each language localization file that you want to include into the appropriately named directory.

Your directory structure will now be similar to the following:

110n\fr-ch\AnyConnect.mo
\he\AnyConnect.mo
\ja\AnyConnect.mo

mst\fr-ch\AnyConnect fr-ca.mst
\he\AnyConnect he.mst
\ja\AnyConnect ja.mst

Zip up this directory structure using a standard compression utility into an appropriately named file, such as
AnyConnect-Localization-Bundle- (release) .zip, to create your AnyConnect Localization Bundle.

What to do next

Upload the AnyConnect Localization Bundle onto ISE. This ISE resource is used to deploy AnyConnect to
your users.
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Prepare Your AnyConnect Customization Bundle

The AnyConnect Customization Bundle is a zip file containing custom AnyConnect GUI resources, a custom
help file, VPN scripts, and installer transforms. This zip file is part of an ISE AnyConnect resource that is
used to deploy AnyConnect from your ISE to your users. It has the following directory structure:

win\resource\
\binary
\transform
mac-intel\resource
\binary
\transform

Customized AnyConnect components are included in the resource, binary and transform
sub-directories for Windows and macOS platforms as follows:

* Each resource sub-directory contains all the custom AnyConnect GUI components for that platform.
To create these resources see Create Custom Icons and Logos for the AnyConnect GUI, on page 54.
* Each binary sub-directory contains the custom help file and VPN scripts for that platform.
* To create the AnyConnect help file, see Create and Upload the AnyConnect Help File, on page 60.

* To create VPN scripts, see Write and Deploy Scripts, on page 61.

* Each transform sub-directory contains the installer transforms for that platform.

* To create Windows Customized Installer Transforms, see Modify Installation Behavior, Windows,
on page 40.

¢ To create macOS Installer Transforms, see Customize Installer Behavior on macOS with
ACTransforms.xml, on page 46 .

Before you begin

Create all the necessary custom components before preparing the AnyConnect Customization Bundle.

Step 1 Create the described directory structure in a working area of your local computer.

Step 2 Populate the resources directories with your custom AnyConnect GUI files for each platform. Verify files are all
named appropriately and icons and logos are sized appropriately.

Step 3 Populate the binary directories with your custom help AnyConnect.html file.

Step 4 Populate the binary directories with your VPN OnConnect and OnDisconnect scripts, and any additional scripts
they call.

Step 5 Populate the t rans form directories with your platform specific installer transforms.

Step 6 Zip up this directory structure using a standard compression utility into an appropriately named file, such as

AnyConnect-Customization-Bundle.zip , to create your AnyConnect Customization Bundle.

What to do next

Upload the AnyConnect Customization Bundle onto ISE. This ISE resource is used to deploy AnyConnect
to your users.
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The AnyConnect Profile Editor

* About the Profile Editor, on page 71
* The AnyConnect VPN Profile, on page 72
» The AnyConnect Local Policy, on page 97

About the Profile Editor

The AnyConnect Secure Mobility Client software package contains a profile editor for Windows. ASDM
activates the profile editor when you load the AnyConnect image on the Secure Firewall ASA. You can upload
a client profile from local or flash.

If you load multiple AnyConnect packages, ASDM activates the client profile editor from the newest
AnyConnect package. This approach ensures that the editor displays the features for the newest AnyConnect
loaded, as well as the older clients.

There is also a stand-alone profile editor which runs on Windows.

Add a New Profile from ASDM

Step 1

Step 2
Step 3
Step 4

\)

Note  You must first upload a client image before creating a client profile.

Profiles are deployed to administrator-defined end user requirements and authentication policies on endpoints
as part of AnyConnect, and they make the preconfigured network profiles available to end users. Use the
profile editor to create and configure one or more profiles. AnyConnect includes the profile editor as part of
ASDM and as a stand-alone Windows program.

To add a new client profile to the Secure Firewall ASA from ASDM:

Open ASDM and select Configuration > Remote Access VPN > Network (Client) Access > AnyConnect Client
Profile.

Click Add.
Enter a profile name.

From the Profile Usage drop-down list, choose the module for which you are creating a profile.
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. The AnyConnect VPN Profile

Step 5

Step 6
Step 7
Step 8

(Optional) In the Profile Location field, click Browse Flash and select a device file path for the XML file on the Secure
Firewall ASA.

(Optional) If you created a profile with the stand-alone editor, click Upload to use that profile definition.

(Optional) Choose the AnyConnect group policy from the drop-down list.
Click OK.

The AnyConnect VPN Profile

AnyConnect Secure Mobility Client features are enabled in the AnyConnect profiles. These profiles contain
configuration settings for the core client VPN functionality and for the optional client modules (such as
Network Access Manager, ISE posture, Umbrella, Network Visibility Module, AMP, and customer experience
feedback). The Secure Firewall ASA deploys the profiles during AnyConnect installation and updates. Users
cannot manage or modify profiles.

You can configure the Secure Firewall ASA or ISE to deploy profiles globally for all AnyConnect users or
to users based on their group policy. Usually, a user has a single profile for each AnyConnect module installed.
In some cases, you might want to provide more than one VPN profile for a user: for example, for someone
who works from multiple locations.

Some profile settings are stored locally on the user’s computer in a user preferences file or a global preferences
file. The user file has information the AnyConnect needs to display user-controllable settings in the Preferences
tab of the client GUI and information about the last connection, such as the user, the group, and the host.

We advise against having more than one Secure Client profile with the same <HostAddress>. If you do, the
profile preferences are merged, and the more secure connection setting is chosen for the connection. With the
merging, the endpoint may lose features and functionalities or may be denied a connection.

The global file has information about user-controllable settings so that you can apply those settings before
login (since there is no user). For example, the client needs to know if Start Before Login and/or AutoConnect
On Start are enabled before login.

AnyConnect Profile Editor, Preferences (Part 1)

» Use Start Before L ogin—(Windows Only) Enables Start Before Login for the client's use. With Start
Before Login enabled, AnyConnect starts before the Windows login dialog box appears. The user connects
to the enterprise infrastructure over a VPN connection, before logging on to Windows. After authenticating,
the login dialog box appears, and the user logs in as usual.

+ Show Pre-connect M essage—Enables an administrator to have a one-time message displayed prior to
a users' first connection attempt. For example, the message can remind users to insert their smart card
into its reader. The message appears in the AnyConnect message catalog and is localized.

* Client Certificate Store—Controls which certificate store(s) AnyConnect uses for reading client
certificates. The secure gateway must be configured accordingly and dictates to the client which one of
the multiple certificate authentication combinations is acceptable for a particular VPN connection.

Types of certificates that are acceptable to the secure gateway: either two user certificates or one machine
and one user certificate.
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To allow further filtering of the certificate stores accessible by AnyConnect, you can configure the
certificate store from Windows, macOS, or Linux drop-down. The profile preferences support the values
below:

* Windows

* All—[Default] Uses client certificates from both Windows machine and user certificate stores.
* Machine—Uses client certificates only from Windows certificate store.

» User—Uses client certificates only from Windows certificate store.

* macOS

» All—[Default] Uses client certificates from all available keychains and PEM file stores.

» System—Uses client certificates only from the System Keychain and system PEM file store.

» Login—Uses client certificates only from the user login and dynamic smartcard keychains, as well
as the user PEM file store.

* Linux

» All—[Default] Uses client certificates from both system and user PEM file stores, as well as the
user Firefox NSS store.

* Machine—Uses client certificates only from the system PEM file store.

» User—Uses client certificates only from the user PEM file store, as well as the user Firefox NSS
store.

» Windows Certificate Store Override—Allows an administrator to direct AnyConnect to utilize
certificates in the Windows machine (Local System) certificate store for client certificate authentication.
Certificate Store Override only applies to SSL, where the connection is initiated, by default, by the Ul
process. When using IPSec/IKEv2, this feature in the AnyConnect Profile is not applicable.

)

Note  You must have a predeployed profile with this option enabled in order to connect
with Windows using a machine certificate. If this profile does not exist on a
Windows device prior to connection, the certificate is not accessible in the machine
store, and the connection fails.

* True—AnyConnect searches for certificates in the Windows machine certificate store. Client
Certificate Store (Windows) must set to All or Machine.

» False—[Default] AnyConnect will not search for certificates in the Windows machine certificate
store, when the user does not have administrative privileges.

» AutomaticCertSelection—When multiple certificate authentication is configured on the secure gateway,
you must set this value to true.

+ Auto Connect on Start—AnyConnect, when started, automatically establishes a VPN connection with
the secure gateway specified by the AnyConnect profile, or to the last gateway to which the client
connected.

Cisco AnyConnect Secure Mobility Client Administrator Guide, Release 4.10 .



The AnyConnect Profile Editor |
. AnyConnect Profile Editor, Preferences (Part 1)

» Minimize On Connect—A fter establishing a VPN connection, the AnyConnect GUI minimizes.

 Local LAN Access—Allows the user complete access to the local LAN connected to the remote computer
during the VPN session to the Secure Firewall ASA.

N

Note Enabling local LAN access can potentially create a security weakness from the
public network through the user computer into the corporate network.
Alternatively, you can configure the security appliance (version 8.4(1) or later)
to deploy an SSL client firewall that uses the AnyConnect Local Print firewall
rule included in the default group policy. In order to enable this firewall rule, you
also must enable Automatic VPN Policy, Always on, and Allow VPN Disconnect
in this editor, Preferences (Part 2).

+ Disable Captive Portal Detection—When AnyConnect receives a certificate with a common name that
does not match the Secure Firewall ASA name, a captive portal is detected. This behavior prompts the
user to authenticate. Some users using self signed certificates may want to enable connection to corporate
resources behind an HTTP captive portal and should thus mark the Disable Captive Portal Detection
checkbox. The administrator can also determine if they want the option to be user configurable and mark
the checkbox accordingly. If user configurable is selected, the checkbox appears on the Preferences tab
of the AnyConnect Secure Mobility Client UI.

» Auto Reconnect—AnyConnect attempts to reestablish a VPN connection if you lose connectivity. If
you disable Auto Reconnect, it does not attempt to reconnect, regardless of the cause of the disconnection.

N

Note Use Auto Reconnect in scenarios where the user has control over the behavior
of the client.

» Auto Reconnect Behavior

* DisconnectOnSuspend—AnyConnect releases the resources assigned to the VPN session upon
a system suspend and does not attempt to reconnect after the system resumes.

* ReconnectAfterResume (Default)—AnyConnect attempts to reestablish a VPN connection if
you lose connectivity.

» Suspend AnyConnect During Connected Standby— (Windows Only) Available only for devices that
support Connected Standby. During Connected Standby, the operating system throttles system process,
which can impact how packets are processed. With this option, you can disable VPN traffic when the
system enters Connected Standby mode. The feature is disabled by default.

+ Auto Update—When checked, enables the automatic update of the client. If you check User Controllable,
the user can override this setting in the client.

* RSA SecureID Integration (Windows only)—Controls how the user interacts with RSA. By default,
AnyConnect determines the correct method of RSA interaction (automatic setting: both software or
hardware tokens accepted).

» Windows L ogon Enforcement—Allows a VPN session to be established from a Remote Desktop
Protocol (RDP) session. Split tunneling must be configured in the group policy. AnyConnect disconnects
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AnyConnect Profile Editor, Preferences (Part 1) .

the VPN connection when the user who established the VPN connection logs off. If the connection is
established by a remote user, and that remote user logs off, the VPN connection terminates.

\}

* Single Local Logon (Default)—(Local: 1, Remote: no limit) Allows only one local user to be logged
on during the entire VPN connection. Also, a local user can establish a VPN connection while one
or more remote users are logged on to the client PC. This setting has no effect on remote user logons
from the enterprise network over the VPN connection.

Note

N

If the VPN connection is configured for all-or-nothing tunneling, then the remote
logon is disconnected because of the resulting modifications of the client PC
routing table for the VPN connection. If the VPN connection is configured for
split-tunneling, the remote logon might or might not be disconnected, depending
on the routing configuration for the VPN connection.

* Single Logon—(Local + Remote: 1) Allows only one user to be logged on during the entire VPN
connection. If more than one user is logged on, either locally or remotely, when the VPN connection
is being established, the connection is not allowed. If a second user logs on, either locally or remotely,
during the VPN connection, the VPN connection terminates. No additional logons are allowed
during the VPN connection, so a remote logon over the VPN connection is not possible.

Note

Multiple simultaneous logons are not supported.

* Single Logon No Remote—(Local: 1, Remote: 0) Allows only one local user to be logged on during
the entire VPN connection. No remote users are allowed. If more than one local user or any remote
user is logged on when the VPN connection is being established, the connection is not allowed. If
a second local user or any remote user logs on during the VPN connection, the VPN connection
terminates.

» Windows VPN Establishment—Determines the behavior of AnyConnect when a user who is remotely
logged on to the client PC establishes a VPN connection. The possible values are:

\}

* Local Users Only (Default)—Prevents a remotely logged-on user from establishing a VPN connection.
This is the same functionality as in prior versions of AnyConnect.

¢ Allow Remote Users—Allows remote users to establish a VPN connection. However, if the
configured VPN connection routing causes the remote user to become disconnected, the VPN
connection terminates to allow the remote user to regain access to the client PC. Remote users must
wait 90 seconds after VPN establishment if they want to disconnect their remote login session
without causing the VPN connection to be terminated.

Note

The preference works when Remote Desktop Protocol (RDP) is used to connect
to the endpoint.

« Linux L ogon Enforcement— Allows a VPN session to be established from an SSH session. You must
configure split tunneling in the group policy. AnyConnect disconnects the VPN connection when the
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user who established the VPN connection logs off. If the connection is established by a remote user, and
that remote user logs off, the VPN connection terminates.

\}

* Single Local Logon (Default)—(Local: 1, Remote: no limit) Allows only one local user to be logged
on during the entire VPN connection. Also, a local user can establish a VPN connection while one
or more remote users are logged on to the client PC. This setting has no effect on remote user logons
from the enterprise network over the VPN connection.

Note

N

If the VPN connection is configured for all-or-nothing tunneling, then the remote
logon is disconnected because of the resulting modifications of the client PC
routing table for the VPN connection. If the VPN connection is configured for
split-tunneling, the remote logon might or might not be disconnected, depending
on the routing configuration for the VPN connection.

* Single Logon—(Local + Remote: 1) Allows only one user to be logged on during the entire VPN
connection. If more than one user is logged on, either locally or remotely, when the VPN connection
is being established, the connection is not allowed. If a second user logs on, either locally or remotely,
during the VPN connection, the VPN connection terminates. No additional logons are allowed
during the VPN connection, so a remote logon over the VPN connection is not possible.

Note

Multiple simultaneous logons are not supported.

* Single Logon No Remote—(Local: 1, Remote: 0) Allows only one local user to be logged on during
the entire VPN connection. No remote users are allowed. If more than one local user or any remote
user is logged on when the VPN connection is being established, the connection is not allowed. If
a second local user or any remote user logs on during the VPN connection, the VPN connection
terminates.

* Linux VPN Establishment— Determines the behavior of AnyConnect when a user who is logged on
to the client PC using SSH establishes a VPN connection. The possible values are:

* Local Users Only (Default)}— Prevents a remotely logged-on user from establishing a VPN
connection.

¢ Allow Remote Users— Allows remote users to establish a VPN connection.

 Clear SmartCard PIN — Only certain smart cards support this function. It forces smart card users to
re-enter their PIN during VPN authentication, even if has already been unlocked recently by another user
who was using it without additional PIN prompts.

* | P Protocol Supported—For clients with both an IPv4 and IPv6 address attempting to connect to the
Secure Firewall ASA using AnyConnect, AnyConnect needs to decide which IP protocol to use to initiate
the connection. By default AnyConnect initially attempts to connect using IPv4. If that is not successful,
AnyConnect attempts to initiate the connection using IPv6.

This field configures the initial IP protocol and order of fallback.

* [Pv4—Only IPv4 connections can be made to the Secure Firewall ASA.

* [Pv6—Only IPv6 connections can be made to the Secure Firewall ASA.
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* [Pv4, IPv6—First, attempt to make an IPv4 connection to the Secure Firewall ASA. If the client
cannot connect using IPv4, then try to make an I[Pv6 connection.

* [Pv6, IPv4—First attempt to make an IPv6 connection to the Secure Firewall ASA. If the client
cannot connect using IPv6 then try to make an IPv4 connection.

Note The IP protocol failover can also happen during the VPN session. Whether
performed prior to or during the VPN session, the failover is maintained until the
currently used secure gateway IP address is no longer reachable. The client fails
over to the IP address matching the alternate IP protocol, if available, whenever
the currently used IP address isn't reachable.

AnyConnect Profile Editor, Preferences (Part 2)

« Disable Automatic Certificate Selection (Windows only)—Disables automatic certificate selection by
the client and prompts the user to select the authentication certificate.

* Proxy Settings—Specifies a policy in the AnyConnect profile to control client access to a proxy server.
Use this when a proxy configuration prevents the user from establishing a tunnel from outside the corporate
network.

» Native—Causes the client to use both proxy settings previously configured by AnyConnect, and
the proxy settings configured in the browser. The proxy settings configured in the global user
preferences are pre-pended to the browser proxy settings.

* IgnoreProxy—Ignores the browser proxy settings on the user's computer.

* Override—Manually configures the address of the Public Proxy Server. Public proxy is the only
type of proxy supported for Linux. Windows also supports public proxy. You can configure the
public proxy address to be User Controllable.

« Allow L ocal Proxy Connections—By default, AnyConnect lets Windows users establish a VPN session
through a transparent or non-transparent proxy service on the local PC. Uncheck this parameter if you
want to disable support for local proxy connections. Some examples of elements that provide a transparent
proxy service include acceleration software provided by some wireless data cards, and network components
on some antivirus software.

» Enable Optimal Gateway Selection (OGS), (IPv4 clients only)—AnyConnect identifies and selects
which secure gateway is best for connection or reconnection based on the round trip time (RTT),
minimizing latency for Internet traffic without user intervention. OGS is not a security feature, and it
performs no load balancing between secure gateway clusters or within clusters. You control the activation
and deactivation of OGS and specify whether end users may control the feature themselves. Automatic
Selection displays in the Connect To drop-down list on the Connection tab of the client GUI.

* Suspension Time Threshold (hours)—Enter the minimum time (in hours) that the VPN must have
been suspended before invoking a new gateway-selection calculation. By optimizing this value in
combination with the next configurable parameter (Performance Improvement Threshold), you can
find the correct balance between selecting the optimal gateway and reducing the number of times
to force the re-entering of credentials.

Cisco AnyConnect Secure Mobility Client Administrator Guide, Release 4.10 .



The AnyConnect Profile Editor |
. AnyConnect Profile Editor, Preferences (Part 2)

« Performance | mprovement Threshold (%)—The percentage of performance improvement that
triggers the client to re-connect to another secure gateway following a system resume. Adjust these
values for your particular network to find the correct balance between selecting the optimal gateway
and reducing the number of times to force the re-entering of credentials. The default is 20%.

When OGS is enabled, we recommend that you also make the feature user-controllable.
OGS has the following limitations:

* It cannot operate with Always On

* [t cannot operate with automatic proxy detection

* [t cannot operate with proxy auto-configuration (PAC) files

* If AAA is used, users may have to re-enter their credentials when transitioning to a different secure
gateway. Using certificates eliminates this problem.

» Automatic VPN Policy (Windows and macOS only)—Enables Trusted Network Detection allowing
AnyConnect to automatically manage when to start or stop a VPN connection according to the Trusted
Network Policy and Untrusted Network Policy. If disabled, VPN connections can only be started and
stopped manually. Setting an Automatic VPN Policy does not prevent users from manually controlling
a VPN connection.

* Trusted Network Policy—Action AnyConnect automatically takes on the VPN connection when
the user is inside the corporate network (the trusted network).

* Disconnect (Default)}—Disconnects the VPN connection upon the detection of the trusted
network.

 Connect—Initiates a VPN connection upon the detection of the trusted network.

* Do Nothing—Takes no action in the untrusted network. Setting both the Trusted Network
Policy and Untrusted Network Policy to Do Nothing disables Trusted Network Detection.

» Pause—AnyConnect suspends the VPN session instead of disconnecting it if a user enters a
network configured as trusted after establishing a VPN session outside the trusted network.
When the user goes outside the trusted network again, AnyConnect resumes the session. This
feature is for the user’s convenience because it eliminates the need to establish a new VPN
session after leaving a trusted network.

* Untrusted Network Policy—AnyConnect starts the VPN connection when the user is outside the
corporate network (the untrusted network). This feature encourages greater security awareness by
initiating a VPN connection when the user is outside the trusted network.

* Connect (Default)—Initiates the VPN connection upon the detection of an untrusted network.

* Do Nothing—Takes no action in the trusted network. This option disables Always-On VPN.
Setting both the Trusted Network Policy and Untrusted Network Policy to Do Nothing disables
Trusted Network Detection.

Bypass connect upon VPN session timeout—When a VPN session times out while either
Trusted Network Policy or Untrusted Network Policy are set to connect, a connection retry
begins automatically. If you want to disallow the connection retry, click Bypass connect upon
VPN session timeout.
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\}

AnyConnect Profile Editor, Preferences (Part 2) .

* Trusted DNS Domains—DNS suffixes (a string separated by commas) that a network interface
may have when the client is in the trusted network. For example: *.cisco.com. Wildcards (*) are
supported for DNS suffixes.

Note

If you are using Network Visibility Module, Trusted DNS Domains and Servers
are not supported because the the Network Visibility Module uses an
administrator-defined trusted server and certificate hash to determine whether
the user is on a trusted or untrusted network.

* Trusted DNS Server s—DNS server addresses (IP addresses separated by commas) that a network
interface may have when the client is in the trusted network. For example: 192.168.1.2,2001:DB8::1.
Wildcards (*) are supported for IPv4 or IPv6 DNS server addresses.

* Trusted Servers @ https://<server>[:<port>]—The host URL that you want to add as trusted.
After you click Add, the URL is added, and the certificate hash is pre-filled. If the hash is not found,
an error message prompts the user to enter the certificate hash manually and click Set.

You must have a secure web server that is accessible with a trusted certificate to be considered
trusted. Secure TND attempts a connection to the first configured server in the list. If the server
cannot be contacted or if the hash of the certificate doesn't match, secure TND attempts to contact
the next server in the configured list. If the server can be contacted, and the hash is trusted, the
"trusted" criteria is met.

If a certificate is renewed or changed, the certificate hash does not get updated on the ASDM profile
preference automatically. You must remove the server and re-add it into this field for the hash to
update. Or, if you know the certificate hash or thumbprint numbers, you can update the hash value
in the ASDM profile. Afterwards, you must manually reconfigure the secure TND server in the
VPN profile. To ensure the expected server policy is applied, you must push the new profile to the
endpoint, as the server certificate change is not automatically tracked or written to the VPN profile
by ASDM or the Profile Editor.

Note

You can configure this parameter only when at least one of the Trusted DNS
Domains or Trusted DNS Servers is defined. If Trusted DNS Domains or Trusted
DNS Servers are not defined, this field is disabled.

» Always On—Determines whether AnyConnect automatically connects to the VPN when the user

logs in to a computer running one of the supported Windows or macOS operating systems. You can
enforce corporate policies, protecting the computer from security threats by preventing access to
Internet resources when it is not in a trusted network. You can set the Always-On VPN parameter
in group policies and dynamic access policies to override this setting by specifying exceptions
according to the matching criteria used to assign the policy. If the AnyConnect policy enables
Always-On and a dynamic access policy or group policy disables it, the client retains the disable
setting for the current and future VPN sessions, as long as its criteria match the dynamic access
policy or group policy on the establishment of each new session. After enabling, you will be able
to configure additional parameters.
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\}

Note AlwaysOn is used for scenarios where the connection establishment and
redundancy run without user intervention; therefore, while using this feature, you
need not configure or enable Auto Reconnect in Preferences, part 1.

+ Allow VPN Disconnect—Determines whether AnyConnect displays a Disconnect button for
Always-On VPN sessions. Users of Always-On VPN sessions may want to click Disconnect
so they can choose an alternative secure gateway for reasons such as performance issues with
the current VPN session or reconnection issues following the interruption of a VPN session.

The Disconnect locks all interfaces to prevent data from leaking out and to protect the computer
from internet access except for establishing a VPN session. For the reasons noted above,
disabling the Disconnect button can at times hinder or prevent VPN access.

Allow Accessto the Following Hosts With VPN Disconnected—Allows endpoints to access
the configured hosts while VPN is disconnected during Always On. Values are a
comma-separated list of hosts which can be specified IP addresses, IP address ranges (CIDR
format), or FQDNSs. Access to all subdomains of the configured domains is also allowed. A
maximum of 500 hosts are allowed, and wildcards are not supported.

Caveat: Access to the specified FQDNs depends upon the name resolution performed in an
untrusted network.

Connect Failure Policy—Determines whether the computer can access the Internet if
AnyConnect cannot establish a VPN session (for example, when a Secure Firewall ASA is
unreachable). This parameter applies only if Always-On and Allow VPN Disconnect are
enabled. If you choose Always-On, the fail-open policy permits network connectivity, and the
fail-close policy disables network connectivity.

* Closed—Restricts network access when the VPN is unreachable. The purpose of this
setting is to help protect corporate assets from network threats when resources in the
private network responsible for protecting the endpoint are unavailable.

* Open—Permits network access when the VPN is unreachable.
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Caution A connect failure closed policy prevents network access if AnyConnect fails to
establish a VPN session. It is primarily for exceptionally secure organizations
where security persistence is a greater concern than always-available network
access. It prevents all network access except for local resources such as printers
and tethered devices permitted by split tunneling and limited by ACLs. It can
halt productivity if users require Internet access beyond the VPN if a secure
gateway is unavailable. AnyConnect detects most captive portals. If it cannot
detect a captive portal, a connect failure closed policy prevents all network
connectivity.

If you deploy a closed connection policy, we highly recommend that you follow
a phased approach. For example, first deploy Always-On VPN with a connect
failure open policy and survey users for the frequency with which AnyConnect
does not connect seamlessly. Then deploy a small pilot deployment of a connect
failure closed policy among early-adopter users and solicit their feedback. Expand
the pilot program gradually while continuing to solicit feedback before considering
a full deployment. As you deploy a connect failure closed policy, be sure to
educate the VPN users about the network access limitation as well as the
advantages of a connect failure closed policy.

If Connect Failure Policy is Closed, then you can configure the following settings:

+ Allow Captive Portal Remediation—Lets AnyConnect lift the network access restrictions
imposed by the closed connect failure policy when the client detects a captive portal
(hotspot). Hotels and airports typically use captive portals to require the user to open a
browser and satisfy conditions required to permit Internet access. By default, this parameter
is unchecked to provide the greatest security; however, you must enable it if you want the
client to connect to the VPN if a captive portal is preventing it from doing so.

» Remediation Timeout—Number of minutes AnyConnect lifts the network access
restrictions. This parameter applies if the Allow Captive Portal Remediation parameter
is checked and the client detects a captive portal. Specify enough time to meet typical
captive portal requirements (for example, 5 minutes).

» Apply Last VPN L ocal Resource Rules—If the VPN is unreachable, the client applies
the last client firewall it received from the Secure Firewall ASA, which may include ACLs
allowing access to resources on the local LAN.

» Captive Portal Remediation Browser Failover—Allows the end user to use an external browser (after
closing the AnyConnect browser) for captive portal remediation.

« Allow Manual Host I nput—Enables users to enter different VPN addresses than those listed in the
drop-down box of the AnyConnect UI. If you uncheck this checkbox, the VPN connection choices are
only those in the drop-down box, and users are restricted from entering a new VPN address.

» PPP Exclusion—For a VPN tunnel over a PPP connection, specifies whether and how to determine the
exclusion route. The client can exclude traffic destined for the secure gateway from the tunneled traffic
intended for destinations beyond the secure gateway. The exclusion route appears as a non-secured route
in the Route Details display of the AnyConnect GUI. If you make this feature user controllable, users
can read and change the PPP exclusion settings.

Cisco AnyConnect Secure Mobility Client Administrator Guide, Release 4.10 .



The AnyConnect Profile Editor |
. AnyConnect Profile Editor, Backup Servers

» Automatic—Enables PPP exclusion. AnyConnect automatically determines the IP address of the
PPP server.

* Override—Enables PPP Exclusion using a predefined server IP address specified in the PPP
Exclusion Server IP field. The PPP Exclusion Server IP field is only applicable to this Override
method and should only be used when the Automatic options fails to detect the IP address of the
PPP server.

Checking User Controllable for the PPP Exclusion Server IP field allows the end user to manually
update the IP address via the preferences.xml file.

* Disabled—PPP exclusion is not applied.

 Enable Scripting—Launches OnConnect and OnDisconnect scripts if present on the security appliance
flash memory.

» Terminate Script On Next Event—Terminates a running script process if a transition to another
scriptable event occurs. For example, AnyConnect terminates a running OnConnect script if the
VPN session ends, and terminates a running OnDisconnect script if the client starts a new VPN
session. On Microsoft Windows, the client also terminates any scripts that the OnConnect or
OnDisconnect script launched, and all their script descendents. On macOS and Linux, the client
terminates only the OnConnect or OnDisconnect script; it does not terminate child scripts.

» Enable Post SBL On Connect Script—Launches the OnConnect script if present, and SBL
establishes the VPN session. (Only supported if VPN endpoint is running Microsoft Windows.)

* Retain VPN On L ogoff—Determines whether to keep the VPN session when the user logs off a Windows
or macOS.

* User Enforcement—Specifies whether to end the VPN session if a different user logs on. This
parameter applies only if “Retain VPN On Logoff” is checked, and the original user logged off
Windows or macOS when the VPN session was up.

« Authentication Timeout Values—The number of seconds the client waits for an authentication response
from the headend after successfully sending user credentials for the connection attempt. Enter the number
of seconds in the range of 10 to 120.

)

Note Ifyour clientis structured to receive client certificates from the operating system,
then the value in the profile is not considered.

AnyConnect Profile Editor, Backup Servers

You can configure a list of backup servers the client uses in case the user-selected server fails. If the
user-selected server fails, the client attempts to connect to the optimal server’s backup at the top of the list.
If that fails, the client attempts each remaining server in the Optimal Gateway Selection list, ordered by its
selection results.
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Note Any backup servers that you configure here are only attempted when no backup servers are defined in
AnyConnect Profile Editor, Add/Edit a Server List, on page 89. Those servers configured in the Server List
take precedence, and backup servers listed here are overwritten.

Host Address—Specifies an IP address or a Fully-Qualified Domain Name (FQDN) to include in the backup
server list.

» Add—Adds the host address to the backup server list.

» Move Up—Moves the selected backup server higher in the list. If the user-selected server fails, the client
attempts to connect to the backup server at the top of the list first, and moves down the list, if necessary.

* Move Down—Moves the selected backup server down in the list.

» Delete—Removes the backup server from the server list.

AnyConnect Profile Editor, Certificate Matching

Enable the definition of various attributes that can be used to refine automatic client certificate selection on
this pane.

If no certificate matching criteria is specified, AnyConnect applies the following certificate matching rules:
» Key Usage: Digital Signature
» Extended Key Usage: Client Auth

If any criteria matching specifications are made in the profile, neither of these matching rules are applied
unless they are specifically listed in the profile.

» Key Usage—Use the following Certificate Key attributes for choosing acceptable client certificates:
* Decipher Only—Deciphering data, and that no other bit (except Key Agreement) is set.
* Encipher Only—Enciphering data, and any other bit (except Key Agreement) is not set.
* CRL_Sign—Verifying the CA signature on a CRL.
* Key Cert_Sign—Verifying the CA signature on a certificate.
* Key Agreement—Key agreement.
» Data_Encipherment—Encrypting data other than Key Encipherment.
* Key Encipherment—Encrypting keys.

* Non_Repudiation—Verifying digital signatures protecting against falsely denying some action,
other than Key Cert sign or CRL_Sign.

* Digital Signature—Verifying digital signatures other than Non Repudiation, Key Cert Sign or
CRL Sign.

» Extended Key Usage—Use these Extended Key Usage settings. The OIDs are included in parenthesis:
* ServerAuth (1.3.6.1.5.5.7.3.1)
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* ClientAuth (1.3.6.1.5.5.7.3.2)

* CodeSign (1.3.6.1.5.5.7.3.3)

* EmailProtect (1.3.6.1.5.5.7.3.4)

* [PSecEndSystem (1.3.6.1.5.5.7.3.5)
* [PSecTunnel (1.3.6.1.5.5.7.3.6)

» [PSecUser (1.3.6.1.5.5.7.3.7)

» TimeStamp (1.3.6.1.5.5.7.3.8)

* OCSPSign (1.3.6.1.5.5.7.3.9)

* DVCS (1.3.6.1.5.5.7.3.10)

« IKE Intermediate

» Custom Extended Match Key (Max 10)—Specifies custom extended match keys, if any (maximum
10). A certificate must match all of the specified key(s) you enter. Enter the key in the OID format (for
example, 1.3.6.1.5.5.7.3.11).

N

Note If a Custom Extended Match Key is created with the OID size greater than 30
characters, it is unaccepted when you click the OK button. The limit for the
maximum characters for an OID is 30.

» Match only certificates with Extended key usage—Previous behavior was that if a certificate
distinguished name (DN) match rule is set, the client would match certificates with the specific EKU
OID and all certificates with no EKU. To keep consistency but provide more clarity, you can disallow
the match to certificates with no EKU. The default is to keep the legacy behavior that customers have
come to expect. You must click the check box to enable the new behavior and disallow the match.

« Distinguished Name (Max 10):—Specifies distinguished names (DNs) for exact match criteria in
choosing acceptable client certificates.

» Name—The distinguished name (DN) to use for matching:

* CN—Subject Common Name

* C—Subject Country

* DC—Domain Component

* DNQ—Subject Dn Qualifier

* EA—Subject Email Address

* GENQ—Subject Gen Qualifier
* GN—Subject Given Name

* [—Subject Initials

* L—Subject City
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* N—Subject Unstruct Name

* O—Subject Company

* OU—Subject Department

* SN—Subject Sur Name

* SP—Subject State

* ST—Subject State

* T—Subject Title

* ISSUER-CN—Issuer Common Name

* ISSUER-DC—Issuer Component

* ISSUER-SN—Issuer Sur Name

* ISSUER-GN—Issuer Given Name

* ISSUER-N—Issuer Unstruct Name

* ISSUER-I—Issuer Initials

* ISSUER-GENQ—Issuer Gen Qualifier

* ISSUER-DNQ—Issuer Dn Qualifier

* ISSUER-C—Issuer Country

* ISSUER-L—Issuer City

» ISSUER-SP—Issuer State

* ISSUER-ST—Issuer State

* ISSUER-O—Issuer Company

* ISSUER-OU—Issuer Department

* ISSUER-T—Issuer Title

* ISSUER-EA—Issuer Email Address
* Pattern—Specifies the string to match. The pattern to be matched should include only the portion

of the string you want to match. There is no need to include pattern match or regular expression
syntax. If entered, this syntax will be considered part of the string to search for.

For example, if a sample string was abc.cisco.com and the intent is to match cisco.com, the pattern
entered should be cisco.com.

» Operator—The operator to use when performing matches for this DN.
* Equal—equivalent to ==

* Not Equal—equivalent to !=

* Wildcar d—Enabled includes wildcard pattern matching. With wildcard enabled, the pattern can
be anywhere in the string.
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» Match Case—Check to enable case-sensitive pattern matching.

Related Topics
Configure Certificate Matching, on page 155

AnyConnect Profile Editor, Certificate Enroliment

Certificate Enrollment enables AnyConnect to use the Simple Certificate Enrollment Protocol (SCEP) to
provision and renew a certificate for client authentication.

* Certificate Expiration Threshold—The number of days before the certificate expiration date that
AnyConnect warns users their certificate is going to expire (not supported by RADIUS
password-management). The default is zero (no warning displayed). The range of values is zero to 180
days.

* Client Certificate Import Store—Select to which certificate store to save enrollment certificates.

* Windows

* All—[Default] Import enrollment certificates to both Windows machine and user certificate stores.
* Machine—Import enrollment certificates only to Windows machine certificate stores.

» User—Import enrollment certificates only to Windows user certificate stores.

* Linux

* All—[Default] Import enrollment certificates to both user PEM file and user Firefox NSS certificate
stores.

* UserFirefoxNSS—Import enrollment certificates only to user Firefox NSS certificate store.

» UserPEMFile—Import enrollment certificates only to user PEM file certificate store.

* macOS
* Enrollment certificates can only be imported to the user Login Keychain.
» Mobile platforms

* Enrollment certificates can only be imported to the app sandbox.

« Certificate Contents—Specifies certificate contents to include in the SCEP enrollment request:

* Name (CN)—Common Name in the certificate.

* Department (OU)—Department name specified in certificate.
* Company (O)—Company name specified in certificate.

« State (ST)—State identifier named in certificate.

« State (SP)—Another state identifier.

* Country (C)—Country identifier named in certificate.
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* Email (EA)—Email address. In the following example, Email (EA) is %USER%@cisco.com.
%USER% corresponds to the user’s ASA username login credential.

* Domain (DC)—Domain component. In the following example, Domain (DC) is set to cisco.com.
* SurName (SN)—The family name or last name.

» GivenName (GN)—Generally, the first name.

* UnstructName (N)—Undefined name.

* Initials (I)—The initials of the user.

* Qualifier (GEN)—The generation qualifier of the user. For example, “Jr.” or “IIL.”

* Qualifier (DN)—A qualifier for the entire DN.

* City (L)—The city identifier.

» Title (T)—The person's title. For example, Ms., Mrs., Mr.

* CA Domain—Used for the SCEP enrollment and is generally the CA domain.

* Key size—The size of the RSA keys generated for the certificate to be enrolled.

* Display Get Certificate Button—Enables the AnyConnect GUI to display the Get Certificate button
under the following conditions:

* The certificate is set to expire within the period defined by the Certificate Expiration Threshold (not
supported with RADIUS).

* The certificate has expired.
* No certificate is present.

« The certificate fails to match.

Related Topics
Configure Certificate Enrollment, on page 147

AnyConnect Profile Editor, Certificate Pin

Prerequisites

Use the VPN profile editor to enable the preference and configure global and per host certificate pins. You
can only pin per host certificates in the server list section if the preference in the Global Pins section is enabled.
After enabling the preference, you can configure a list of global pins that the client uses for certificate pin
verification. Adding per host pins in the server list section is similar to adding global pins. You can pin any
certificates in the certificate chain, and they get imported to the profile editor to calculate the information
required for pinning.

Add Pin—Initiates the Certificate Pinning Wizard which guides you through importing certificates into the
Profile Editor and pinning them.

The certificate details portion of the window allows you to visually verify the Subject and Issuer columns.
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Certificate Pinning Wizard

You can import any certificate of the server certificate chain into the profile editor to specify the information
required for pinning. The profile editor supports three certificate import options:

*» Browse local file—Choose the certificate that is locally present on your computer.
* Download file from a URL—Download the certificate from any file hosting server.

* Paste information in PEM format—Insert information in PEM format including certificate begin and end
headers.

\)

Note  You can only import certificates in DER, PEM, and PKCS7 data format.

AnyConnect Profile Editor, Mobile Policy

AnyConnect version 3.0 and later does not support Windows Mobile devices. See Cisco AnyConnect Secure
Mobility Client Administrator Guide, Release 2.5, for information related to Windows Mobile devices.

AnyConnect Profile Editor, Server List

You can configure a list of servers that appear in the client GUI. Users can select servers in the list to establish
a VPN connection.

Server List Table Columns:
» Hostname—The alias used to refer to the host, IP address, or Full-Qualified Domain Name (FQDN).
* Host Address—IP address or FQDN of the server.
* User Group—Used in conjunction with Host Address to form a group-based URL.

» Automatic SCEP Host—The Simple Certificate Enrollment Protocol specified for provisioning and
renewing a certificate used for client authentication.

* CA URL—The URL this server uses to connect to certificate authority (CA).

* Certificate Pins—Per host pins used by the client during pin verification. Refer to AnyConnect Profile
Editor, Certificate Pin, on page 87.

\}

Note Clients use global and the corresponding per host pins during pin verification.
Per host pins are configured in a similar way that global pins are configured using
the Certificate Pinning Wizard.

Add/Edit—Launches the Server List Entry dialog where you can specify the above server parameters.
Delete—Removes the server from the server list.

Details—Displays more details about backup servers or CA URLSs for the server.
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Related Topics
Configure VPN Connection Servers, on page 105

AnyConnect Profile Editor, Add/Edit a Server List

* Host Display Name—Enter an alias used to refer to the host, IP address, or Full-Qualified Domain Name
(FQDN).

* FQDN or IP Address— Specify an IP address or an FQDN for the server.

* If you specify an IP address or FQDN in the Host Address Field, then the entry in the Host Name
field becomes a label for the server in the connection drop-down list of the AnyConnect tray fly-out.

* If you only specify an FQDN in the Hostname field, and no IP address in the Host Address field,
then the FQDN in the Hostname field will be resolved by a DNS server.

* If you enter an IP address, use the Public IPv4 or the Global IPv6 address of the secure gateway.
Use of the link-local secure gateway address is not supported.

» User Group—Specify a user group.

The user group is used in conjunction with Host Address to form a group-based URL. If you specify the
Primary Protocol as IPsec, the User Group must be the exact name of the connection profile (tunnel
group). For SSL, the user group is the group-url of the connection profile.

\}

Note In IKEv2/IPsec connections, when the Primary Server is not reachable, User
Group information entered for the Primary Server carries forward to Backup
Servers. To have the same behavior for SSL, you must also supply user group
information to the Backup Servers as a URL (for example,
https://example.com/usergroup) and not just FQDN.

+ Additional mobile-only settings—Select to configure Apple iOS and Android mobile devices.
» Backup Server List

We recommend that you configure a list of backup servers the client uses in case the user-selected server
fails. If the server fails, the client attempts to connect to the server at the top of the list first, and moves
down the list, if necessary.

\)

Note Conversely, the backup servers configured in AnyConnect Profile Editor, Backup
Servers, on page 82 are global entries for all connection entries. Any entries put
in Backup Servers of the Profile Editor are overwritten with what is entered here
in Backup Server List for an individual server list entry. This setting takes
precedence and is the recommended practice.

* Host Address—Specifies an IP address or an FQDN to include in the backup server list. If the
client cannot connect to the host, it attempts to connect to the backup server.

» Add—Adds the host address to the backup server list.
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* Move Up—Moves the selected backup server higher in the list. If the user-selected server fails, the
client attempts to connect to the backup server at the top of the list first, and moves down the list,
if necessary.

* Move Down—Moves the selected backup server down in the list.

» Delete—Removes the backup server from the server list.

+ Load Balancing Server List

If the host for this server list entry is a load balancing cluster of security appliances, and the Always-On
feature is enabled, specify the backup devices of the cluster in this list. If you do not, Always-On blocks
access to backup devices in the load balancing cluster.

» Host Address—Specifies an IP address or an FQDN of a backup device in a load-balancing cluster.
» Add—Adds the address to the load balancing backup server list.

» Delete—Removes the load balancing backup server from the list.

* Primary Protocol—Specifies the protocol for connecting to this server, either SSL or IPsec with IKEv2.
The default is SSL.

« Standard Authentication Only (10S Gateways)—When you select IPsec as the protocol, you are
able to select this option to limit the authentication methods for connections to IOS servers.

\}

Note If this server is a Secure Firewall ASA, then changing the authentication method
from the proprietary AnyConnect EAP to a standards-based method disables the
ability of the Secure Firewall ASA to configure session timeout, idle timeout,
disconnected timeout, split tunneling, split DNS, MSIE proxy configuration, and
other features.

» Auth Method During IKE Negotiation Select one of the standard-based authentication methods.

* IKE Identity—If you choose a standards-based EAP authentication method, you can enter a
group or domain as the client identity in this field. The client sends the string as the ID GROUP
type IDi payload. By default, the string is *$AnyConnectClient$*.

* CA URL—Specify the URL of the SCEP CA server. Enter an FQDN or IP Address. For example,
http://ca01.cisco.com.

» Certificate Pins—Per host pins used by the client during pin verification. See AnyConnect Profile Editor,
Certificate Pin, on page 87.

» Prompt For Challenge PW—Enable to let the user make certificate requests manually. When the user
clicks Get Certificate, the client prompts the user for a username and one-time password.

» CA Thumbprint—The certificate thumbprint of the CA. Use SHA1 or MD5 hashes.
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Note  Your CA server administrator can provide the CA URL and thumbprint. The
thumprint should be retrieved directly from the server and not from a “fingerprint”
or “thumbprint” attribute field in a certificate it issued.

Related Topics
Configure VPN Connection Servers, on page 105

AnyConnect Profile Editor, Mobile Settings

Apple i0S / Android Settings

» Certificate Authentication—The Certificate Authentication policy attribute associated with a connection
entry specifies how certificates are handled for this connection. Valid values are:

» Automatic—AnyConnect automatically chooses the client certificate with which to authenticate
when making a connection. In this case, AnyConnect views all the installed certificates, disregards
those certificates that are out of date, applies the certificate matching criteria defined in VPN client
profile, and then authenticates using the certificate that matches the criteria. This happens every
time the device user attempts to establish a VPN connection.

» Manual—AnyConnect searches for a certificate from the AnyConnect certificate store on the
Android device when the profile is downloaded and does one of the following:

« If AnyConnect finds a certificate based on the certificate matching criteria defined in the VPN
client profile, it assigns that certificate to the connection entry and uses that certificate when
establishing a connection.

« If a matching certificate cannot be found, the Certificate Authentication policy is set to
Automatic.

« If the assigned certificate is removed from the AnyConnect certificate store for any reason,
AnyConnect resets the Certificate Authentication policy to Automatic.

» Disabled—A client certificate is not used for authentication.

» MakethisServer List Entry activewhen profileisimported—Defines a server list entry as the default
connection once the VPN profile has been downloaded to the device. Only one server list entry can have
this designation. The default value is disabled.

Apple i0S Only Setting

+ Connect on Demand (requires certificate authorization)—This field allows you to configure the
Connect on Demand functionality provided by Apple iOS. You can create lists of rules that are checked

whenever other applications start network connections that are resolved using the Domain Name System
(DNS).

Connect on Demand is an option only if the Certificate Authentication field is set to Manual or Automatic.
If the Certificate Authentication field is set to Disabled, this checkbox is dimmed. The Connect on
Demand rules, defined by the Match Domain or Host and the On Demand Action fields, can still be
configured and saved when the checkbox is dimmed.
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» Match Domain or Host—Enter the hostnames (host.example.com), domain names (.example.com), or
partial domains (.internal.example.com) for which you want to create a Connect on Demand rule. Do
not enter IP addresses (10.125.84.1) in this field.

» On Demand Action—Specify one of the following actions when a device user attempts to connect to
the domain or host defined in the previous step:

* Never connect—iOS will never start a VPN connection when rules in this list are matched. Rules
in this list take precedence over all other lists.

N

Note When Connect On Demand is enabled, the application automatically adds the
server address to this list. This prevents a VPN connection from being
automatically established if you try accessing the server’s clientless portal with
a web browser. Remove this rule if you do not want this behavior.

* Connect if Needed—iOS will start a VPN connection when rules in this list are matched only if
the system could not resolve the address using DNS.

+ Always Connect—Always connect behaviour is release dependent:
* On Apple i0S 6, i0S will always start a VPN connection when rules in this list are matched.

* OniOS 7.x, Always Connect is not supported. When rules in this list are matched, they behave
as Connect If Needed rules.

* On later releases, Always Connect is not used. Configured rules are moved to the Connect If
Needed list and behave as such.

» Add or Delete—Add the rule specified in the Match Domain or Host and On-Demand Action fields to
the rules table, or delete a selected rule from the rules table.

Network Visibility Module Profile Editor

In the profile editor, configure the IP address or FQDN of the collection server. You can also customize the
data collection policy choosing what type of data to send, and whether data is anonymized or not.

Network Visibility Module can establish connection with a single stack IPv4 with an IPv4 address, a single
stack IPv6 with an [Pv6 address, or a dual stack IPv4/IPv6 to the IP address as preferred by the OS.

The mobile Network Visibility Module can establish a connection using IPv4 only. IPv6 connectivity is not
supported.
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Note

The Network Visibility Module sends flow information only when it is on the trusted network. By default,
no data is collected. Data is collected only when configured as such in the profile, and the data continues to
be collected when the endpoint is connected. If collection is done on an untrusted network, it is cached and
sent when the endpoint is on a trusted network. If you are sending collection data to Stealthwatch 7.3.1 and
prior releases (or something other than Splunk or similar SIEM tool), cache data is sent once on a trusted
network but not processed. For Stealthwatch applications, refer to the Stealthwatch Enterprise Endpoint
License and NVM Configuration Guide.

If TND is configured in the Network Visibility Module profile, then the trusted network detection is done by
Network Visibility Module and does not depend on VPN to determine if the endpoint is in a trusted network.
Also, if VPN is in a connected state, then the endpoint is considered to be on the trusted network, and the
flow information is sent. The NVM-specific system logs show Trusted Network Detection use.

When configuring TND directly in the Network Visibility Module profile, an administrator-defined trusted
server and certificate hash determine whether the user is on a trusted or untrusted network. Administrators

configuring Trusted Network Detection for the core VPN profile would alternatively configure the Trusted
DNS Domains and Trusted DNS Servers in the core VPN profile: AnyConnect Profile Editor, Preferences

(Part 2), on page 77.

* Desktop or M obile—Determines whether you are setting up Network Visibility Module on a desktop
or mobile device. Desktop is the default.

* Collector Configuration

* | P AddresssFQDN—Specifies the IPv4 or IPv6 IP address/FQDN of the collector.
» Port—Specifies at which port number the Collector is listening.

» Secure—Determines if you want Network Visibility Module to securely send data to the collector
over DTLS. When this checkbox is checked, Network Visibility Module uses DTLS for transport.
The DTLS connection requires that the DTLS server (collector) certificate is trusted by the endpoint.
Any untrusted certificates are silently rejected.

The collector as part of the CESA Splunk App v3.1.0 is required for DTLS support, and DTLS 1.2
is the minimum supported version.
+ Cache Configuration

* Max Size—Specify the maximum size the database can reach. The cache size previously had a
pre-set limit, but you can now configure it within the profile. The data in the cache is stored in an
encrypted format, and only processes with root privileges are able to decrypt the data.

Once a size limit is reached, the oldest data is dropped from the space for the most recent data.

» Max Duration—Specify how many days of data you want to store. If you also set a max size, the
limit which reaches first takes precedence.

Once the day limit is reached, the oldest day's data is dropped from the space for the most recent
day. If only Max Duration is configured, there is no size cap; if both are disabled, the size is capped
at SOMB.

* Periodic Template—Specify the period interval at which templates are sent out from the endpoint. The
default value is 1440 minutes.
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« Periodic Flow Reporting (Optional, applies to desktop only)—Click to enable periodic flow reporting.
By default, Network Visibility Module sends information about the flow at the end of connection (when
this option is disabled). If you need periodic information on the flows even before they are closed, set
an interval in seconds here. The value of 0 means the flow information is sent at the beginning and at
the end of each flow. If the value is n, the flow information will be sent at the beginning, every n seconds,
and at the end of each flow. Use this setting for tracking long-running connections, even before they are
closed.

» Aggregation I nterval—Specify at which interval the data flows should be exported from the endpoint.
When the default value of 5 seconds is used, more than one data flow is captured in a single packet. If
the interval value is 0 seconds, each packet has a single data flow. The valid range is 0 to 600 seconds.

* Throttle Rate—Throttling controls at what rate to send data from the cache to the collector so that the
end user is minimally impacted. You can apply throttling on both real time and cached data, as long as
there is cached data. Enter the throttle rate in Kbps. The default is 500 Kbps.

The cached data is exported after this fixed period of time. Enter 0 to disable this feature.
* Collection M ode—Specify when data from the endpoint should be collected by choosing: collection
mode is off, trusted network only, untrusted network only, or all networks.

» Collection Criteria— You can reduce unnecessary broadcasts during data collection so that you have
only relevant data to analyze. Control collection of data with the following options:

* Broadcast packetsand M ulticast packets(Applies to desktop only)—By default, and for efficiency,
broadcast and multicast packet collection are turned off so that less time is spent on backend
resources. Click the checkbox to enable collection for broadcast and multicast packets and to filter
the data.

* KNOX only (Optional and mobile specificy—When checked, data is collected from the KNOX
workspace only. By default, this field is not checked, and data from inside and outside the workspace
is collected.

« Data Collection Policy—You can add data collection policies and associate them with a network type
or connectivity scenario. You can apply one policy to VPN and another to non-VPN traffic since multiple
interfaces can be active at the same time.

When you click Add, the Data Collection Policy window appears. Keep these guidelines in mind when
creating policies:

* By default, all fields are reported and collected if no policy is created or associated with a network
type.

* Each data collection policy must be associated with at least one network type, but you cannot have
two policies for the same network type.

* The policy with the more specific network type takes precedence. For example, since VPN is part
of the trusted network, a policy containing VPN as a network type takes precedence over a policy
which has trusted as the network specified.

* You can only create a data collection policy for the network that applies based on the collection
mode chosen. For example, if the Collection Mode is set to Trusted Network Only, you cannot
create a Data Collection Policy for an Untrusted Network Type.

« If a profile from an earlier AnyConnect release is opened in a later AnyConnect release profile
editor, it automatically converts the profile to the newer release. Conversion adds a data collection
policy for all networks that exclude the same fields as were anonymized previously.
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» Name—Specify a name for the policy you are creating.

» Network Type—Determine the collection mode, or the network to which a data collection policy
applies, by choosing VPN, trusted, or untrusted. If you choose trusted, the policy applies to the VPN
case as well.

* Flow Filter Rule—Defines a set of conditions and an action that can be taken to either Collect or
Ignore the flow when all conditions are satisfied. You can configure up to 25 rules, and each rule
can define up to 25 conditions. Use the up and down buttons to the right of the Flow Filter Rules
list to adjust the priority of rules and give them higher consideration over subsequent rules. Click
Add to set up the component of a flow filter rule.

* Name—The unique name of the flow filter rule.

» Type—Edach filter rule has a Collect or Ignore type. Determine the action (Collect or Ignore)
to apply if the filter rule is satisfied. If collect, the flow is allowed when conditions are met. If

ignore, the flow is dropped.

* Conditions—Add an entry for each field that is to be matched and an operation to decide if the
field value should be equal or unequal for a match. Each operation has a field identifier and a
corresponding value for that field. The field matches are case sensitive unless you apply
case-insensitive operations (EqualsIgnoreCase) to the rule set when you are setting up the filter
engine rules. After it has been enabled, the input in the Value field set under the rule is case

insensitive.

* Include/Exclude
» Type—Determine which fields you want to I nclude or Exclude in the data collection policy.
The default is Exclude. All fields not checked are collected. When no fields are checked, all
fields are collected.
* Fields—Determine what information to receive from the endpoint and which fields will be

part of your data collection to meet policy requirements. Based on the network type and what
fields are included or excluded, Network Visibility Module collects the appropriate data on

the endpoint.
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\}

Note During an upgrade, the ProcessPath, ParentProcessPath, ProcessArgs, and
ParentProcessArgs are excluded by default from being reported in the flow
information, if one of these scenarios exist:

* If the profile in the older version of Network Visibility Module had no Data
Collection Policy or had an include Data Collection Policy.

» If the profile in the older version of Network Visibility Module had an
exclude Data Collection Policy, and the profile was opened and saved with
a newer version profile editor. If the profile in the older version of Network
Visibility Module had an exclude Data Collection Policy but the profile was
not opened and saved with the newer 4.9 (or later) version profile editor,
then these four fields are included.

If Network Visibility Module is unable to compute the parent process id, the
value defaults to 4294967295.

FlowStartMsec and FlowStopMsec determine the Epoch timestamp of the flow
in milliseconds.

You can choose Interface State and SSID, which specifies whether the network state of the
interface is trusted or untrusted.

* Optional Anonymization Fields—If you want to correlate records from the same endpoint
while still preserving privacy, choose the desired fields as anonymized. They are then sent as
the hash of the value rather than actual values. A subset of the fields is available for
anonymization.

Fields marked for include or exclude are not available for anonymization; likewise, fields
marked for anonymization are not available for include or exclude.

« Data Collection Palicy for Knox (M obile Specific)—Option to specify data collection policy when
mobile profile is selected. To create Data Collection Policy for Knox Container, choose the Knox-Only
checkbox under Scope. Data Collection policies applied under Device Scope apply for Knox Container
traffic also, unless a separate Knox Container Data Collection policy is specified. To add or remove Data
Collection Policies, see the Data Collection Policy description above. You can set a maximum of 6
different Data Collection Policies for mobile profile: 3 for Device, and 3 for Knox.

» Export on Mobile Network (Optional and M obile Specific)—Specifies whether the exporting of
Network Visibility Module flows is allowed when a device is using a mobile network. If enabled (the
default value), an end user can override an administrator when an Acceptable User Policy window is
displayed or later by enabling the Settings > NV M -Settings > > Use mobile data for NVM checkbox
in the AnyConnect Android application. If you uncheck the Export on Mobile Network checkbox,
Network Visibility Module flows are not exported when the device is using a mobile network, and an
end user cannot change that.

» Trusted Networ k Detection—This feature detects if an endpoint is physically on the corporate network.
The network state is used by the Network Visibility Module to determine when to export data and to
apply the appropriate Data Collection Policy. Click Configure to set the configuration for Trusted
Network Detection. An SSL probe is sent to the configured trusted headend, which responds with a
certificate, if reachable. The thumbprint (SHA-256 hash) is then extracted and matched against the hash
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set in the profile editor. A successful match signifies that the endpoint is in a trusted network; however,
if the headend is unreachable, or if the certificate hash does not match, then the endpoint is considered
to be in an untrusted network.

\}

Note When operating from outside your internal network, Trusted Network Detection
makes DNS requests and attempts to establish an SSL connection to the configured
server. Cisco strongly recommends the use of an alias to ensure that the name
and internal structure of your organization are not revealed through these requests
by a machine being used outside your internal network.

1. https://—Enter the URL (IP address, FQDN, or port address) of each trusted server and click Add.

Note Trusted servers behind proxies are not supported.

2. Certificate Hash (SHA-256)—If the SSL connection to the trusted server is successful, this field is
populated automatically. Otherwise, you can set it manually by entering the SHA-256 hash of the
server certificate and clicking Set.

3. List of Trusted Servers—You can define multiple trusted servers with this process. (The maximum
is 10.) Because the servers are attempted for trusted network detection in the order in which they are
configured, you can use the Move Up and M ove [Down buttons to adjust the order. If the endpoint
fails to connect to the first server, it tries the second server and so on. After trying all of the servers
in the list, the endpoint waits for ten seconds before making another final attempt. When a server
authenticates, the endpoint is considered within a trusted network.

Save the profile as NVM_ServiceProfile.xml. You must save the profile with this exact name or
Network Visibility Module fails to collect and send data.

The AnyConnect Local Policy

AnyConnectLocalPolicy.xml is an XML file that is installed automatically on the client with the AnyConnect
VPN installer and contains some default security values. This file is not deployed by the Secure Firewall ASA.
If you make changes to an existing local policy file on a user’s system, you must reboot for the changes to
take effect.

Local Policy Preferences

You can specify the following preferences in the VPN Local Policy Editor to be included in the
AnyConnectLocalPolicy.xml file.

* FIPSMode

Enables FIPS mode for the client. This setting forces the client to only use algorithms and protocols
approved by the FIPS standard.

* Bypass Downloader
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When selected, disables the launch of the VPNDownloader.exe module, which is responsible for detecting
the presence of and updating the local versions of dynamic content. The client does not check for dynamic
content present on the Secure Firewall ASA, including translations, customizations, optional modules,
and core software updates.

When Bypass Downloader is selected, one of two things happens upon client connection to the Secure
Firewall ASA:

« If the VPN client profile on the Secure Firewall ASA is different than the one on the client, the
client aborts the connection attempt.

* [f there is no VPN client profile on the Secure Firewall ASA, the client makes the VPN connection,
but it uses its hard-coded VPN client profile settings.

Note If you configure VPN client profiles on the Secure Firewall ASA, they must be

installed on the client before the client connects to the Secure Firewall ASA with
BypassDownloader set to true. Because the profile can contain an administrator
defined policy, the BypassDownloader true setting is only recommended if you
do not rely on the Secure Firewall ASA to centrally manage client profiles.

» Enable CRL Check

This feature is only implemented for Windows desktop. For both SSL and IPsec VPN connections, you
have the option to perform Certificate Revocation List (CRL) checking. When this setting is enabled,
AnyConnect retrieves the updated CRL for all certificates in the chain. AnyConnect then verifies whether
the certificate in question is among those revoked certificates which should no longer be trusted; and if
found to be a certificate revoked by the Certificate Authority (CA), it does not connect.

CRL checking is disabled by default. AnyConnect performs CRL checks only when Enable CRL Check
is checked (or enabled), and as a result, the end user may observe the following:

« If the certificate is revoked through CRL, the connection to the secure gateway fails unconditionally,
even if Strict Certificate Trust is disabled in the AnyConnect Local Policy file.

* [fthe CRL cannot be retrieved (such as due to an unreachable CRL distribution point), the connection
to the secure gateway fails unconditionally, if Strict Certificate Trust is enabled in the AnyConnect
Local Policy file. Otherwise, if Strict Certificate Trust is disabled, the user may be prompted to
bypass the error.

N

Note AnyConnect cannot perform a CRL check when Always On is enabled. Also, if

CRL distribution points are not publicly reachable, AnyConnect may encounter
service disruption.

» Enable OCSP Check

Thisfeatureisimplemented only for Linux. It allows the client to query the status of individual certificates
in realtime by making a request to the OSCP responder and parsing the OSCP response to get the certificate
status. OCSP is used to verify the entire certificate chain and only works with PEM File Certificate Store
(by setting Exclude Firefox NSS Cert Store to True). There is a five second timeout interval per certificate
to access the OCSP responder.
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OCSP checking is disabled by default. When enabled, the end user may observe the following:

« Ifthe certificate is revoked through OCSP, the connection to the gateway fails unconditionally, even
if Strict Certificate Trust is disabled in the AnyConnect Local Policy file.

* [fthe OCSP responder cannot be reached, the connection to the secure gateway fails unconditionally,
if Strict Certificate Trust is enabled in the AnyConnect Local Policy file. Otherwise, if Strict
Certificate Trust is disabled, the user may be prompted to bypass the error.

Note AnyConnect cannot perform an OCSP check when Always On is enabled. Also,
if the OCSP responder is not publicly reachable, AnyConnect may encounter a
service disruption.

» Restrict Web Launch

Prevents users from using a non-FIPS-compliant browser to initiate WebLaunch. It does this by preventing
the client from obtaining the security cookie that is used to initiate the AnyConnect tunnel. The client
displays an informative message to the user.

« Strict Certificate Trust

If selected, when authenticating remote security gateways, AnyConnect disallows any certificate that it
cannot verify. Instead of prompting the user to accept these certificates, the client fails to connect to
security gateways using self-signed certificates and displays Local policy prohibits the acceptance
of untrusted server certificates. A connection will not be established..If not selected,
the client prompts the user to accept the certificate. This is the default behavior.

We strongly recommend that you enable Strict Certificate Trust for the AnyConnect for the following
reasons:

 With the increase in targeted exploits, enabling Strict Certificate Trust in the local policy helps
prevent “man in the middle” attacks when users are connecting from untrusted networks such as
public-access networks.

* Even if you use fully verifiable and trusted certificates, the AnyConnect, by default, allows end
users to accept unverifiable certificates. If your end users are subjected to a man-in-the-middle
attack, they may be prompted to accept a malicious certificate. To remove this decision from your
end users, enable Strict Certificate Trust.

* Restrict Server Cert Store (Windows, macOS, and Linux)

Prevents the client from using the user-based certificate store to verify server certificates. Only
system-based certificate store will be used. Enabling this also enables <StrictCertificateTrust> and sets
it to true.

* Restrict Preference Caching

By design, AnyConnect does not cache sensitive information to disk. Enabling this parameter extends
this policy to any type of user information stored in the AnyConnect preferences.

« Credentials—The user name and second user name are not cached.
» Thumbprints—The client and server certificate thumbprints are not cached.

* CredentialsAndThumbprints—Certificate thumbprints and user names are not cached.
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» All—No automatic preferences are cached.

* false—All preferences are written to disk (default).

Restrict Web-deploy Updates—You can define the level of restriction for updates. In coordination with
the Update Policy parameter below, you could restrict downloader distribution to only trusted Secure
Firewall ASA sources by creating a list of trusted Secure Firewall ASAs and electing to download policies,
help files, translations, and scripts from those trusted Secure Firewall ASAs. With the following settings,
you can bypass certain downloader functions, while preserving VPN profile updates and software update
capabilities. Or disable web deployment of scripts, localization files, help files, or UI customization from
Secure Firewall ASAs, without impacting other functions of the AnyConnect downloader. If set for
bypass, any necessary updates must be done with out-of-band software update mechanisms.

* Restrict Script Web-deploy Updates—Prevents administrators from customizing on-connect script
updates from the server.

* Restrict Resour ce Web-deploy Updates—Prevents administrators from customizing user interface
element updates from the server.

* Restrict Help Web-deploy Updates—Prevents administrators from customizing help file updates
from the server.

* Redtrict L ocalization Web-deploy Updates—Prevents administrators from customizing localization
updates from the server.
Exclude Pem File Cert Store (Linux and macOS)

Prevents the client from using the PEM file certificate store to verify server certificates and search for
client certificates.

The store uses FIPS-capable OpenSSL and has information about where to obtain certificates for client
certificate authentication. Permitting the PEM file certificate store ensures remote users are using a
FIPS-compliant certificate store.

Exclude Firefox NSS Cert Store (Linux)

Prevents the client from using the Firefox NSS certificate store to verify server certificates and search
for client certificates.

The store has information about where to obtain certificates for client certificate authentication.
Update Policy

Controls which headends the client can get software or profile updates from. By default, allowing updates
from any server is set to TRUE. To restrict downloader distribution to only trusted Secure Firewall ASA
sources, add the server names in the Server Name field and uncheck those server updates that you do
not want to allow. While Allow Software Updates used to encompass scripts, help files, resources, and
localizations, we have changed it to four separate setting.

« Allow Software Updates From Any Server

« Allow Compliance M odule Updates From Any Server

* Allow VPN Profile Updates From Any Server

» Allow Management VPN Profile Updates From Any Server
« Allow | SE Posture Profile Updates From Any Server
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« Allow Service Profile Updates From Any Server
* Allow Script Updates From Any Server

* Allow Help Updates From Any Server

* Allow Resour ce Updates From Any Server

« Allow L ocalization Updates From Any Server

« Server Name

Specify authorized servers in this list. These headends are allowed full updates of all AnyConnect
software and profiles upon VPN connectivity. ServerName can be an FQDN, IP address, domain
name, or wildcard with domain name.

Related Topics: Set the Update Policy

* Trusted | SE Certificate Finger prints (SHA256)—Allows you to establish ISE trust before fetching
the posture policy. You can specify SHA256 fingerprints of the ISE certificates, an intermediate CA
certificate, or the root CA certificate in the ISE certification chain. SHA256 fingerprints are case insensitive
and can be added with or without colons. This setting is mandatory for Script Remediation.

Enable Local Policy Parameters in an MST File

See Local Policy Preferences for the descriptions and values that you can set.

Create an MST file to change local policy parameters. The MST parameter names correspond to the parameters
in the AnyConnect Local Policy file (AnyConnectLocalPolicy.xml):

« LOCAL_POLICY BYPASS DOWNLOADER
« LOCAL_POLICY FIPS MODE

« LOCAL_POLICY RESTRICT PREFERENCE CACHING
« LOCAL_POLICY RESTRICT TUNNEL_PROTOCOLS

« LOCAL_POLICY RESTRICT WEB_LAUNCH

« LOCAL POLICY STRICT CERTIFICATE TRUST

\}

Note AnyConnect installation does not automatically overwrite an existing local policy file on the user computer.
You must delete the existing policy file on user computers first, so the client installer can create a new policy
file.

)

Note Any changes to the local policy file require the system to be rebooted.
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* Connect and Disconnect to a VPN, on page 103

* Configure Start Before Login (PLAP) on Windows Systems, on page 109
* Use Trusted Network Detection to Connect and Disconnect, on page 110
* Require VPN Connections Using Always-On, on page 112

* Use Captive Portal Hotspot Detection and Remediation, on page 119

* Configure AnyConnect over L2TP or PPTP, on page 122

» Use Management VPN Tunnel, on page 123

* Configure AnyConnect Proxy Connections, on page 129

* Select and Exclude VPN Traffic, on page 133

* Manage VPN Authentication, on page 142

Connect and Disconnect to a VPN

AnyConnect VPN Connectivity Options

AnyConnect provides many options for automatically connecting, reconnecting, or disconnecting VPN sessions.
These options provide a convenient way for your users to connect to your VPN, and they also support your
network security requirements.

Starting and Restarting AnyConnect Connections

Configure VPN Connection Servers to provide the names and addresses of the secure gateways your users
will manually connect to.

Choose from the following AnyConnect capabilities to provide convenient, automatic VPN connectivity:
» Automatically Start Windows VPN Connections Before Logon
» Automatically Start VPN Connections When AnyConnect Starts

* Automatically Restart VPN Connections

Also, consider using the following Automatic VPN Policy options to enforce greater network security or
restrict network access to the VPN only:

» About Trusted Network Detection
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* Require VPN Connections Using Always-On

* Use Captive Portal Hotspot Detection and Remediation

Renegotiating and Maintaining the AnyConnect Connection

You can limit how long the Secure Firewall ASA keeps an AnyConnect VPN connection available to the user
even with no activity. If a VPN session goes idle, you can terminate the connection or re-negotiate the
connection.

* Keepalive—The Secure Firewall ASA sends keepalive messages at regular intervals. These messages
are ignored by the Secure Firewall ASA, but are useful in maintaining connections with devices between
the client and the Secure Firewall ASA.

For instructions to configure Keepalive with the ASDM or CLI, see the Enable Keepalive section in the
Cisco ASA Series VPN Configuration Guide.

* Dead Peer Detection—The Secure Firewall ASA and AnyConnect send "R-U-There" messages. These
messages are sent less frequently than IPsec's keepalive messages. You can enable both the Secure
Firewall ASA (gateway) and AnyConnect to send DPD messages, and configure a timeout interval.

« If the client does not respond to the Secure Firewall ASA’s DPD messages, the ASA tries once
more before putting the session into "Waiting to Resume" mode. This mode allows the user to roam
networks, or enter sleep mode and later recover the connection. If the user does not reconnect before
the idle timeout occurs, the Secure Firewall ASA will terminate the tunnel. The recommended
gateway DPD interval is 300 seconds.

* If the Secure Firewall ASA does not respond to the client's DPD messages, the client tries again
before terminating the tunnel. The recommended client DPD interval is 30 seconds.

For instructions to configure DPD within the ASDM, refer to Configure Dead Peer Detection in
the appropriate release of the Cisco ASA Series VPN ASDM Configuration Guide.

* Best Practices:

* Set Client DPD to 30 seconds (Group Policy > Advanced > AnyConnect Client > Dead Peer
Detection).

* Set Server DPD to 300 seconds (Group Policy > Advanced > AnyConnect Client > Dead Peer
Detection).

* Set Rekey, for both SSL and IPsec to 1 hour (Group Policy > Advanced > AnyConnect Client >
Key Regeneration).

Terminating an AnyConnect VPN Connection

Terminating an AnyConnect VPN connection requires users to re-authenticate their endpoint to the secure
gateway and create a new VPN connection.

The following connection parameters terminate the VPN session based on timeouts:

* Maximum Connect Time—Sets the maximum user connection time in minutes. At the end of this time,
the system terminates the connection. You can also allow unlimited connection time(default).

» VPN Idle Timeout—Terminates any user’s session when the session is inactive for the specified time.
If the VPN idle timeout is not configured, then the default idle timeout is used.
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* Default Idle Timeout—Terminates any user’s session when the session is inactive for the specified time.
The default value is 30 minutes (or 1800 seconds).

See the Specify a VPN Session Idle Timeout for a Group Policy section in the appropriate release of the Cisco
ASA Series VPN ASDM Configuration Guide to set these parameters.

Configure VPN Connection Servers

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

The AnyConnect VPN server list consists of host name and host address pairs identifying the secure gateways
that your VPN users will connect to. The host name can be an alias, an FQDN, or an IP address.

The hosts added to the server list display in the Connect to drop-down list in the AnyConnect GUI. The user
can then select from the drop-down list to initiate a VPN connection. The host at the top of the list is the
default server, and appears first in the GUI drop-down list. If the user selects an alternate server from the list,
the selected server becomes the new default server.

Once you add a server to the server list, you can view its details and edit or delete the server entry. To add a
server to the server list, follow this procedure.

Open the VPN Profile Editor and choose Server List from the navigation pane.
Click Add.
Configure the server’s host name and address:

a) Enter a Host Display Name, an alias used to refer to the host, an FQDN, or an IP address. Do not use "&" or "<"
characters in the name. If you enter an FQDN or an IP address, you do not need to enter the FQDN or | P Address
in the next step.

If you enter an IP address, use the Public IPv4 or the Global IPv6 address of the secure gateway. Use of the link-local
secure gateway address is not supported.

b) (Optional) Enter the host’s FQDN or | P Addressif not entered in the Host Display Name.
¢) (Optional) Specify a User Group.

AnyConnect uses the FQDN or IP Address in conjunction with User Group to form the Group URL.
Enter the server to fall back to as the backup server in the Backup Server List. Do not use "&" or "<" characters in the
name.

Note Conversely, the Backup Server tab on the Server menu is a global entry for all connection entries. Any entries
put in that Backup Server location are overwritten with what is entered here for an individual server list
entry. This setting takes precedence and is the recommended practice.

(Optional) Add load balancing servers to the L oad Balancing Server List. Do not use "&" or "<" characters in the name.

If the host for this server list entry specifies a load balancing cluster of security appliances, and the Always-On feature
is enabled, add the load balancing devices in the cluster to this list. If you do not, Always-On blocks access to the devices
in the load balancing cluster.

Specify the Primary Protocol for the client to use for this Secure Firewall ASA:
a) Choose SSL (default) or IPsec.

If you specify IPsec, the User Group must be the exact name of the connection profile (tunnel group). For SSL, the
user group is the group-url or group-alias of the connection profile.
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b) Ifyou specify IPsec, select Standard Authentication Only to disable the default authentication method (proprietary
AnyConnect EAP), and choose a method from the drop-down list.

Note Changing the authentication method from the proprietary AnyConnect EAP to a standards-based method
disables the ability of the Secure Firewall ASA to configure session timeout, idle timeout, disconnected
timeout, split tunneling, split DNS, MSIE proxy configuration, and other features.

Step 7 (Optional) Configure SCEP for this server:
a) Specify the URL of the SCEP CA server. Enter an FQDN or IP Address. For example, http://ca0l.cisco.com.

b) Check Prompt For Challenge PW to enable the user to make certificate requests manually. When the user clicks
Get Certificate, the client prompts the user for a username and one-time password.

c) Enter the certificate thumbprint of the CA. Use SHA1 or MDS5 hashes. Your CA server administrator can provide
the CA URL and thumbprint and should retrieve the thumbprint directly from the server and not from a “fingerprint”
or “thumbprint” attribute field in a certificate it issued.

Step 8 Click OK.

Related Topics
AnyConnect Profile Editor, Server List, on page 88
AnyConnect Profile Editor, Add/Edit a Server List, on page 89

Automatically Start Windows VPN Connections Before Logon

About Start Before Login

This feature called Start Before Login (SBL) allows users to establish their VPN connection to the enterprise
infrastructure before logging onto Windows.

)

Note When using Start Before Login (SBL) and HostScan, you must install the VPN Posture predeploy module on
the endpoints to achieve full HostScan functionality, since SBL is pre-login.

After SBL is installed and enabled, the Network Connection button launches AnyConnect core VPN and
Network Access Manager UL

SBL also includes the Network Access Manager tile and allows connections using user configured home
network profiles. Network profiles allowed in SBL mode include all media types employing non-802.1X
authentication modes, such as open WEP, WPA/WPA?2 Personal, and static key (WEP) networks.

SBL is available on Windows systems only, and is implemented using different mechanisms depending on
the version of Windows:

* On Windows, the Pre-Login Access Provider (PLAP) is used to implement AnyConnect SBL.

With PLAP, the Ctrl+Alt+Del key combination opens a window where the user can choose either to log
in to the system or activate Network Connections (PLAP components) using the Network Connect button
in the lower-right corner of the window.

PLAP supports 32-bit and 64-bit versions of the Windows.

Reasons you might consider enabling SBL for your users include:
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* The user’s computer is joined to an Active Directory infrastructure.

* A user has network-mapped drives that require authentication with the Microsoft Active Directory
infrastructure.

* The user cannot have cached credentials on the computer (the group policy disallows cached credentials).
In this scenario, users must be able to communicate with a domain controller on the corporate network
for their credentials to be validated before gaining access to the computer.

* The user must run logon scripts that execute from a network resource or need access to a network resource.
With SBL enabled, the user has access to the local infrastructure and logon scripts that would normally
run when a user is in the office. This includes domain logon scripts, group policy objects and other Active
Directory functionality that normally occurs when users log on to their system.

* Networking components (such as MS NAP/CS NAC) exist that might require connection to the
infrastructure.

Limitations on Start Before Login
» AnyConnect is not compatible with fast user switching.

» AnyConnect cannot be started by third-party Start Before Login applications.

Configure Start Before Login

Step 1 Install the AnyConnect Start Before Login Module.
Step 2 Enable SBL in the AnyConnect VPN Profile.

Install the AnyConnect Start Before Login Module

The AnyConnect installer detects the underlying operating system and places the appropriate AnyConnect
DLL from the AnyConnect SBL module in the system directory. On Windows devices, the installer determines
whether the 32-bit or 64-bit version of the operating system is in use and installs the appropriate PLAP
component, vpnplap.dll or vpnplap64.dll.

\}

Note If you uninstall AnyConnect while leaving the SBL module installed, the SBL module is disabled and not
visible to the remote user.

You can predeploy the SBL module or configure the ASA to download it. When predeploying AnyConnect,
the Start Before Login module requires that the core client software is installed first. If predeploying
AnyConnect VPN and Start Before Login components using MSI files, the order must be correct.

Step 1 In ASDM go to Configuration > Remote Access VPN > Network (Client) Access > Group Policies.
Step 2 Select a group policy and click Edit or Add a new group policy.

Step 3 Select Advanced > AnyConnect Client in the left navigation pane.

Step 4 Uncheck I nherit for the Optional Client Module for Download setting.
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. Enable SBL in the AnyConnect VPN Profile

Step 5

Select the AnyConnect SBL module in the drop-down list.

Enable SBL in the AnyConnect VPN Profile

Step 1
Step 2
Step 3

Before you begin

* SBL requires a network connection to be present at the time it is invoked. In some cases, this might not
be possible, because a wireless connection might depend on credentials of the user to connect to the
wireless infrastructure. Since SBL mode precedes the credential phase of a logon, a connection would
not be available in this scenario. In this case, the wireless connection needs to be configured to cache
the credentials across logon, or another wireless authentication needs to be configured, for SBL to work.

» If the Network Access Manager is installed, you must deploy device connection to ensure that an
appropriate connection is available.

Open the VPN Profile Editor and choose Preferences (Part 1) from the navigation pane.
Select Use Start Before L ogin.
(Optional) To give the remote user control over SBL, select User Controllable.

Note The user must reboot the remote computer before SBL takes effect.

Troubleshoot Start Before Login

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

Ensure that the AnyConnect VPN profile is loaded on the Secure Firewall ASA, ready to be deployed.
Delete prior profiles. The profile locations are provided in Locations to Predeploy the AnyConnect Profiles.
Using Windows Add/Remove Programs, reinstall the SBL Components. Reboot the computer and retest.
Clear the user’s AnyConnect log in the Event Viewer and retest.

Browse back to the security appliance to install AnyConnect again.

Reboot once. On the next reboot, you should be prompted with the Start Before Login prompt.

Collect a DART bundle and send it to your AnyConnect administrator.

If you see the following error, delete the user’s AnyConnect VPN profile:

Description: Unable to parse the profile C:\Documents and Settings\All Users\Application Data
\Cisco\Cisco AnyConnect Secure Mobility Client\Profile\VABaseProfile.xml. Host data not available.

Go back to the .tmpl file, save a copy as an.xml file, and use that XML file as the default profile.

Automatically Start VPN Connections When AnyConnect Starts

This feature called Auto Connect On Start, automatically establishes a VPN connection with the secure gateway
specified by the VPN client profile when AnyConnect starts.
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Step 1

Step 2

Step 3

Configure Start Before Login (PLAP) on Windows Systems .

Auto Connect On Start is disabled by default, requiring the user to specify or select a secure gateway.

Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.
Select Auto Connect On Start.
(Optional) To give the user control over Auto Connect on Start, select User Controllable.

Configure Start Before Login (PLAP) on Windows Systems

The Start Before Login (SBL) feature starts a VPN connection before the user logs in to Windows. This
ensures that users connect to their corporate infrastructure before logging on to their computers. Windows
only supports one PLAP being installed at the a time.

The SBL AnyConnect feature is known as the Pre-Login Access Provider (PLAP), which is a connectable
credential provider. This feature lets programmatic network administrators perform specific tasks, such as
collecting credentials or connecting to network resources before logon. PLAP provides SBL functions on all
of the supported Windows operating systems. PLAP supports 32-bit and 64-bit versions of the operating
system with vpnplap.dll and vpnplap64.dll, respectively. The PLAP functions supports x86 and x64.

Automatically Restart VPN Connections

Step 1
Step 2
Step 3

When Auto Reconnect is enabled (default), AnyConnect recovers from VPN session disruptions and
reestablishes a session, regardless of the media used for the initial connection. For example, it can reestablish
a session on wired, wireless, or 3G/4G/5G. When Auto Reconnect is enabled, you also specify the reconnect
behavior upon system suspend or system resume. A system suspend is a low-power standby, such as Windows
“hibernation” or macOS or Linux “sleep.” A system resume is a recovery following a system suspend.

If you disable Auto Reconnect, the client does not attempt to reconnect regardless of the cause of the
disconnection. Cisco highly recommends using the default setting (enabled) for this feature. Disabling this
setting can cause interruptions in VPN connectivity over unstable connections.

Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.
Select Auto Reconnect.
Choose the Auto Reconnect Behavior:

* Disconnect On Suspend—(Default) AnyConnect releases the resources assigned to the VPN session upon a system
suspend and does not attempt to reconnect after the system resume.

* Reconnect After Resume—The client retains resources assigned to the VPN session during a system suspend and
attempts to reconnect after the system resume.
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Use Trusted Network Detection to Connect and Disconnect

About Trusted Network Detection

Trusted Network Detection (TND) gives you the ability to have AnyConnect automatically disconnect a VPN
connection when the user is inside the corporate network (the trusted network) and start the VPN connection
when the user is outside the corporate network (the untrusted network).

TND does not interfere with the ability of the user to manually establish a VPN connection. It does not
disconnect a VPN connection that the user starts manually in the trusted network. TND only disconnects the
VPN session if the user first connects in an untrusted network and moves into a trusted network. For example,
TND disconnects the VPN session if the user makes a VPN connection at home and then moves into the
corporate office.

\)

Note To configure the TND feature for the Network Visibility Module, see the Network Visibility Module Profile
Editor, on page 92 in the Network Visibility Module chapter.

You configure TND in the AnyConnectVPN profile. No changes are required to the Secure Firewall ASA
configuration. You need to specify the action or policy AnyConnect takes when recognizing it is transitioning
between trusted and untrusted networks, and identify your trusted networks and servers.

)

Note Whenever the TND policy evaluation occurs with the VPN tunnel connected and the policy specifies
name-based trusted servers, that name resolution is performed over the VPN tunnel using the DNS servers
pushed by the VPN headend.

Guidelines for Trusted Network Detection

* Because the TND feature controls the AnyConnect GUI and automatically starts connections, the GUI
should run at all times. If the user exits the GUI, TND does not automatically start the VPN connection.

* If AnyConnect VPN is also running Start Before Login (SBL), and the user moves into the trusted
network, the SBL window displayed on the computer automatically closes.

* Trusted Network Detection with or without Always-On configured is supported on IPv6 and IPv4 VPN
connections to the Secure Firewall ASA over IPv4 and IPv6 networks.

» TND policies take into effect only on a pre-existing VPN tunnel state. TND will not be triggered when
a network or interface change occurs during an ongoing AnyConnect connection/reconnection attempt
(for example, in a dual-home scenario where an interface change occurs while AnyConnect is already
attempting a connection/reconnection). If there are multiple interfaces (one trusted and other untrusted),
it depends upon the operating system as to which interface is chosen for the network activity for
AnyConnect.

* Multiple profiles on a user computer may present problems if the TND configuration is different. In a
dual-home scenario, you should have at least one interface which satisfies all the TND conditions to
deem the endpoint as trusted.
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Configure Trusted Network Detection .

If the user has received a TND-enabled profile in the past, upon system restart, AnyConnect attempts to
connect to the security appliance it was last connected to, which may not be the behavior you desire. To
connect to a different security appliance, they must manually disconnect and re-connect to that headend.
The following workarounds will help you prevent this problem:

* Enable TND in the client profiles loaded on all the Secure Firewall ASAs on your corporate network.

* Create one profile listing all the Secure Firewall ASAs in the host entry section, and load that profile
on all your Secure Firewall ASAs.

* If users do not need to have multiple, different profiles, use the same profile name for the profiles
on all the Secure Firewall ASAs. Each Secure Firewall ASA overrides the existing profile.

* To use TND on Linux, you must have the Network Manager installed and running properly on the target
(RHEL/Ubuntu) device, and the network manager must be maintaining the network interfaces.

Configure Trusted Network Detection

Step 1
Step 2
Step 3

Step 4

Step 5

Open the VPN profile editor and choose Preferences (Part 2) from the navigation pane.
Select Automatic VPN Palicy.
Choose a Trusted Network Policy.

This is the action the client takes when the user is inside the corporate network (the trusted network). The options are:
* Disconnect—(Default) The client terminates the VPN connection in the trusted network.
* Connect—The client starts a VPN connection in the trusted network.

* Do Nothing—The client takes no action in the trusted network. Setting both the Trusted Network Policy and Untrusted
Network Policy to Do Nothing disables Trusted Network Detection (TND).

» Pause—AnyConnect suspends its AnyConnect VPN session (instead of disconnecting it) if a user enters a network
configured as trusted after establishing a VPN session outside the trusted network. When the user goes outside the
trusted network again, AnyConnect VPN resumes the session. This feature is for the user’s convenience because it
eliminates the need to establish a new VPN session after leaving a trusted network.

Choose an Untrusted Network Policy.
This is the action the client takes when the user is outside the corporate network. The options are:

* Connect—The client starts a VPN connection upon the detection of an untrusted network.

* Do Nothing—The client takes no action upon detection of an untrusted network. This option disablesAlways-On
VPN. Setting both the Trusted Network Policy and Untrusted Network Policy to Do Nothing disables Trusted
Network Detection.

Specify Trusted DNS Domains.

Specify the DNS suffixes (a string separated by commas) that a network interface may have when the client is in the
trusted network. You can assign multiple DNS suffixes if you add them to the split-dns list and specify a default domain
on the Secure Firewall ASA.

AnyConnect builds the DNS suffix list in the following order:
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* The domain passed by the head end.
* The split-DNS suffix list passed by the head end.

* The public interface’s DNS suffixes, if configured. If not, the primary and connection-specific suffixes, along with
the parent suffixes of the primary DNS suffix (if the corresponding box is checked in the Advanced TCP/IP Settings).

To Match This DNS Suffix: Use This Value for TrustedDNSDomains:

example.com (only) *example.com

example.com AND vpn.example.com * example.com OR example.com, vpn.example.com

asa.example.com AND vpn.example.com * example.com OR asa.example.com,
vpn.example.com

Step 6 Specify Trusted DNS Servers.

All DNS server addresses (a string separated by commas) that a network interface may have when the client is in the
trusted network. For example: 203.0.113.1,2001:DB8::1. Wildcards (*) are supported for IPv4 and IPv6 DNS server
addresses.

You must have a DNS entry for the headend server that is resolvable via DNS. If your connections are by IP address,
you need a DNS server that can resolve mus.cisco.com. If mus.cisco.com is not resolvable via DNS, captive portal
detection will not work as expected.

Note You can configure either TrustedDNSDomains, TrustedDNSServers, or both. If you configure
TrustedDNSServers, be sure to enter all your DNS servers, so your site(s) will all be part of the Trusted
Network.

An active interface will be considered as an In-Trusted-Network if it matches all the rules in the VPN profile.

Step 7 Specify a host URL that you want to add as trusted. You must have a secure web server that is accessible with a trusted
certificate to be considered trusted. After you click Add, the URL is added and the certificate hash is pre-filled. If the
hash is not found, an error message prompts the user to enter the certificate hash manually and click Set.

Note You can configure this parameter only when at least one of the Trusted DNS Domains or Trusted DNS
Servers is defined. If Trusted DNS Domains or Trusted DNS Servers are not defined, this field is disabled.

Require VPN Connections Using Always-0n

About Always-On VPN

Always-On operation prevents access to Internet resources when the computer is not on a trusted network,
unless a VPN session is active. Enforcing the VPN to always be on in this situation protects the computer
from security threats.

When Always-On is enabled, it establishes a VPN session automatically after the user logs in and upon
detection of an untrusted network. The VPN session remains open until the user logs out of the computer, or
the session timer or idle session timer (specified in the Secure Firewall ASA group policy) expires. AnyConnect
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continually attempts to reestablish the connection to reactivate the session if it is still open; otherwise, it
continually attempts to establish a new VPN session.

When Always-On is enabled in the VPN Profile, AnyConnect protects the endpoint by deleting all the other
downloaded AnyConnect profiles and ignores any public proxies configured to connect to the Secure Firewall
ASA.

The following AnyConnect options also need to be considered when enabling Always-On:

* Allowing the user to disconnect the Always-On VPN session: AnyConnect provides the ability for the
user to disconnect Always-On VPN sessions. If you enable Allow VPN Disconnect, AnyConnect displays
a Disconnect button upon the establishment of a VPN session. By default, the profile editor enables the
Disconnect button when you enableAlways-On VPN.

Pressing the disconnect button locks all interfaces to prevent data from leaking out and to protect the
computer from internet access except for establishing a VPN session. Users of Always-On VPN sessions
may want to click Disconnect so they can choose an alternative secure gateway due to performance issues
with the current VPN session, or reconnection issues following the interruption of a VPN session.

Setting a connect failure policy: The connect failure policy determines whether the computer can access
the internet if Always-On VPN is enabled, and AnyConnect cannot establish a VPN session. See Set a
Connect Failure Policy for Always-On.

Handling captive portal hotspots: See Use Captive Portal Hotspot Detection and Remediation.

Allowing access to certain hosts while VPN is disconnected: An optional configuration available with
Allow accessto thefollowing hostswith VPN disconnected (which may be required for certain HostScan
deployments) that allows endpoints to access the configured hosts while AnyConnect VPN is disconnected
during Always On. Values are a comma-separated list of hosts which can be specified IP addresses, IP
address ranges (CIDR format), or FQDNs. A maximum of 500 hosts are allowed.

To configure this parameter for the use of SAML authentication, refer to Use Always-On VPN With
External SAML Identity Provider, on page 115.

Limitations of Always-On VPN

* Always On is available only on Windows and macOS

* If Always-On is enabled, but the user does not log on, AnyConnect VPN does not establish the VPN
connection. AnyConnect VPN starts the VPN connection only post-login.

* Always-On VPN does not support connecting though a proxy.

Guidelines for Always-On VPN

To enhance protection against threats, we recommend the following additional protective measures if you
configure Always-On VPN:

» We strongly recommend purchasing a digital certificate from a certificate authority (CA) and enrolling
it on the secure gateways. The ASDM provides an Enroll ASA SSL VPN with Entrust button on the
Configuration > Remote Access VPN > Certificate Management > | dentity Certificates panel to
facilitate enrollment of a public certificate.
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Configure Always-On VPN

* Predeploy a profile configured with Always-On to the endpoints to limit connectivity to the pre-defined
Secure Firewall ASAs. Predeployment prevents contact with a rogue server.

* Restrict administrator rights so that users cannot terminate processes. A PC user with admin rights can
bypass an Always-On policy by stopping the agent. If you want to ensure fully-secure Always-On, you
must deny local admin rights to users.

* Restrict access to the Cisco sub-folders on Windows computers, typically C: \ProgramData.

+ Users with limited or standard privileges may sometimes have write access to their program data folders.
They could use this access to delete the AnyConnect profile and thereby circumvent the Always-On
feature.

* Predeploy a group policy object (GPO) for Windows users to prevent users with limited rights from
terminating the GUI. Predeploy equivalent measures for macOS users.

Configure Always-On VPN

Step 1
Step 2
Step 3

Configure Always-On in the VPN Profile, on page 114.
(Optional) Add Load-Balancing Backup Cluster Members to the Server List.
(Optional) Exempt Users from Always-On VPN.

Configure Always-0n in the VPN Profile

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7
Step 8

Before you begin

Always-On VPN requires that a valid, trusted server certificate be configured on the Secure Firewall ASA;
otherwise, it fails and logs an event indicating the certificate is invalid. In addition, ensuring that the server
certificate can pass Strict Certificate Trust mode prevents the download of an Always-On VPN profile that
locks a VPN connection to a rogue server.

Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.
Select Automatic VPN Palicy.

Configure Trusted Network Detection, on page 111.

Select Always On.

(Optional) Select or un-select Allow VPN Disconnect.

(Optional) Define the hosts that endpoints can access while VPN is disconnected during Always On. If SAML authentication
is used, refer to Use Always-On VPN With External SAML Identity Provider, on page 115.

(Optional) Configure a Connect Failure Policy.
(Optional) Configure Captive Portal Remediation.
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Use Always-0On VPN With External SAML Identity Provider .

Use Always-0On VPN With External SAML Identity Provider

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

To support SAML authentication with Always On enabled, follow these steps, which impact the Allow Access
to the Following Hosts With VPN Disconnected parameter configuration.

Disable the Always On parameter in the AnyConnect Profile Editor, Preferences (Part 2), on page 77.

After the resulting profile is deployed, perform SAML authentication while capturing all DNS flows, as well as all TCP
flows generated by the browser (either embedded or the default), used by AnyConnect during SAML authentication.
Windows

* Use the Microsoft tool ProcMon to capture the browser TCP flows.

* Before starting the ProcMon trace, if the AnyConnect browser is used, add process name filter acwebhelper.exe. If
the default browser is used, add the process name filter matching the default browser's executable.

* Capture DNS traffic and TCP flow traffic with Wireshark using display filter udp.port==53 || (tcp.flags.syn ==
& & tep.flags.ack ==0).

macOS

* Use the native tool tcpmon to capture relevant network traffic with process name metadata: sudo tcpdump -n -k
NP > /tmp/capture.txt

» For packets originating from the AnyConnect embedded browser, the process name field shows up as (proc com
.appleWebKit:PID1, eproc Cisco AnyConnect: PID2).

Identify all TCP connections originating from the browser that are used by AnyConnect for SAML authentication, as
well as the DNS response packets preceding such TCP connections and containing the TCP connection's destination IP
address.

Extract FQDNs from the query name field of the previously identified DNS response packets and add them to the Always
On Allow Accessto the Following Hosts With VPN Disconnected parameter in the AnyConnect Profile Editor,
Preferences (Part 2).

Also, to the same Always On preference parameter, add all IP addresses corresponding to browser connections that aren't
preceded by corresponding DNS traffic (such as, connections by IP address).

Re-enable the Always On profile preference.

Add Load-Balancing Backup Cluster Members to the Server List

Step 1

Always-On VPN affects the load balancing of AnyConnect VPN sessions. With Always-On VPN disabled,
when the client connects to a primary device within a load balancing cluster, the client complies with a
redirection from the primary device to any of the backup cluster members. With Always-On enabled, the
client does not comply with a redirection from the primary device unless the address of the backup cluster
member is specified in the server list of the client profile. Therefore, be sure to add any backup cluster members
to the server list.

To specify the addresses of backup cluster members in the client profile, use ASDM to add a load-balancing
backup server list by following these steps:

Open the VPN Profile Editor and choose Server List from the navigation pane.
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Step 2 Choose a server that is a primary device of a load-balancing cluster and click Edit.

Step 3 Enter an FQDN or IP address of any load-balancing cluster member.

Exempt Users from Always-On VPN

You can configure exemptions to override an Always-On policy. For example, you might want to let certain
individuals establish VPN sessions with other companies or exempt the Always-On policy for noncorporate
assets.

Exemptions set in group policies and dynamic access policies on the Secure Firewall ASA override the
Always-On policy. You specify exceptions according to the matching criteria used to assign the policy. If the
AnyConnect VPN policy enables Always-On and a dynamic access policy or group policy disables it, the
client retains the disable setting for the current and future VPN sessions as long as its criteria match the
dynamic access policy or group policy on the establishment of each new session.

This procedure configures a dynamic access policy that uses AAA endpoint criteria to match sessions to
noncorporate assets.

Step 1 Choose Configuration > Remote Access VPN > Network (Client) Access> Dynamic Access Policies> Add or Edit.

Step 2 Configure criteria to exempt users from Always-On VPN. For example, use the Selection Criteria area to specify AAA
attributes to match user logon IDs.

Step 3 Click the AnyConnect tab on the bottom half of the Add or Edit Dynamic Access Policy window.
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Set a Connect Failure Policy for Always-On .

Puolicy Mame: |Test

Descripkion: | | ACL Priority: |0

~Selection Criteria
Define the &AM and endpaint attributes used ko select this access policy. A policy is used when a user's autharization attributes match the A48 attribute criteria
below and every endpoint attribute has been satisfied. These attribukes can be created using the kables below andfor by expanding the Advanced option to
specify the logical expression kext,

|User has ANY of the Following AAA Attributes values.., W | and the fFollowing endpaint attributes are satisfied,

| AL Attribute OperationYalue Add Endpaint 10 Marne/Operation)alue Aadd

Logical Op,

Advanced

i

-Access/Authorization Policy Attributes -
Configure accessfauthorization attributes For this policy. Attribute values specified here will override those values obtained From the A6 system and the
group-palicy hierarchy, The resulting YPH authorization policy is an aggreqgation of DAF atkributes, AAA attributes, and group-palicy hierarchy attributes (those
that are not specified in DAR),

| &ction | Metwork ACL Filkers (dient) | Webtype ACL Filters (cientless) | Functions ': Port Forwarding Lists ': Bockmarks | Access Method

g

Always-0n WPN For AnyConnect client: () Unchanged () Use AnyConneckProfile setting

Step 4 Click Disable next to “Always-On VPN for AnyConnect client."

Set a Connect Failure Policy for Always-On

About the Connect Failure Policy

The connect failure policy determines whether the computer can access the internet if Always-On VPN is
enabled and AnyConnect cannot establish a VPN session. This can occur when a secure gateway is unreachable,
or when AnyConnect fails to detect the presence of a captive portal hotspot.

An open policy permits full network access, letting users continue to perform tasks where access to the Internet
or other local network resources is needed.

A closed policy disables all network connectivity until the VPN session is established. AnyConnect does this
by enabling packet filters that block all traffic from the endpoint that is not bound for a secure gateway to
which the computer is allowed to connect.

Regardless of the connect failure policy, AnyConnect continues to try to establish the VPN connection.
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Guidelines for Setting the Connect Failure Policy
Consider the following when using an open policy which permits full network access:

* Security and protection are not available until the VPN session is established; therefore, the endpoint
device may get infected with web-based malware or sensitive data may leak.

» An open connect failure policy does not apply if you enable the Disconnect button and the user clicks
Disconnect.

Consider the following when using a closed policy which disables all network connectivity until the VPN
session is established:

* A closed policy can halt productivity if users require Internet access outside the VPN.

* The purpose of closed is to help protect corporate assets from network threats when resources in the
private network that protect the endpoint are not available.The endpoint is protected from web-based
malware and sensitive data leakage at all times because all network access is prevented except for local
resources such as printers and tethered devices permitted by split tunneling.

* This option is primarily for organizations where security persistence is a greater concern than
always-available network access.

* A closed policy prevents captive portal remediation unless you specifically enable it.

* You can allow the application of the local resource rules imposed by the most recent VPN session if
Apply Last VPN Local Resourcesis enabled in the client profile. For example, these rules could
determine access to active sync and local printing.

* The network is unblocked and open during the AnyConnect software upgrade when Always-On is enabled
regardless of a closed policy.

* If you deploy a closed connection policy, we highly recommend that you follow a phased approach.
For example, first deploy Always-On with a connect failure open policy and survey users for the frequency
with which AnyConnect does not connect seamlessly. Then deploy a small pilot deployment of a connect
failure closed policy among early-adopter users and solicit their feedback. Expand the pilot program
gradually while continuing to solicit feedback before considering a full deployment. As you deploy a
connect failure closed policy, be sure to educate the VPN users about the network access limitation as
well as the advantages of a connect failure closed policy.

A

Caution A connect failure closed policy prevents network access if AnyConnect fails to
establish a VPN session. Use extreme caution when implementing a connect
failure closed policy.

Configure a Connect Failure Policy

You configure a Connect Failure Policy only when the Always-On feature is enabled. By default, the connect
failure policy is closed, preventing Internet access if the VPN is unreachable. To allow Internet access in this
situation, the connect failure policy must be set to open.

Step 1 Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.
Step 2 Set the Connect Failure Policy parameter to one of the following settings:
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* Closed—(Default) Restricts network access when the secure gateway is unreachable.

* Open—Permits network access by browsers and other applications when the client cannot connect to the secure
gateway.

Step 3 If you specified a closed policy:
a) Configure Captive Portal Remediation.

b) Select Apply Last VPN Local Resourcesif you would like to retain the last VPN session’s local device rules while
network access is disabled.

Use Captive Portal Hotspot Detection and Remediation

About Captive Portals

Many facilities that offer Wi-Fi and wired access, such as airports, coffee shops, and hotels, require the user
to pay before obtaining access, to agree to abide by an acceptable use policy, or both. These facilities use a
technique called captive portal to prevent applications from connecting until the user opens a browser and
accepts the conditions for access. Captive portal detection is the recognition of this restriction, and captive
portal remediation is the process of satisfying the requirements of a captive portal hotspot in order to obtain
network access.

Captive portals are detected automatically by AnyConnect when initiating a VPN connection requiring no

additional configuration. Also, AnyConnect does not modify any browser configuration settings during captive
portal detection and does not automatically remediate the captive portal. It relies on the end user to perform
the remediation. AnyConnect reacts to the detection of a captive portal depending on the current configuration:

* If Always-On is disabled, or if Always-On is enabled and the Connect Failure Policy is open, the following
message is displayed on each connection attempt:

The service provider in your current location is restricting access to the Internet.
You need to log on with the service provider before you can establish a VPN session.
You can try this by visiting any website with your browser.

The end user must perform captive portal remediation by meeting the requirements of the provider of
the hotspot. These requirements could be paying a fee to access the network, signing an acceptable use
policy, both, or some other requirement defined by the provider.

* If Always-On is enabled and the connect failure policy is closed, captive portal remediation needs to be
explicitly enabled. If enabled, the end user can perform remediation as described above. If disabled, the
following message is displayed upon each connection attempt, and the VPN cannot be connected.

The service provider in your current location is restricting access to the Internet.
The AnyConnect protection settings must be lowered for you to log on with the service
provider. Your current enterprise security policy does not allow this.
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. Configure Captive Portal Remediation

Configure Captive Portal Remediation

Step 1
Step 2

Step 3

You configure captive portal remediation only when the Always-On feature is enabled and the Connect Failure
Policy is set to closed. In this situation, configuring captive portal remediation allows AnyConnect to connect
to the VPN when a captive portal is preventing it from doing so.

\}

Note Configuration of captive portal remediation is not applicable to Linux, since Always On is not supported on
this platform. Therefore, regardless of the Allow Captive Portal Remediation Always On setting in the profile

editor, the Linux user can remediate a captive portal.

If the Connect Failure Policy is set to open or Always-On is not enabled, your users are not restricted from
network access and are capable of remediating a captive portal without any specific configuration in the
AnyConnect VPN profile.

By default, captive portal remediation is disabled on platforms supporting Always on (Windows and macOS)
to provide the greatest security. AnyConnect does not provide data leakage protection capabilities during the
captive portal remediation phase. If data loss protection is desired, you should employ a relevant endpoint
security product.

Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.
Select Allow Captive Portal Remediation.

This setting lifts the network access restrictions imposed by the closed connect failure policy.

Specify the Remediation Timeout.

Enter the number of minutes for which AnyConnect lifts the network access restrictions. The user needs enough time to
satisfy the captive portal requirements.

Enhanced Captive Portal Remediation (Windows and mac0S)

With enhanced captive portal remediation, the AnyConnect embedded browser is used for remediation
whenever captive portal is detected with network access restricted by AnyConnect (for example, due to Always
On). Other applications remain with network access blocked while captive portal remediation with the
AnyConnect browser is pending. The user can close the AnyConnect browser and fail over to an external
browser (when enabled in the profile), causing AnyConnect to revert to the regular captive portal remediation
behavior. In doing so, the following message is shown:

Please retry logging on with the service provider to retain access to the Internet, by
visiting any website with your browser.

When captive portal is detected but network access is restricted by AnyConnect, the AnyConnect browser is
automatically launched, with the following message displayed to prompt the user to remediate:
The service provider in your current location is restricting access to the internet. You

need to log on with the service provider before you establish a VPN session, using the
AnyConnect browser.
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Configure Captive Portal Remediation Browser Failover

You may want to set browser failover to apply whenever the AnyConnect browser is launched for captive
portal remediation. By setting the browser failover, users can remediate the captive portal via an external
browser, after closing the AnyConnect browser.

The AnyConnect browser launched for captive portal remediation has tighter security settings with regard to
server security certificates. Untrusted server certificates are not accepted during the captive portal remediation.
If an untrusted server certificate is encountered, the corresponding HTTPS URL is not loaded by the
AnyConnect browser, potentially blocking the remediation process. If untrusted server certificates are acceptable
during captive portal remediation, you should enable captive portal remediation browser failover in order to
allow the user to remediate the captive portal. After enabling, the user can close the AnyConnect browser and
continue remediation with an external browser (as AnyConnect reverts to the regular captive portal remediation
behavior).

Before you begin

Supported on Windows and macOS.

Step 1 Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.

Step 2 Check Captive Portal Remediation Browser Failover if you want the end user to use an external browser (after closing
the AnyConnect browser) for captive portal remediation. The default is for the end user to only remediate a captive portal
with the AnyConnect browser; that is, the user is unable to disable the enhanced captive portal remediation.

Troubleshoot Captive Portal Detection and Remediation

AnyConnect can falsely assume that it is in a captive portal in the following situations.

» If attempts to contact an Secure Firewall ASA with a certificate containing an incorrect server name
(CN), then AnyConnect will think it is in a “captive portal” environment.

To prevent this, make sure the Secure Firewall ASA certificate is properly configured. The CN value in
the certificate must match the name of the Secure Firewall ASA server in the VPN client profile.

* [f there is another device on the network before the Secure Firewall ASA, and that device responds to
the client's attempt to contact the Secure Firewall ASA by blocking HTTPS access to the ASA, then
AnyConnect will think it is in a “captive portal” environment. This situation can occur when a user is
on an internal network, and connects through a firewall to connect to the Secure Firewall ASA.

If you need to restrict access to the Secure Firewall ASA from inside the corporation, configure your
firewall such that HTTP and HTTPS traffic to the ASA’s address does not return an HTTP status.
HTTP/HTTPS access to the Secure Firewall ASA should either be allowed or completely blocked to
ensure that HTTP/HTTPS requests sent to the ASA will not return an unexpected response.

If users cannot access a captive portal remediation page, ask them to try the following:

* Terminate any applications that use HTTP, such as instant messaging programs, e-mail clients, IP phone
clients, and all but one browser to perform the remediation.

The captive portal may be actively inhibiting DoS attacks by ignoring repetitive attempts to connect,
causing them to time out on the client end. The attempt by many applications to make HTTP connections
exacerbates this problem.
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* Disable and re-enable the network interface. This action triggers a captive portal detection retry.

* Restart the computer.

Configure AnyConnect over L2TP or PPTP

ISPs in some countries require support of the Layer 2 Tunneling Protocol (L2TP) and Point-to-Point Tunneling
Protocol (PPTP).

To send traffic destined for the secure gateway over a Point-to-Point Protocol (PPP) connection, AnyConnect
uses the point-to-point adapter generated by the external tunnel. When establishing a VPN tunnel over a PPP
connection, the client must exclude traffic destined for the Secure Firewall ASA from the tunneled traffic
intended for destinations beyond the Secure Firewall ASA. To specify whether and how to determine the
exclusion route, use the PPP Exclusion setting in the AnyConnect profile. The exclusion route appears as a
non-secured route in the Route Details display of the AnyConnect GUI.

Step 1 Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.
Step 2 Choose a PPP Exclusion method. Also, check User Controllable for this field to let users view and change this setting:

» Automatic—Enables PPP exclusion. AnyConnect automatically determines the IP address of the PPP server.

* Override—Enables PPP Exclusion using a predefined server IP address specified in the PPP Exclusion Server |P
field. The PPP Exclusion Server IP field is only applicable to this Override method and should only be used when
the Automatic options fails to detect the IP address of the PPP server.

Checking User Controllable for the PPP Exclusion Server IP field allows the end user to manually update the TP
address via the preferences.xml file. Refer to the Instruct Users to Override PPP Exclusion, on page 122 section.

* Disabled—PPP exclusion is not applied.

Instruct Users to Override PPP Exclusion

If automatic detection does not work and you configured the PPP Exclusion fields as user controllable, the
user can override the setting by editing the AnyConnect preferences file on the local computer.

Step 1 Use an editor such as Notepad to open the preferences XML file.
This file is at one of the following paths on the user’s computer:
* Windows: %LOCALAPPDATA%\Cisco\Cisco AnyConnect Secure Mobility Client\preferences.xml. For example,
» macOS: /Users/username/.vpn/.anyconnect
* Linux: /home/username/.vpn/.anyconnect

Step 2 Insert the PPPExclusion details under <ControllablePreferences>, while specifying the Override value and the IP
address of the PPP server. The address must be a well-formed IPv4 address. For example:
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Step 3
Step 4

Use Management VPN Tunnel .

<AnyConnectPreferences>

<ControllablePreferences>

<PPPExclusion>Override
<PPPExclusionServerIP>192.168.22.44</PPPExclusionServerIP></PPPExclusion>
</ControllablePreferences>

</AnyConnectPreferences>

Save the file.
Exit and restart AnyConnect.

Use Management VPN Tunnel

About the Management VPN Tunnel

A management VPN tunnel ensures connectivity to the corporate network whenever the client system is
powered up, not just when a VPN connection is established by the end user. You can perform patch management
on out-of-the-office endpoints, especially devices that are infrequently connected by the user, via VPN, to the
office network. Endpoint OS login scripts which require corporate network connectivity will also benefit from
this feature.

The management VPN tunnel is meant to be transparent to the end user; therefore, network traffic initiated
by user applications is not impacted, by default, but instead directed outside the management VPN tunnel.

When a management tunnel feature is detected as enabled, a restricted user account (ciscoacvpnuser) is created
to enforce the principle of least privilege. This account gets removed during AnyConnect uninstallation or
during an installation upgrade.

If a user complains of slow logins, it may be an indication that the management tunnel was not configured
appropriately. Configure the Management VPN Tunnel, on page 125 describes the configuration steps that are
required to enable the feature. If symptoms suggest lack of connectivity to the corporate network despite
following this configuration, refer to Troubleshoot Management VPN Tunnel Connectivity Issues.

Compatibilities and Requirements of Management VPN Tunnel

* Requires ASA 9.0.1 (or later) and ASDM 7.10.1 (or later)

* Connects whenever the user initiated VPN tunnel is disconnected, before or after user login.

N

Note The management VPN tunnel is not established when a trusted network is detected
by the Trusted Network Detection (TND) feature or when AnyConnect software
update is in progress.

* Disconnects whenever the user initiates a VPN tunnel, before or after user login.
+ Uses only machine store certificate authentication.

* Requires split include tunneling configuration, by default, to avoid impacting user initiated network
communication (since the management VPN tunnel is meant to be transparent to the end user). To override
this behavior, see Configure a Custom Attribute to Support Tunnel-All Configuration , on page 127.
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* Performs strict certificate checking on server certificate. The server certificate's root CA certificate must
reside in the machine certificate store (computer certificate store on Windows, or system keychain or
system file certificate store on macOS).

» Works with backup server list.

* Currently available only on Windows and macOS. Linux support will be added in subsequent releases.

Incompatibilities and Limitations of Management VPN Tunnel

* The management VPN profile does not support the value Native for proxy settings. This restriction applies
only to Windows client, since the management VPN tunnel can be initiated without any user logged in;
therefore, it cannot rely on user-specific browser proxy settings.

» The management VPN profile does not support private proxy settings that are pushed from the VPN
server. Since the management VPN tunnel is meant to be transparent to the end user, user-specific or
system proxy settings are not altered.

* Not compatible with the Always On feature, since the management VPN tunnel is established whenever
the user VPN tunnel is inactive. However, you can configure the group policy for the management tunnel
connection to tunnel all traffic, ensuring that no traffic is leaked by physical interfaces while the user
VPN tunnel is inactive. Refer to Configure a Custom Attribute to Support Tunnel-All Configuration ,
on page 127.

* Captive portal remediation is only performed when the AnyConnect Ul is running and while the user is
logged in, as if the management VPN tunnel feature was not enabled.

* The management VPN profile settings are only enforced by AnyConnect while the management VPN
tunnel is active. When the management VPN tunnel is disconnected, only user VPN tunnel profile settings
are enforced. Therefore, the management VPN tunnel is initiated according to the Trusted Network
Detection (TND) settings in the user VPN tunnel profile, namely when TND is disabled or when it detects
"untrusted network," regardless of the configured Untrusted Network Policy. Additionally, the TND
Connect action in the management VPN profile (enforced only when the management VPN tunnel is
active), always applies to the user VPN tunnel, to ensure that the management VPN tunnel is transparent
to the end user. For a consistent user experience, you must use identical TND settings in both user and
management VPN tunnel profiles.

Mandatory Preferences Enforced by Management VPN Profile

Certain profile preferences are mandatory while the management VPN tunnel is active. To assist you in
configuring a valid profile, mandatory preferences are enforced by the AnyConnect Management VPN Profile
Editor, by disabling the corresponding UI controls. During a management tunnel connection, the following
preference values are overridden, mostly to eliminate user interaction and to minimize tunnel interruptions:

* AllowManualHostInput: false—Not relevant to the management tunnel (headless client).

+» AlwaysOn: false—Not relevant, since user tunnel profile preferences are enforced whenever the
management tunnel is disconnected.

+ AutoConnectOnStart: false—Relevant only to a UI client, for automatic connection on start-up to the
previously connected host.

+ AutomaticCertSelection: true—To avoid certificate selection popups.

+ AutoReconnect: true—To avoid management tunnel termination on network changes.
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+ AutoReconnectBehavior: ReconnectAfter Resume—To avoid management tunnel termination on network
changes.

» AutoUpdate: false—No software updates are performed during a management tunnel connection.
* BlockUntrustedServers: true—To avoid untrusted server certificate prompts.

* CertificateStore: MachineStore—Management tunnel authentication should also succeed without a
logged in user.

* CertificateStoreOverride: true—Required for machine certificate authentication on Windows.
« EnableAutomaticServer Selection: false—Only one host entry is expected in the management VPN profile.

+ EnableScripting: false—AnyConnect customization scripts (invoked at connect and/or disconnect time)
are not executed during a management tunnel connection.

 MinimizeOnConnect:false—Not relevant to the management tunnel (headless client).
* RetainVPNONLogoff:true—The management tunnel should remain active on user logoff.
* ShowPreConnect Message—Not relevant to the management tunnel (headless client).

* UserEnforcement: AnyUser—To ensure that the management tunnel is not potentially disconnected when
a certain user logs in.

» UseStartBeforelogon: False—Only applicable to user tunnel.

» WindowsVPNEstablishment: AllowRemote Users—To ensure that the management tunnel is not impacted
by any type of user (local/remote) logging in.

« LinuxVPNEstablishment: Allow Remote Users— To ensure that the management tunnel is not impacted
by any type of user (local/remote)

Also, AnyConnect does not enforce the following profile preferences during a management tunnel connection:
WindowsLogonEnforcement and SCEP related preferences.

Configure the Management VPN Tunnel

Because the management tunnel connection may occur without any user logged in, only machine store
certificate authentication is supported. Consequently, at least one relevant client certificate needs to be available
in the client host's machine certificate store.

Configure the Tunnel Group for the Management VPN Tunnel

You must configure the authentication method of the tunnel group as "certificate only" by navigating to
Configuration > Remote Access > Networ k (Client) Access> AnyConnect Connection Profiles> Add/Edit
in ASDM and choosing it from the Method drop-down menu under Authentication. Then configure the group
URL in Advanced > Group Alias/Group URL, which is then specified in the management VPN profile (as
described in Create a Profile for Management VPN Tunnel, on page 126).

The group policy for this tunnel group must have split include tunneling configured for all IP protocols with
client address assignment configured in the the tunnel group: choose Tunnel Network List Below from
ASDM Remote Access VPN > Network (Client) Access> Group Policies > Edit > Advanced > Split
Tunnéling > . Configure a Custom Attribute to Support Tunnel-All Configuration , on page 127 describes
how to enable support for other split tunneling configurations. If a client address assignment is not configured
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in the tunnel group for both IP protocols, you must enable Client Bypass Protocol in the group policy, so that
traffic matching the IP protocol without client address assignment is not disrupted by the management VPN
tunnel.

Create a Profile for Management VPN Tunnel

Step 1
Step 2
Step 3

Step 4

You can deploy only one management VPN profile to a given client device. The management VPN profile
is stored in a dedicated directory (%ProgramData%\Cisco\Cisco AnyConnect Secure Mobiliy
Client\Profile\MgmtTun in Windows, /opt/cisco/anyconnect/profile/mgmttun in macOS) with a fixed name
(VpnMgmtTunProfile.xml). A management VPN profile can have zero or one host entry that points to a tunnel
group configured as per section Configure the Tunnel Group for the Management VPN Tunnel, on page 125.
To automatically disable the feature (upon profile update during tunnel establishment), you should configure
zero host entries in the management VPN profile.

Before you begin

Complete Configure the Tunnel Group for the Management VPN Tunnel, on page 125.

Navigate to Configuration > Remote Access VPN > Network (Client) Access > AnyConnect Client Profile.
Click Add. The Add AnyConnect Client Profiles window appears.

Choose AnyConnect M anagement VPN Profileas the profile usage. Refer to the Configure AnyConnect Client Profiles
section in the Cisco ASA Series VPN ASDM Configuration Guide for further description of how to populate the fields
on the Add AnyConnect Client Profile screen.

Choose the group policy created in Configure the Tunnel Group for the Management VPN Tunnel, on page 125. Click
OK to create the Management VPN Profile, then Edit to configure it, as well as for subsequent updates.

(Optional) Upload an Already Configured Management VPN Profile

Step 1

Step 2
Step 3

You may need to upload to Secure Firewall ASA an already configured management VPN profile that was
edited or created using the standalone AnyConnect Management VPN Profile Editor, copied from AnyConnect,
or exported from another Secure Firewall ASA.

From the AnyConnect Client Profile window in ASDM, click Add and then Upload....
When choosing a destination location for the upload file, ensure that you choose a profile with a vpnm extension.

Provide a profile name and choose AnyConnect M anagement VPN Profile from the Profile Usage drop-down menu.

Choose the group policy created in Configure the Tunnel Group for the Management VPN Tunnel, on page 125. Click
OK to create the Management VPN Profile.

Associate the Management VPN Profile to Group Policies

You must add the management VPN profile to the group policy associated with the tunnel group used for the
management tunnel connection.
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Step 1
Step 2

\)

Configure a Custom Attribute to Support Tunnel-All Configuration .

Note

Similarly, you may also add the management VPN profile to the group policy mapped to the regular tunnel
group, used for the user tunnel connection. When the user connects, the management VPN profile is
downloaded, along with the user VPN profile already mapped to the group policy, enabling the management
VPN tunnel feature.

Alternatively, you can deploy the management VPN profile out of band: ensure it is named
VpnMgmtTunProfile.xml, copy it to the above mentioned management VPN profile directory, and restart the
AnyConnect Secure Mobility Client Agent service (or reboot).

Before you begin

Complete Configure the Tunnel Group for the Management VPN Tunnel, on page 125 and Create a Profile
for Management VPN Tunnel, on page 126.

Navigate to Group Policy > Advanced > AnyConnect Client in ASDM.

In Client Profiles to Download, click Add and choose the management VPN profile created or updated in the Create a
Profile for Management VPN Tunnel, on page 126 section.

Configure a Custom Attribute to Support Tunnel-All Configuration

Management VPN tunnel requires split include tunneling configuration, by default, to avoid impacting user
initiated network communication (since management VPN tunnel is meant to be transparent to the end user).
You can override this behavior by configuring the following custom attribute in the group policy used by the
management tunnel connection (in the Create Custom Attribute ASDM window: Configuration > Remote
Access VPN > Network (Client) Access > Group Policies > Edit > Advanced > AnyConnect Client >
Custom Attributes > Add).

If you set a new custom attribute type to ManagementTunnel AllAllowed and set the corresponding custom
attributes to true, AnyConnect proceeds with the management tunnel connection, if the configuration is one
of tunnel-all, split-exclude, split-include, or bypass for both IP protocols.

Restrict Management VPN Profile Updates

You can restrict management VPN profile updates to a certain trusted server list with a new AnyConnect local
policy file (AnyConnectLocalPolicy.xml) setting, and still allow user VPN profile updates from any server.
Edit this setting through the Local Policy Preferences by checking the Allow Management VPN Profile
Updates From Any Server checkbox.

For example, if management VPN profile updates are allowed only from the VPN server TrustedServer, the
checkbox would be unchecked, and TrustedServer would be added to the trusted server list. (Replace
TrustedServer with the FQDN or IP address present in the corresponding VPN profile server entry.)

Troubleshoot Management VPN Tunnel Connectivity Issues

If the client host is not reachable remotely, various scenarios may have occurred causing the management
VPN tunnel to disconnect or not be established. In these scenarios, the AnyConnect GUI and CLI reflect the
Management Connection State as a statistics entry:
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* Disconnected (disabled)—The feature is disabled.

* Disconnected (trusted network)—TND detected a trusted network so the management tunnel is not
established.

* Disconnected (user tunnel active)}—A user tunnel is currently pending (thus disconnecting the management
tunnel).

* Disconnected (process launch failed)—A process launch failure was encountered upon attempting the
management tunnel connection.

* Disconnected (connect failed}—A connection failure was encountered upon establishing the management
tunnel.

* Disconnected (invalid VPN configuration)—An invalid split tunneling configuration was encountered
upon management tunnel establishment. Refer to Configure a Custom Attribute to Support Tunnel-All
Configuration , on page 127 for additional information.

* Diconnected (software update pending)—AnyConnect software update is currently pending (thus
disconnecting the management tunnel).

* Disconnected—The management tunnel is about to be established or could not be established for some
other reason.

To troubleshoot the lack of connectivity over the management VPN tunnel (expected to be established on the
client host), verify the following:

* Check the state of the management VPN connection on the AnyConnect UI Statistics tab, in the Export
Stats output, or the Connection Information/Management Connection State in the CLI. If the management
connection state is unexpectedly listed as "disconnected" and the provided explanation is insufficient,
capture the AnyConnect logs with the DART tool for further troubleshooting.

* If you see Management Connection State: Disconnected (disabled) in the UI stats line, ensure that the
management VPN profile is configured with a single host entry, pointing to a tunnel group set up with
certificate authentication. The associated group policy must have a single profile configured: the
management VPN profile.

N

Note The associated group policy should have no banner enabled. User interaction is
not supported during a management tunnel connection.

* If you see Management Connection State: Disconnected (disabled) in the UI stats line, ensure that the
management VPN profile is configured within the group policy that is associated with the tunnel group
used for regular user tunnel connections. When the user connects with that tunnel group, the management
VPN profile is downloaded, and the feature is enabled.

\}

Note  Alternatively, you can deploy the management VPN profile out of band.

* If you see Management Connection State: Disconnected (connect failed) in the Ul stats line, note that
the management tunnel connection fails whenever user interaction is needed, as follows:
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« if the server certificate is not trusted. The server certificate's root CA certificate must reside in the
machine certificate store.

« if a private key (pertaining to a machine store certificate) is password protected, the corresponding
client certificate is not usable by the management tunnel connection. The client certificate is not
usable because the user cannot be prompted for the private key password.

+ if a macOS system keychain private key is not configured to allow access without prompting to the
AnyConnect agent executable (vpnagentd); the corresponding client certificate is unusable by the
management tunnel connection, since the user cannot be prompted for credentials to access the
private key.

« if group policy was configured with a banner.

Configure AnyConnect Proxy Connections

About AnyConnect Proxy Connections

AnyConnect supports VPN sessions through Local, Public, and Private proxies:
* Local Proxy Connections:

A local proxy runs on the same PC as AnyConnect, and is sometimes used as a transparent proxy. Some
examples of a transparent proxy service include acceleration software provided by some wireless data
cards, or a network component on some antivirus software, such as Kaspersky.

The use of a local proxy is enabled or disabled in the AnyConnect profile, see Allow a Local Proxy
Connection.

* Public Proxy Connections:

Public proxies are usually used to anonymize web traffic. When Windows is configured to use a public
proxy, AnyConnect uses that connection. Public proxy is supported on macOS and Linux for both native
and override.

Configuring a public proxy is described in Public Proxy, on page 130 .

* Private Proxy Connections:

Private proxy servers are used on a corporate network to prevent corporate users from accessing certain
Web sites based on corporate usage policies, for example, pornography, gambling, or gaming sites.

You configure a group policy to download private proxy settings to the browser after the tunnel is
established. The settings return to their original state after the VPN session ends. See Configure a Private
Proxy Connection, on page 131.

\}

Note AnyConnect SBL connections through a proxy server are dependent on the
Windows operating system version and system (machine) configuration or other
third-party proxy software capabilities; therefore, refer to system wide proxy
settings as provided by Microsoft or whatever third-party proxy application you
use.
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Control Client Proxy with VPN Client Profile

The VPN Client profile can block or redirect the client system's proxy connection. For Windows and Linux,
you can configure, or you can allow the user to configure, the address of a public proxy server.

For more information about configuring the proxy settings in the VPN client profile, see AnyConnect Profile
Editor, Preferences (Part 2), on page 77.

Proxy Auto-Configuration File Generation for Clientless Support

Some versions of the Secure Firewall ASA require AnyConnect configuration to support clientless portal
access through a proxy server after establishing the AnyConnect session. AnyConnect uses a proxy
auto-configuration (PAC) file to modify the client-side proxy settings to let this occur. AnyConnect generates
this file only if the Secure Firewall ASA does not specify private-side proxy settings.

Requirements for AnyConnect Proxy Connections

OS support of proxy connections varies as shown:

Proxy Connection Type | Windows mac0S Linux
Local Proxy Yes Yes (Override& | Yes
Native)
Private Proxy Yes (on Internet | Yes (set as No
Explorer) system proxy
settings)
Public Proxy Yes (IE and Yes (Override & | Yes (Override&
Override) Native Native)

Limitations on Proxy Connections

* Connecting through a proxy is not supported with the Always-On feature enabled.

» A VPN client profile is required to allow access to a local proxy.

Allow a Local Proxy Connection

Step 1 Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.
Step 2 Select (default) or unselect Allow L ocal Proxy Connections. Local proxy is disabled by default.

Public Proxy

Public proxies are supported on Windows and Linux platforms. Proxy servers are chosen based on preferences
set in the client profile. In case of proxy override, AnyConnect extracts proxy servers from the profile. With
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release 4.1 (and later) we added proxy support on macOS along with Native-proxy configuration on Linux
and macOS.

On Linux, native-proxy settings are exported before AnyConnect runs. If you change the settings, a restart
must happen.

Authenticating Proxy Servers requires a username and password. AnyConnect supports Basic and NTLM
authentication when the proxy server is configured to require authentication. AnyConnect dialogs manage
the authentication process. After successfully authenticating to the proxy server, AnyConnect prompts for the
Secure Firewall ASA username and password.

Configure a Public Proxy Connection, Windows

Follow these steps to configure a public proxy connection on Windows.

Step 1 Open I nternet Options from Internet Explorer or the Control Panel.
Step 2 Select the Connections Tab, and click the L AN Settings button.
Step 3 Configure the LAN to use a proxy server, and enter the IP address of the proxy server.

Configure a Public Proxy Connection, mac0S

Step 1 Go to system preferences and choose the appropriate interface on which you are connected.
Step 2 Click Advanced.

Step 3 Choose Proxiestab from the new window.

Step 4 Enable HTTPS proxy.

Step 5 Enter the proxy server address in the Secure Proxy Server field on the right panel.

Configure a Public Proxy Connection, Linux

To configure a public proxy connection in Linux, you must set an environment variable.

Configure a Private Proxy Connection

Step 1 Configure the private proxy information in the Secure Firewall ASA group policy. See the Configuring a Browser Proxy
for an Internal Group Policy section in the Cisco ASA Series VPN CLI or ASDM Configuration Guide.

Note In a macOS environment, the proxy information that is pushed down from the Secure Firewall ASA (upon
a VPN connection) is not viewed in the browser until you open up a terminal and issue a scutil --proxy.

Step 2 (Optional) Configure the Client to Ignore Browser Proxy Settings.
Step 3 (Optional) Lock Down the Internet Explorer Connections Tab.

Cisco AnyConnect Secure Mobility Client Administrator Guide, Release 4.10 .


http://www.cisco.com/en/US/docs/security/asa/asa91/asdm71/vpn/vpn_asdm_setup.html#wp1336831
http://www.cisco.com/en/US/docs/security/asa/asa91/asdm71/vpn/vpn_asdm_setup.html#wp1336831
https://www.cisco.com/c/en/us/support/security/adaptive-security-appliance-asa-software/series.html

Configure AnyConnect VPN |

. Configure the Client to Ignore Browser Proxy Settings

What to do next

\)

Note

When a VPN session initiated via proxy is active, network access via proxy is restricted only to AnyConnect
related processes. Therefore, to accommodate third-party applications communicating over HTTP/HTTPS,
you must set the private proxy settings in the VPN policy to something other than Do not modify client proxy
settings, such as Do not use proxy. Alternatively, you can configure the VPN profile Proxy Settings so that

system proxy settings are ignored upon initiating a VPN connection.

Configure the Client to Ignore Browser Proxy Settings

Step 1
Step 2

You can specify a policy in the AnyConnect profile to bypass the Microsoft Internet Explorer or Safari proxy
configuration settings on the user’s PC. This prevents the user from establishing a tunnel from outside the
corporate network, and prevents AnyConnect from connecting through an undesirable or illegitimate proxy
server.

Open the VPN Profile Editor and choose Preferences (Part 2) from the navigation pane.

In the Proxy Settings drop-down list, choose I gnoreProxy. Ignore Proxy causes the client to ignore all proxy settings.
No action is taken against proxies that are downloaded from the Secure Firewall ASA.

Lock Down the Internet Explorer Connections Tab

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Under certain conditions, AnyConnect hides the Internet Explorer Tools > Internet Options > Connections
tab. When exposed, this tab lets the user set proxy information. Hiding this tab prevents the user from
intentionally or unintentionally circumventing the tunnel. The tab lockdown is reversed on disconnect, and it
is superseded by any administrator-defined policies applied to that tab. The conditions under which this lock
down occurs are the following:

* The Secure Firewall ASA configuration specifies Connections tab lockdown.
* The Secure Firewall ASA configuration specifies a private-side proxy.

* A Windows group policy previously locked down the Connections tab (overriding the no lockdown
Secure Firewall ASA group policy setting).

You can configure the Secure Firewall ASA to allow or not allow proxy lockdown, in the group policy. To
do this using ASDM, follow this procedure:

In ASDM go to Configuration > Remote Access VPN > Network (Client) Access > Group Poalicies.
Select a group policy and click Edit or Add a new group policy.

In the navigation pane, go to Advanced > Browser Proxy. The Proxy Server Policy pane displays.

Click Proxy L ockdown to display more proxy settings.

Uncheck I nherit and select Yesto enable proxy lockdown and hide the Internet Explorer Connections tab for the duration
of the AnyConnect session or; select NO to disable proxy lockdown and expose the Internet Explorer Connections tab
for the duration of the AnyConnect session.

Click OK to save the Proxy Server Policy changes.
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Step 7 Click Apply to save the Group Policy changes.

Verify the Proxy Settings

» For Windows: Find the user and system proxy settings in the registry under:

HKEY CURRENT USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Internet Settings

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Internet Settings\Connections

* For macOS: Open a terminal window, and type:

scutil --proxy

Select and Exclude VPN Traffic

Configure IPv4 or IPv6 Traffic to Bypass the VPN

You can configure how AnyConnect manages IPv4 traffic when the Secure Firewall ASA is expecting only
IPv6 traffic or how AnyConnect manages IPv6 traffic when the ASA is only expecting IPv4 traffic using the
Client Bypass Protocol setting.

When AnyConnect makes a VPN connection to the Secure Firewall ASA, the ASA can assign the client an
IPv4, IPv6, or both an IPv4 and IPv6 address.

If Client Bypass Protocol is enabled for an IP protocol and an address pool is not configured for that protocol
(in other words, no IP address for that protocol was assigned to client by the Secure Firewall ASA), any IP
traffic using that protocol will not be sent through the VPN tunnel. It will be sent outside the tunnel.

If Client Bypass Protocol is disabled, and an address pool is not configured for that protocol, the client drops
all traffic for that IP protocol once the VPN tunnel is established.

For example, assume that the Secure Firewall ASA assigns only an IPv4 address to the AnyConnect connection,
and the endpoint is dual stacked. When the endpoint attempts to reach an IPv6 address, if Client Bypass
Protocol is disabled, the IPv6 traffic is dropped. If Client Bypass Protocol is enabled, the IPv6 traffic is sent
from the client in the clear.

If establishing an IPsec tunnel (as opposed to an SSL connection), the Secure Firewall ASA is not notified
whether or not IPv6 is enabled on the client, so Secure Firewall ASA always pushes down the client bypass
protocol setting.

You configure the Client Bypass Protocol on the Secure Firewall ASA in the group policies.

Step 1 In ASDM go to Configuration > Remote Access VPN > Network (Client) Access > Group Poalicies.
Step 2 Select a group policy and click Edit or Add a new group policy.

Step 3 Select Advanced > AnyConnect.

Step 4 Next to Client Bypass Protocol, uncheck Inherit if this is a group policy other than the default group policy.
Step 5 Choose one of these options:
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* Click Disableto drop IP traffic for which the Secure Firewall ASA did not assign an address.

« Click Enableto send that IP traffic in the clear.

Step 6 Click OK.
Step 7 Click Apply.

Configure a Client Firewall with Local Printer and Tethered Device Support

See the Client Firewall with Local Printer and Tethered Device Support section in the Cisco ASA Series
VPN CLI or ASDM Configuration Guide.

Configure Split Tunneling

Split tunneling is configured in a Network (Client) Access group policy. See the Configure Split Tunneling
for AnyConnect Traffic section in the Cisco ASA Series VPN CLI or ASDM Configuration Guide.

After making changes to the group policy in ASDM, be sure the group policy is associated with a Connection
Profile in Configuration > Remote Access VPN > Network (Client) Access > AnyConnect Connection
Profiles> Add/Edit > Group Poalicy.

Routing Network Traffic on Linux

To enable Linux users to route network traffic on a VM instance/docker container, you must create a new
custom attribute and enable it. Create a tunnel-from-any-sour ce custom attribute and when set to true,
AnyConnect permits packets with any source addresses in split-include or split-exclude tunnel mode, allowing
network access inside the VM instance or Docker container.

\}

Note The network used by the VM instance or Docker container must be excluded from the tunnel initially.

About Dynamic Split Tunneling

Dynamic split tunneling was designed to enhance the static split tunneling options, which are configured with
the "Exclude Network List Below" or "Tunnel Network List Below" option in ASDM group policy
configuration. Beyond the static inclusions or exclusions typically used to define split tunneling, the dynamic
split tunneling inclusions or exclusions address scenarios when traffic pertaining to a certain service needs to
be excluded from or included into the VPN tunneling. You cannot configure a distinct split tunneling setting
for each IP protocol. For example, if you enable dynamic split include tunneling for IPv4 (such as IPv4 split
include and dynamic split include domains), you cannot enable dynamic split exclude tunneling for IPv6 (such
as IPv6 tunnel-all and dynamic split exclude domains). Additionally, we provide an enhanced dynamic split
tunneling, where both dynamic split exclude and dynamic split include domains are specified for enhanced
domain name matching.

The limits also vary from static split tunneling to dynamic split tunneling. For static split tunneling, the limit
is 2500 networks/ACEs per IP protocol. With dynamic split tunneling, AnyConnect takes into account only
dynamic split tunneling domains with the first 20,000 characters of the domain list pushed by the headend,

and is only enforced via truncation on the client. Wildcards are not supported. For both dynamic split exclude
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and dynamic split include, besides the configured domains, all of their subdomains are also excluded from
(or included into for dynamic split include) the tunnel.

Dynamic Split Exclude Tunneling—Multiple cloud-based services may be hosted on the same IP pool and
may resolve to different IP addresses based on the location of the user or the load of cloud-hosted compute
resources. Administrators who only want to exclude a single such service from the VPN tunnel would have
a difficult time defining such a policy using static exclusions, especially when ISP NAT, 6to4, 4t06, and other
network translation schemes are also considered. With dynamic split exclude tunneling, you can dynamically
provision split exclude tunneling after tunnel establishment, based on the host DN'S domain name. For example,
a VPN administrator could configure example.com to be excluded from the VPN tunnel at runtime. When
the VPN tunnel is up and an application attempts to connect to mail.example.com, the VPN client automatically
changes the system routing table and filters to allow the connection outside of the tunnel.

Enhanced Dynamic Split Exclude Tunneling—When dynamic split exclude tunneling is configured with
both dynamic split exclude and dynamic split include domains, traffic dynamically excluded from the VPN
tunnel much match at least one dynamic split exclude domain, but no dynamic split include domains. For
example, if a VPN administrator configured a dynamic split exclude domain example.com and a dynamic
split include domain of mail.example.com, all example.com traffic other than mail.example.com is excluded
from tunneling.

Dynamic Split Include Tunneling—With dynamic split include tunneling, you can dynamically provision
split include tunneling after tunnel establishment, based on the host DNS domain name. For example, a VPN
administrator could configure domain.com to be included into the VPN tunnel at runtime. When the VPN
tunnel is up and an application attempts to connect to www.domain.com, the VPN client automatically changes
the system routing table and filters to allow the connection inside the VPN tunnel.

Enhanced Dynamic Split Include Tunneling—When dynamic split include tunneling is configured with
both dynamic split include and dynamic split exclude domains, traffic dynamically included into the VPN
tunnel must match at least one dynamic split include domain, but no dynamic split exclude domains. For
example, if a VPN administrator configured domain.com as a split include domain and www.domain.com as
a split exclude domain, all domain.com traffic other than www.domain.com is tunneled.

\}

Note Dynamic split tunneling is not supported on Linux or any mobile platforms.

Interoperability Between Static Split Tunneling and Dynamic Split Tunneling

Both static and dynamic exclusions can coexist. While static split tunneling is applied when the tunnel is
established, dynamic split tunneling is applied when the traffic to the domain occurs, while the tunnel is
already connected.

Dynamic Split Exclude Tunneling

Dynamic split exclude tunneling applies to "tunnel all," "split include," and "split exclude" tunneling:
* Tunnel All Networks—All exclusions from the VPN tunnel are dynamic.
* Exclude Specific Networks—Dynamic exclusions are added to preconfigured static ones.

* Include Specific Networks—Dynamic exclusions are only relevant if at least one IP address of the
excluded host names overlaps with a split include network. Otherwise, the traffic is already excluded
from the VPN tunnel, and no dynamic exclusion is performed.
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. Outcome of Overlapping Scenarios with Split Tunneling Configuration

Enhanced dynamic split exclude tunneling applies to "tunnel all" and "split exclude" tunneling. If both dynamic
split exclude and dynamic split include domains, as well as split include tunneling, are configured, the resulting
configuration is enhanced dynamic split include tunneling.

Dynamic Split Include Tunneling

Dynamic split include tunneling applies only to split include configuration.

Enhanced dynamic split include tunneling applies only to split include configuration.

N

Note

Umbrella Roaming Security protection is active when either static or dynamic split tunneling is enabled. You
may have to statically include or exclude the Umbrella cloud resolvers from the VPN tunnel, unless they are
reachable and can be probed over the VPN tunnel.

Outcome of Overlapping Scenarios with Split Tunneling Configuration

Dynamic inclusion or exclusion covers only IP addresses not already included or excluded. When both static
and some form of dynamic tunneling is applied and a new inclusion or exclusion needs to be enforced, a
collision with an already applied inclusion or exclusion may occur. When a dynamic exclusion is enforced
(which contains all IP addresses that are part of a DNS response matching an excluded domain name), only
those addresses not already excluded are considered for exclusion. Likewise, when a dynamic inclusion is
enforced (which contains all IP addresses that are part of a DNS response matching an included domain name),
only those addresses not already included are considered for inclusion.

Static public routes (such as split-exclude and critical routes such as the secure gateway route) take precedence
over dynamic split include routes. For that reason, if at least one IP address of the dynamic inclusion matches
a static public route, the dynamic inclusion is not enforced.

Similarly, static split-include routes take precedence over dynamic split exclude routes. For that reason, if at
least one IP address of the dynamic exclusion matches a static split-include route, the dynamic exclusion is
not enforced.

Notifications of Dynamic Split Tunneling Usage

While the VPN tunnel is connected, you can see what is set for dynamic split tunneling in several ways:

» Statistics tab—Displays Dynamic Tunnel Exclusions and Dynamic Tunnel Inclusions, containing the
domain names excluded from or included into the VPN tunnel, as configured in the Secure Firewall ASA

group policy.

* Export Stats—Produces a file that contains the domain names excluded from or included into the VPN
tunneling, along with the tunnel modes for both IPv4 and IPv6. Dynamic routes are also included in the
exported statistics.

* Route Details tab—Shows the IPv4 and IPv6 dynamic split exclude and include routes with the host
names that correspond to each excluded or included IP address.

\)

Note The AnyConnect UI only displays up to 200 per IP protocol of the secured or
non-secured routes enforced by AnyConnect VPN. In excess of 200 routes,
truncation occurs, and you can run either route print on Windows or
netstat -rn on Linux or macOS to view all routes.
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* VPN configuration log message—Shows the number of domains excluded from or included into the
VPN tunnel.

Configure Dynamic Split Exclude Tunneling

Step 1

Step 2

Step 3

Before you begin
Refer to About Dynamic Split Tunneling, on page 134.

With dynamic split tunneling, you can dynamically provision split exclude tunneling after tunnel establishment
based on the host DNS domain name. Dynamic split tunneling is configured by creating a custom attribute
and adding it to a group policy on Secure Firewall ASA. Refer to Configure Dynamic Split Tunneling in the
Cisco ASA Series VPN ASDM Configuration Guide for GUI steps.

Define the custom attribute type in the WebVPN context with the following command:

anyconnect-custom-attr dynamic-split-exclude-domains description dynamic split exclude domains
Define the custom attribute names for each cloud/web service that needs access by the client outside the VPN tunnel. For
example, add Google domains to represent a list of DNS domain names pertaining to Google web services. The attribute

value contains the list of domain names to exclude from the VPN tunnel and must be in comma-separated-values (CSV)
format using the following as an example:

anyconnect-custom-data dynamic-split-exclude-domains example service domains examplel.com, example2.com

Attach the previously defined custom attribute to a certain policy group with the following command, executed in the
group-policy attributes context:

anyconnect-custom dynamic-split-exclude-domains value example service domains

Configure Enhanced Dynamic Split Exclude Tunneling

Step 1

Step 2

Before you begin
Refer to About Dynamic Split Tunneling, on page 134.

Enhanced domain name matching is supported when dynamic split exclude tunneling is configured with both
dynamic split exclude and dynamic split include domains. Enhanced dynamic split exclude tunneling is
configured by creating two custom attribute and adding it to a group policy on Secure Firewall ASA. Refer
to Configure Dynamic Split Tunneling in the Cisco ASA Series VPN ASDM Configuration Guide for GUI
steps.

Define the custom attribute type in the WebVPN context with the following command:

anyconnect-custom-attr dynamic-split-exclude-domains description dynamic split exclude domains

Define the custom attribute names for each cloud/web service that needs access by the client outside the VPN tunnel. For
example, when example.com is the dynamic split exclude domain while www.example.com is the dynamic split include
domain, all traffic to examples.com is excluded except www.example.com. The attribute value contains the list of domain
names to exclude (or not) from the VPN tunnel and must be in comma-separated-values (CSV) format using the following
as an example:
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Step 3

anyconnect-custom-data dynamic-split-exclude-domains example service domains examplel.com, example2.com

anyconnect-custom-data dynamic-split-include-domains example service domains_tunneled www.examplel.com,
www.example2.com

Attach the previously defined custom attributes to a certain policy group with the following command, executed in the
group-policy attributes context:

anyconnect-custom dynamic-split-exclude-domains value

example service domains

anyconnect-custom dynamic-split-include-domains value

example service domains_ tunneled

Configure Dynamic Split Include Tunneling

Step 1

Step 2

Step 3

Before you begin
Refer to About Dynamic Split Tunneling, on page 134.

With dynamic split tunneling, you can dynamically provision split include tunneling after tunnel establishment
based on the host DNS domain name. Dynamic split tunneling is configured by creating a custom attribute
and adding it to a group policy on Secure Firewall ASA. Refer to Configure Dynamic Split Tunneling in the
Cisco ASA Series VPN ASDM Configuration Guide for GUI steps.

Define the custom attribute type in the WebVPN context with the following command:
anyconnect-custom-attr dynamic-split-include-domains description dynamic split include domains
Define the custom attribute names for each cloud/web service that needs client access by the VPN tunnel. The attribute

value contains the list of domain names to include into the VPN tunnel and must be in comma-separated-values (CSV)
format using the following as an example:

anyconnect-custom-data dynamic-split-include-domains corporate service domains domainl.com, domain2.com

Note A custom attribute cannot exceed 421 characters. A list of dynamically included domains (in CSV format)
may need to be partitioned into smaller values if exceeding the limit.

Attach the previously defined custom attribute to a certain policy group with the following command, executed in the
group-policy attributes context:

anyconnect-custom dynamic-split-include-domains value

corporate service domains

Configure Enhanced Dynamic Split Include Tunneling

Before you begin
Refer to About Dynamic Split Tunneling, on page 134.

Enhanced domain name matching is supported when dynamic split include tunneling is configured with both
dynamic split include and dynamic split exclude domains. Enhanced dynamic split include tunneling is
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Step 1

Step 2

Step 3

splitons I

configured by creating two custom attribute and adding it to a group policy on Secure Firewall ASA. Refer
to Configure Dynamic Split Tunneling in the Cisco ASA Series VPN ASDM Configuration Guide for GUI
steps.

Define the custom attribute type in the WebVPN context with the following command:

anyconnect-custom-attr dynamic-split-exclude-domains description dynamic split exclude domains
Define the custom attribute names for each cloud/web service that needs client access from the VPN tunnel. For example,
when domain.com is the dynamic split include domain while www.domain.com is the dynamic split exclude domain, all
traffic to domain.com is included except www.domain.com.The attribute value contains the list of domain names to

include (or not) into the VPN tunnel and must be in comma-separated-values (CSV) format using the following as an
example:

anyconnect-custom-data dynamic-split-include-domains corporate service domains domainl.com, domain2.com

anyconnect-custom-data dynamic-split-include-domains corporate service domains excluded www.domainl.com,
www.domain2.com

Attach the previously defined custom attributes to a certain policy group with the following command, executed in the
group-policy attributes context:

anyconnect-custom dynamic-split-include-domains value

corporate service domains

anyconnect-custom dynamic-split-exclude-domains value

corporate service domains_excluded

Split DNS

Split DNS is supported for both split include and split exclude tunneling configurations.

When split DNS for split include tunneling is configured in the Network (Client) Access group policy,
AnyConnect tunnels specific DNS queries to a VPN DNS server (also configured in the group policy). All
other DNS queries are directed outside the VPN tunnel, to a public DNS server.

When split DNS for split exclude tunneling is configured, specific DNS queries are sent outside the VPN
tunnel, to a public DNS server. All othe DNS queries are tunneled to a VPN DNS server.

If split DNS is not enabled with a split tunneling configuration, DNS queries are routed over the tunnel only
if "Send All DNS lookups through tunnel" is configured in the group policy. Otherwise, they could be also
routed outside the tunnel.

Requirements for Split DNS

Split DNS is supported on Windows and macOS platforms.

 Limited support is available on Linux, namely only tunneled DNS requests are subject to the split DNS
policy. Consequently, some DNS requests sent outside the tunnel may not comply with the split DNS
policy.

For macOS, AnyConnect can use true split-DNS for a certain [P protocol only if one of the following conditions
is met:
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* Split-DNS is configured for one IP protocol (such as [Pv4), and Client Bypass Protocol is configured
for the other IP protocol (such as IPv6) in the group policy (with no address pool configured for the latter
IP protocol).

* Split-DNS is configured for both IP protocols.

If split DNS for split include is configured for one IP protocol and split DNS for split exclude is configured
for the other protocol, split DNS for split include takes precedence, resulting in AnyConnect ignoring the split
DNS for split exclude settings.

Split DNS is relevant only to typical applications relying on the native/OS DNS client for name resolution,
such as browsers, mail applications, and such. Unsupported applications include tools using a custom resolver,
such as dig and nslookup.

Configure Split DNS for Split Include Tunneling

Step 1

Step 2

Step 3

To configure split DNS for split include tunneling in the group policy, do the following:

Configure at least one DNS server.

See the Configure Server Attributes for an Internal Group Policy section in the Cisco ASA Series VPN CLI or ASDM
Configuration Guide.

Ensure the private DNS servers specified do not overlap with the DNS servers configured for the client platform. If they
do, name resolution may not function properly.

Configure split-include tunneling:

On the Configuration > Remote Access VPN > Network (Client) Access > Group Policies> Advanced > Split
Tunneling pane, choose the Tunnel Networ k List Below policy, and specify a Network List of addresses to be tunneled.

On the Configuration > Remote Access VPN > Network (Client) Access > Group Policies> Advanced > Split
Tunneling pane, uncheck Send All DNSlookupsthrough tunnel, and specify the names of the domains whose queries
will be tunneled in DNS Names.

What to do next

After making changes to the group policy in ASDM, be sure the group policy is associated with a Connection
Profile in Configuration > Remote Access VPN > Network (Client) Access > AnyConnect Connection
Profiles> Add/Edit > Group Policy.

Configure Split DNS for Split Exclude Tunneling

Step 1

To configure split DNS for split exclude tunneling in the group policy, do the following:

In ASDM, navigate to Configuration > Remote Access VPN > Network (Client) Access> Advanced > AnyConnect
Custom Attributesto configure a new custom attribute type. Choose Add and set the following in the Create Custom
Attribute pane:

a) Enter split-dns-exclude-domains as the new type.

b) Optionally, enter a description.
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Step 2

Step 3

Step 4

Step 5

Step 6

Verify Split DNS Using AnyConnect Logs .

To configure a new custom attribute name for the created type, choose Add and set the following in the Create Custom
Attribute Name pane:

a) Choose split-dns-exclude-domains for the type.

b) Enter a name.

¢) For the value, enter a comma-separated list of domain names whose queries should not be tunneled.
The client accepts up to 300 such domains. Wildcards are not supported.

Choose Add and set the following in the Create Custom Attribute pane:

a) Choose the type created in step 1 for the Attribute Type field.

b) Choose the name created in step 2 for the Value field.

Configure at least one VPN DNS server.

See the Configure Server Attributes for an Internal Group Policy section in the Cisco ASA Series VPN CLI or ASDM
Configuration Guide.

Ensure the private DNS servers specified do not overlap with the DNS servers configured for the client platform. If they
do, name resolution may not function properly.

Configure split exclude or dynamic split exclude tunneling.

On the Configuration > Remote Access VPN > Network (Client) Access > Group Policies > Advanced > Split
Tunneling pane, choose the Exclude Network List Below policy, and specify a Network List of addresses to be excluded.

See Configure Dynamic Split Exclude Tunneling, on page 137 for additional information. Dynamic split exclude
configurations with split include tunneling are not supported.

On the Configuration > Remote Access VPN > Network (Client) Access > Group Policies> Advanced > Split
Tunneling pane, uncheck Send All DNS lookups through tunnel.

What to do next

After making changes to the group policy in ASDM, be sure the group policy is associated with a Connection
Profile in Configuration > Remote Access VPN > Network (Client) Access > AnyConnect Connection
Profiles> Add/Edit > Group Poalicy.

Verify Split DNS Using AnyConnect Logs

To verify if split-DNS is enabled, search the AnyConnect logs for an entry containing “Received VPN Session
Configuration Settings.” There are separate log entries for IPv4 and IPv6 split DNS.

* For split DNS exclude:
* [Pv4 split DNS: 5 excluded domains

* [Pv6 split DNS: 5 excluded domains

* For split DNS include:
* [Pv4 split DNS: 5 included domains

* [Pv6 split DNS: 5 included domains
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Manage VPN Authentication

Important Security Considerations

We do not recommend using a self-signed certificate on your secure gateway

* because of the possibility that a user could inadvertently configure a browser to trust a certificate on a
rogue server, and

* because of the inconvenience to users of having to respond to a security warning when connecting to
your secure gateway.

We strongly recommend that you enable Strict Certificate Trust for the AnyConnect client. To configure
Strict Certificate Trust, see the Local Policy Parameters and Values section: Local Policy Preferences, on
page 97.

Supported Security Types

AnyConnect supports RSA and ECDSA certificates for both server certificate verification and for client
certificate authentication.

* RSA Certificates

AnyConnect supports RSA certificates with the following properties:
* Key length of 2048, 4096, or 8192 bits

* Hash algorithms MD5*, SHA1, SHA256, SHA384, or SHAS512

* RSA certificates that use the MDS5 hash are not supported when AnyConnect is operating in FIPS mode.

* ECDSA Certificates
AnyConnect supports ECDSA certificates with the following properties:

* Key lengths of 256, 384, or 521 bits. These correspond to the NIST P-256, P-384, and P-521 elliptic
curves respectively.

» EADSA Certificates

AnyConnect relies on the Windows and macOS operating systems to establish trust and perform signing

operations using digital certificates. Since these operating systems do not yet support EdDSA certificates,
AnyConnect also cannot support them.

Configure Server Certificate Handling

Server Certificate Verification

* The certificate must meet the minimum key size noted above and be one of the support types (RSA or
ECDSA).
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* (Windows only) For both SSL and IPsec VPN connections, you have the option to perform Certificate
Revocation List (CRL) checking. When enabled in the profile editor, AnyConnect retrieves the updated
CRL for all certificates in the chain. It then verifies whether the certificate in question is among those
revoked certificates which should no longer be trusted; and if found to be a certificate revoked by the
Certificate Authority, it does not connect. Refer to Local Policy Preferences, on page 97 for further
information.

* When a user connects to a Secure Firewall ASA that is configured with a server certificate, the checkbox
to trust and import that certificate will still display, even if there is a problem with the trust chain (Root,
Intermediate, etc.) If there are any other certificate problems, that checkbox will not display.

* SSL connections being performed via FQDN do not make a secondary server certificate verification with
the FQDN's resolved IP address for name verification if the initial verification using the FQDN fails.

* The date and time (as reported by the operating system) at which verification is being performed must
be after the certificate's Valid From date and before the Valid To date.

* Although not recommended, server certificates do not require a Key Usage (KU) or an Extended Key
Usage (EKU) to be accepted. However, if the fields are present (which is most common), the following
conditions apply:

For SSL and IPsec (both RSA and ECDSA certificates), any KU field must contain DigitalSignature.
For RSA certificates, the KU must also contain KeyEncipherment or KeyAgreement.

For IPsec VPN, any EKU field must contain ServerAuth or IkeIntermediate.

* [Psec and SSL connections perform name verification on server certificates. The following rules are
applied for the purposes of [Psec and SSL name verification:

* If a Subject Alternative Name extension is present with relevant attributes, name verification is
performed solely against the Subject Alternative Name. Relevant attributes include DNS Name
attributes for all certificates, and additionally include IP address attributes if the connection is being
performed to an IP address.

* [fa Subject Alternative Name extension is not present, or is present but contains no relevant attributes,
name verification is performed against any Common Name attributes found in the Subject of the
certificate.

« If a certificate uses a wildcard for the purposes of name verification, the wildcard must be in the
first (Ieft-most) subdomain only, and additionally must be the last (right-most) character in the
subdomain. Any wildcard entry not in compliance is ignored for the purposes of name verification.

» For macOS, expired certificates are displayed only when Keychain Access is configured to “Show
Expired Certificates.” Expired certificates are hidden by default, which may confuse users.

Invalid Server Certificate Handling

In response to the increase of targeted attacks against mobile users on untrusted networks, we have improved
the security protections in the client to help prevent serious security breaches. The default client behavior has
been changed to provide an extra layer of defense against Man-in-the-middle attacks.
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. Invalid Server Certificate Handling

User Interaction

When the user tries to connect to a secure gateway, and there is a certificate error (due to expired, invalid
date, wrong key usage, or CN mismatch), the user sees a red-colored dialog with Change Settings and Keep
Me Safe buttons.

\)

Note The dialogs for Linux may look different from the ones shown in this document.

' Cisco AnyConnect Secure Mobility Clien- T

n Untrusted VPN Server! example hostcom

AnyConnect cannot verify the VPN server:

Connecting to this server may result in a severe security compromise!
Security Risks Explained

AnyConnect is configured to block untrusted VPN servers by default.
Muost users choose to keep this setting,

If this setting is changed onnect will no longer automatically
block connections to potentially malicious network devices,

Change Setting... ] |_ Keep Me Safe

2442593

A5

* Clicking Keep M e Safe cancels the connection.

* Clicking Change Settingsopens the AnyConnect Advanced > VPN >Preferences dialog, where the user
can enable connections to untrusted servers. The current connection attempt is canceled.
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Invalid Server Certificate Handling .

-
{'§ Cisco AnyConnect Secure Mobili

'f:l,'s'ég' AnyConnect Secure Mobility Client

Connect on start-up
Minimize on connect
Enable local LAM access (if configured)

Block connections to untrusted servers

If the user un-checks Block connectionsto untrusted servers, and the only issue with the certificate is that
the CA is untrusted, then the next time the user attempts to connect to this secure gateway, the user will not
see the Certificate Blocked Error Dialog dialog.
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-

Cisco AnyConnect Secure Mobility Client @

A Security Warning: Untrusted VPN Server
Certificate!

AnyConnect cannot verify the VPM server: hostname example.com

Certificate is from an untrusted source,

Connecting to this server may result in a severe security compromise!

Most users do not connect to untrusted VPN servers unless the reason
for the error condition is known.,

[] Always trust this VPN server and import the certificate

Connect Anyway I [ Cancel Connection

'442585

a

e

A

If the user checks Alwaystrust this VPN server and import the certificate, then future connections to this
secure gateway will not prompt the user to continue.

\)

Note

If the user checks Block connectionsto untrusted serversin AnyConnect Advanced > VPN > Preferences,
or if the user’s configuration meets one of the conditions in the list of the modes described under the guidelines

and limitations section, then AnyConnect rejects invalid server certificates and connections to untrusted
servers, regardless of whether the Strict Certificate Trust option in the Profile Editor is enabled.

Improved Security Behavior

When the client accepts an invalid server certificate, that certificate is saved in the client's certificate store.
Previously, only the thumbprint of the certificate was saved. Note that invalid certificates are saved only when
the user has elected to always trust and import invalid server certificates.

There is no administrative override to make the end user less secure automatically. To completely remove the
preceding security decisions from your end users, enable Strict Certificate Trust in the user’s local policy
file. When Strict Certificate Trust is enabled, the user sees an error message, and the connection fails; there
is no user prompt.

For information about enabling Strict Certificate Trust in the local policy file, see the Local Policy Preferences,
on page 97.

Guidelines and Limitations

Invalid server certificates are rejected when:

» Always On is enabled in the AnyConnect profile and is not turned off by an applied group policy or
DAP.

* The client has a Local Policy with Strict Certificate Trust enabled.
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» AnyConnect Start Before Login is configured.

* A client certificate from the machine certificate store is used for authentication.

Configure Certificate-Only Authentication

You can specify whether you want users to authenticate using Secure Firewall ASA with a username and
password or using a digital certificate (or both). When you configure certificate-only authentication, users
can connect with a digital certificate and are not required to provide a user ID and password.

To support certificate-only authentication in an environment where multiple groups are used, you may provision
more than one group-url. Each group-url would contain a different client profile with some piece of customized
data that would allow for a group-specific certificate map to be created. For example, the Department OU
value of Engineering could be provisioned on the Secure Firewall ASA to place the user in this group when
the certificate from this process is presented to the Secure Firewall ASA.

\)

Note The certificate used to authenticate the client to the secure gateway must be valid and trusted (signed by a
CA). A self-signed client certificate will not be accepted.

Step 1 Go to Configuration > Remote AccessVPN > Network (Client) Access > AnyConnect Connection Profiles.
Select a connection profile and click Edit. The Edit AnyConnect Connection Profile window opens.

Step 2 If it is not already, click the Basic node of the navigation tree on the left pane of the window. In the right pane of the
window, in the Authentication area, enable the method Certificate.

Step 3 Click OK and apply your changes.

Configure Certificate Enroliment

The AnyConnect Secure Mobility Client uses the Simple Certificate Enrollment Protocol (SCEP) to provision
and renew a certificate as part of client authentication. Certificate enrollment using SCEP is supported by
AnyConnect IPsec and SSL VPN connections to the Secure Firewall ASA in the following ways:

* SCEP Proxy: The Secure Firewall ASA acts as a proxy for SCEP requests and responses between the
client and the Certificate Authority (CA).

» The CA must be accessible to the Secure Firewall ASA, not AnyConnect, since the client does not
access the CA directly.

* Enrollment is always initiated automatically by the client. No user involvement is necessary.

Related Topics
AnyConnect Profile Editor, Certificate Enrollment, on page 86

SCEP Proxy Enroliment and Operation

The following steps describe how a certificate is obtained and a certificate-based connection is made when
AnyConnect and the Secure Firewall ASA are configured for SCEP Proxy.
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1. The user connects to the Secure Firewall ASA headend using a connection profile configured for both
certificate and AAA authentication. The Secure Firewall ASA requests a certificate and AAA credentials
for authentication from the client.

2. The user enters his/her AAA credentials, but a valid certificate is not available. This situation triggers the
client to send an automatic SCEP enrollment request after the tunnel has been established using the entered
AAA credentials.

3. The Secure Firewall ASA forwards the enrollment request to the CA and returns the CA’s response to
the client.

4. 1f SCEP enrollment is successful, the client presents a (configurable) message to the user and disconnects
the current session. The user can now connect using certificate authentication to the Secure Firewall ASA
tunnel group.

If SCEP enrollment fails, the client displays a (configurable) message to the user and disconnects the
current session. The user should contact his/her administrator.
Other SCEP Proxy operational considerations:

* If configured to do so, the client automatically renews the certificate before it expires, without user
intervention.

* SCEP Proxy enollment uses SSL for both SSL and IPsec tunnel certificate authentication.

Certificate Authority Requirements

* All SCEP-compliant CAs, including IOS CS, Windows Server 2003 CA, and Windows Server 2008 CA,
are supported.

» The CA must be in auto-grant mode; polling for certificates is not supported.

* You can configure some CAs to email users an enrollment password for an additional layer of security.
The CA password is the challenge password or token that is sent to the certificate authority to identify
the user. The password can then be configured in the AnyConnect profile, which becomes part of SCEP
request that the CA verifies before granting the certificate.

Guidelines for Certificate Enrollment

* Clientless (browser-based) VPN access to the ASA does not support SCEP proxy, but WebLaunch
(clientless-initiated AnyConnect) does.

* Secure Firewall ASA load balancing is supported with SCEP enrollment.

* The Secure Firewall ASA does not indicate why an enrollment failed, although it does log the requests
received from the client. Connection problems must be debugged on the CA or the client.

* Certificate-Only Authentication and Certificate Mapping on the Secure Firewall ASA:

To support certificate-only authentication in an environment where multiple groups are used, you may
provision more than one group-url. Each group-url would contain a different client profile with some
piece of customized data that would allow for a group-specific certificate map to be created. For example,
the Department_OU value of Engineering could be provisioned on the Secure Firewall ASA to place the
user in this tunnel group when the certificate from this process is presented to the Secure Firewall ASA.

* Identifying Enrollment Connections to Apply Policies:
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On the Secure Firewall ASA, the aaa.cisco.sceprequired attribute can be used to catch the enrollment
connections and apply the appropriate policies in the selected DAP record.

» Windows Certificate Warning:

When Windows clients first attempt to retrieve a certificate from a certificate authority they may see a
warning. When prompted, users must click Yes. This allows them to import the root certificate. It does
not affect their ability to connect with the client certificate.

Configure SCEP Proxy Certificate Enroliment

Configure a VPN Client Profile for SCEP Proxy Enroliment

Step 1 Open the VPN Profile Editor and choose Certificate Enrollment from the navigation pane.
Step 2 Select Certificate Enrollment.
Step 3 Configure the Certificate Contentsto be requested in the enrollment certificate. For definitions of the certificate fields,

see AnyConnect Profile Editor, Certificate Enrollment.
Note * If you use %machineid%, then VPN Posture must be loaded for the desktop client.

* For mobile clients, at least one certificate field must be specified.

Configure the Secure Firewall ASA to Support SCEP Proxy Enrollment

For SCEP Proxy, a single Secure Firewall ASA connection profile supports certificate enrollment and the
certificate authorized VPN connection.

Step 1 Create a group policy, for example, cert_group. Set the following fields:

¢ On General, enter the URL to the CA in SCEP Forwarding URL.
* On the Advanced > AnyConnect pane, uncheck Inherit for Client Profiles to Download and specify the client profile

configured for SCEP Proxy. For example, specify the ac_vpn_scep proxy client profile.

Step 2 Create a connection profile for certificate enrollment and certificate authorized connection, for example, cert tunnel.

* Authentication: Both (AAA and Certificate).
* Default Group Policy: cert_group.
» On Advanced > General, check Enable SCEP Enrollment for this Connction Profile.

* On Advanced > GroupAlias/Group URL, create a Group URL containing the group (cert_group) for this connection
profile.
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Set Up a Windows 2012 Server Certificate Authority for SCEP

If your Certificate Authority software is running on a Windows 2012 server, you may need to make one of
the following configuration changes to the server to support SCEP with AnyConnect.

Disable the SCEP Password on the Certificate Authority

The following steps describe how to disable the SCEP challenge password, so that clients will not need to
provide an out-of-band password before SCEP enrollment.

Step 1 On the Certificate Authority server, launch the Registry Editor. You can do this by selecting Start > Run, typing regedit,
and clicking OK.

Step 2 Navigate to HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Cryptography\MSCEP\EnforcePassword.

If the EnforcePassword key does not exist, create it as a new Key.

Step 3 Edit EnforcePassword, and set it to '0". If it does not exist, create it as a REG-DWORD.
Step 4 Exit regedit, and reboot the certificate authority server.

Setting the SCEP Template on the Certificate Authority

The following steps describe how to create a certificate template, and assign it as the default SCEP template.

Step 1 Launch the Server Manager. You can do this by selecting Start > Admin Tools > Server Manager.
Step 2 Expand Roles > Certificate Services (or AD Certificate Services).

Step 3 Navigate to CA Name > Certificate Templates.

Step 4 Right-click Certificate Templates > Manage.

Step 5 From the Cert Templates Console, right-click User template and choose Duplicate

Step 6 Choose Windows Server 2012 version for new template, and click OK.

Step 7 Change the template display name to something descriptive, such as NDES-IPSec-SSL.

Step 8 Adjust the Validity Period for your site. Most sites choose three or more years to avoid expired certificates.
Step 9 On the Cryptography tab, set the minimum key size for your deployment.

Step 10 On the Subject Name tab, select Supply in Request.

Step 11 On the Extensions tab, set the Application Policies to include at least:

* Client Authentication

* [P security end system

* [P security IKE intermediate
* [P security tunnel termination

* IP security user

These values are valid for SSL or IPsec.

Step 12 Click Apply, then OK to save new template.

. Cisco AnyConnect Secure Mobility Client Administrator Guide, Release 4.10



| Configure AnyConnect VPN

Step 13

Step 14
Step 15
Step 16

Step 17

Configure a Certificate Expiration Notice .

From Server manager > Certificate Services-CA Name, right-click Certificate Templates. Select New > Certificate
Template to Issue, select the new template you created (in this example, NDES-IPSec-SSL), and click OK.

Edit the registry. You can do this by selecting Start > Run, regedit, and clicking OK.
Navigate to HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Cryptography\MSCEP.
Set the value of the following three keys to NDES-I PSec-SSL .

* EncryptionTemplate
* GeneralPurposeTemplate

* SignatureTemplate

Click Save, and reboot the certificate authority server.

Configure a Certificate Expiration Notice

Step 1

Step 2
Step 3

Step 4

Configure AnyConnect to warn users that their authentication certificate is about to expire. The Certificate
Expiration Threshold setting specifies the number of days before the certificate’s expiration date. AnyConnect
uses the thresho